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Resumen

El desarrollo del presente trabajo pretende dar una visién sobre el uso de los drones dentro
de la construccién, exactamente en su aplicacién dentro del flujo de trabajo BIM (Building

Information Modeling).

Para ello, se introduce al lector en antecedentes histéricos y conceptuales exponiendo,
posteriormente, la normativa que recae sobre dichas aeronaves. De este modo conoceremos

las limitaciones dentro del espacio aéreo.

También, se estudian y analizan distintas soluciones que puedan ser de utilidad para abordar
los retos de este trabajo. Para ello, se realizan varios estudios del caso llevando a cabo dos
levantamientos fotogramétricos. Cada uno de ellos con distintas condiciones de trabajo para
realizar una evaluacion mas completa sobre el estudio. Se ha realizado el levantamiento del
Elevador de Aguas de Gordejuela situado en las isla de Santa Cruz de Tenerife (Islas
Canarias) mediante la informacion obtenida con un dron. Con ello, conoceremos los
parametros necesarios para planificar un vuelo, obtener informacion util, como recibirla y
gestionarla en un programa BIM. Sin embargo, previamente se realiza un vuelo de
familiarizacion del dron utilizado realizando el levantamiento fotogramétrico del Sanatorio de

Abades situado en la Leproseria de Arico.
En resumen, el objetivo del trabajo es que el presente documento sirva como guia practica
sobre el uso de drones en la obtencién de informacion que pueda trasladarse en BIM vy

analizar, si cabe, las posibles aplicaciones futuras de aeronaves pilotadas remotamente en

dicha metodologia.

Palabras clave: BIM, dron, UAVS, RPAS, construccioén, edificacion, informacion.

Axel Lubong Blanza 4



Estudio del uso de drones en el flujo de trabajo BIM

Abstract

The development of the dissertation pretends to give a vision about the use of drones within
the construction, mainly in the application within the BIM (Building Information Modeling)

workflow.

For this reason, the reader is introduced in historical and conceptual records exposing, after
all, the regulations that fall on said aircraft. In this way we will know the limitations within the

airspace.

Also, the different applications that may have within the building and which of them are useful,
in terms of information, in BIM methodology are mentioned. For this reason, it has been done
the survey of the Gordejuela Water’s Elevator located on the island of Santa Cruz de Tenerife
(Canary Islands) through the information obtained with a RPAS (Remotely Piloted Aircraft
System). With this, we will know the fundamental parameters to plan a flight, obtain useful
information, how to receive it and manage it in a BIM software. However, previously we will do
a familiarization flight of the drone doing the photogrammetric survey of the Abades’

Sanatorium located in the Arico’s Leprosarium.

In summary, the objective of the work is that this document serves as a practical guide about
the use of drones in obtaining information that can be transferred in BIM and analyse the

possible future applications on the use of remotely piloted aircraft in said methodology.

Keywords: BIM, drone, UAV, RPAS, construction, building, information.
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1. Introduccidon / Planteamiento

Nos encontramos en un momento de desarrollo tecnolégico importante en el sector de la
construccion. A lo largo de la historia, los avances se han centrado principalmente en el
desarrollo y progreso de los materiales de construccion, sin embargo, se empiezan a
escuchar conceptos como impresion 3D, construccion verde, computacién en la nube,
realidad virtual, realidad aumentada y robdtica como tendencias tecnolégicas que se van
implementando cada vez mas en la construcciéon. Entre otros conceptos encontramos,
también, la metodologia BIM (Building Information Modeling) y los RPAS (Remotely Piloted
Aircraft System) o coloquialmente conocidos como drones. Holt, Benham y Bigelow (2015)
realizaron un estudio entre profesionales del sector AEC (Architecture, Engineering and
Construction) para saber qué tecnologias emergentes existen en la actualidad y cual de ellos
deben introducirse en la comunidad educativa para preparar a los futuros profesionales. En
su investigacion enumeran los conceptos tecnoldgicos anteriormente mencionados como los
mas destacables, siendo el BIM el que predomina sobre el resto, o incluso, siendo este un

paraguas donde se cobijan los demas desarrollos techoldgicos.

El procesado de imagen junto a la gestion de informacion en la construccion ha ido
evolucionado a medida que el avance tecnoldgico ha incurrido en dichos campos. Por un
lado, tenemos el BIM, que segun la norma EN-ISO 19650-1:2019. Organizacion y
digitalizaciéon de la informacioén en obras de edificacion e ingenieria civil que utilizan BIM.
Gestié de la informacion al utilizar BIM. Conceptos y principios lo define como el “Uso de una
representacion digital compartida de un activo construido para facilitar los procesos de disefio,
construccion y operacion, y proporcionar una base confiable para la toma de decisiones”.
Definicion que nos da a entender que el BIM se trata de una metodologia de gestién que
recoge toda la informacion necesaria para la construccion de un edificio; planos,
programacion de obra, presupuestos, analisis energético y seguridad y salud. Todo ello con
el objetivo de una disminucién de tiempo y recursos en el proceso constructivo de una obra.
Pero, toda la informacion anterior, no se desvanece tras la construccion sino que se trata de
una informacion que sigue viva y que permite modificaciones para mantener actualizado el

modelo BIM durante todo el ciclo de vida de un edificio.

Por otro lado, estan los RPAS (Remotely Piloted Aircraft System). Un sistema aéreo pilotado

remotamente que esta entrando en el mercado y que, en el sector de la construccién, tiene
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cabida para dar soporte en la mejora de obtencion de informacién gracias a la camara que

este sistema puede contener.

1.1. Antecedentes

El desarrollo e investigacion de los drones tiene una trayectoria histérica longeva, de
hecho su primera aparicion se remite en el afio 1849 en el campo militar. Sin embargo,
tras la regulacién del uso de drones civiles en el 2009 se empezaron a ver las

posibilidades de su uso en la construccion y edificacion.

Los usos y las aplicaciones ya las empezamos a ver en sectores muy dispares entre
ellos. Nex y Remondino (2015) en su estudio sobre las aplicaciones de estos robots
menciona campos como la agricultura ya que pueden obtener informacion sobre el
estado de la plantacién, danos, falta o exceso de agua. Informacion con el que pueden
evitar o tomar decisiones para un mayor ahorro econémico y/o de recursos. También,
de la misma manera es aplicable a la silvicultura. Gracias a los drones se puede
monitorizar la vegetacion, identificar nuevas especies o asentamientos de madera e
incluso vigilar los incendios forestales. En relacion a la ultima aplicacion, podemos
trasladar la vigilancia también a propiedades privadas, a la monitorizacion de trafico,
accidentes, vigilancia costera como apoyo al cuerpo de salvamento, etc. Por otro lado,
con la tecnologia de los RPAS podemos realizar levantamientos 3D mediante la
fotogrametria permitiendo estudiar campos de trabajo relacionados con la
arqueologia. En cuanto a nuestro interés para desarrollar este trabajo, Tatum y Liu
(2017), a modo de introduccion, citan aplicaciones para campos de fotografia y
filmacion, transporte de mercancia, educacion e investigacion. Sin embargo su trabajo
se centra en las aplicaciones relacionadas con el sector AEC. En concreto, en su
investigacion clasifica el uso de drones en cuatro categorias: (1) Fotografia y
videograbacién aérea, (2) Topografia, agrimensura, (3) Inspecciones y (4) Seguridad

y salud.

Durante la realizacion del Master Universitario de Gestion e Innovacion Tecnoldgica
en la Construccién impartido en la Universidad de La Laguna, en el curso 2017-2018,
se han abordado diversos campos innovadores relacionados y aplicados a la
construccion. Entre ellos, la fotogrametria, una técnica que nos permite obtener el

volumen de un objeto por medio de fotografias del mismo y los datos sobre su forma,
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dimensiones y posicidon. También, como asignatura independiente y de la mano de
Jorge de la Torre Cantero, se realizé tanto tedérica como de manera practica una

introduccion a la metodologia BIM.

Por todo lo anterior, se pretende explorar el potencial del uso de los drones en el flujo
de trabajo BIM. Este interés parte de haber realizado trabajos relacionados con
levantamientos fotogramétricos con el uso de RPAS y que, tras ello, se valoro6 la

posibilidad de conjugar ambas tecnologias como herramientas complementarias.

1.2. Objetivos

En este presente trabajo se tiene como objetivo general conocer el potencial del uso
de los drones y estudiar la viabilidad de conjugar su uso con el flujo de trabajo BIM.
Para ello, se realizara una aproximacion practica de uso de dichas aeronaves
pilotadas remotamente realizando, mediante fotogrametria, el modelado del Elevador
de Aguas de Gordejuela, una construccién que forma parte del patrimonio industrial
del municipio de Los Realejos, en el norte de la isla de Tenerife.

Se estudiaran las limitaciones técnicas de los programas de gestion de datos
obtenidos y las legislativas a la hora de utilizar espacio aéreo. Todo lo anterior, con la
finalidad de facilitar informacion de interés para el desarrollo de proyectos de
construccion en los cuales se utilice los vehiculos aéreos no tripulados (VANT) como

herramienta de obtencion de datos.

Por ultimo, mencionar que los objetivos mas especificos que se pretenden
conseguir al finalizar este trabajo de investigacion son los siguientes:
e Analizar las aplicaciones de los drones en el flujo de trabajo BIM.
e Conocer el potencial y las limitaciones de los drones.
e Conocer las limitaciones actuales del espacio aéreo.
e Conocer las limitaciones de software y hardware para la gestion de
informacion.
e Valorar los resultados obtenidos mediante la recogida de datos con drones.
e Valorar las ventajas y desventajas de utilizar estos equipos como herramientas
en la edificacion.
e Estudiar posibles futuras lineas de trabajo en base a las conclusiones

obtenidas.
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1.3. Hipétesis

Vemos la necesidad de justificar, mediante la presente investigacion, el uso de drones
en el flujo de trabajo de una redaccion grafica de una infraestructura arquitectonica en
un proyecto BIM. Todo ello partiendo de una herramienta aérea de dimensiones

reducidas y de bajo presupuesto.

Del resultado obtenido, hipotetizamos la posibilidad de su aplicacion en el ambito de
la rehabilitacion y restauracion arquitecténica o como recopilacién grafica para el

patrimonio histérico de una ciudad.

1.4. Metodologia

El desarrollo de la investigacion consiste, por un lado, en la busqueda de articulos,
trabajos, tesis, etc. publicados en revistas de investigacion relacionados con los
drones y el flujo de trabajo BIM. De esta manera se realiza una revision de literatura
cientifica sobre los conceptos de interés y asi tener informaciéon de partida en la

ejecucion del caso de estudio.

Al tratarse de conceptos que estan marcando tendencia actualmente y que avanzan
continuamente, uno de los filtros de seleccidn de informacion es el uso de aquella que
haya sido publicada en los ultimos diez afios. También, por la escasez de documentos
realizados en castellano, se realizara la busqueda de dichos conceptos en inglés.

Quedando como listado de palabras de busqueda la siguiente:

e BIM (Building Information Modeling)

e Fotogrametria / Photogrammetry

e Nube de puntos / Point cloud

e Construccion / Construction

e Edificacion / Building

e Dron/ Drone

e RPA (Remotely Piloted Aircraft)

o RPAS (Remotely Piloted Aircraft System)
e VANT (Vehiculo Aéreo No Tripulado)

e UAV (Unmanned Aerial Vehicle)
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e UAS (Unmanned Aerial System)

Con la recopilacion de la bibliografia seleccionada se pretende tener una vision del
panorama en el que se encuentra el estado del arte del uso de los drones en la

metodologia de trabajo BIM.

Por otro lado, como complemento a la informacion obtenida anteriormente, y sobre
todo en relacion a los conceptos de los UAV, se ha realizado un curso de Piloto
Profesional Avanzado de RPAS (drones) en CANAVIA Escuela de Pilotos impartido
en la Real Aeroclub de Tenerife. Ademas, en cuanto a la obtencidon de informacién
fotogramétrica mediante ellos, también se ha realizado un curso sobre Analisis de
Imagenes con RPAS (fotogrametria, agricultura de precision, teledeteccion, restitucion

digital 3D, etc.) de la mano de RPA Formacion.

Seguidamente se realiza el estudio de ocho casos de investigacién académica para
entrar en profundidad en la materia. Por otro lado, de manera practica, se tiene
pensado realizar el escaneado del Elevador de Aguas de la Gordejuela y, mediante la

técnica de fotogrametria, trabajar con el resultado obtenido en un concepto BIM.
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2. Estado del arte / Estado de la Tecnologia

En el proceso de revisién bibliografica se ha comprobado la escasez de documentos técnicos
que estudien el objetivo general establecido en este trabajo. Sin embargo, el desarrollo del
mismo se basara en documentacion que ha estudiado flujos de trabajos muy similares. En el
capitulo 3 del presente trabajo se ha realizado expresamente un apartado en el que

resumimos las ideas principales que pueden ser de utilidad la el desarrollo de este TFM.

En cuanto a la estructura del estado del arte se ha visto la necesidad de introducir los
siguientes conceptos para una mayor comprension de los temas que se van a tratar. Por un
lado, una introduccion de los Vehiculos Aéreo No Tripulados (VANT) que recoge desde la
definicion hasta la normativa actual pasando por la historia y evolucion de dichos vehiculos.
Por otro lado, se presenta una introduccion sobre los conceptos generales sobre la
metodologia BIM entrando tanto en los niveles de desarrollo de los proyectos como en la

necesidad de equipos multidisciplinares.

2.1. Remotely Piloted Aircraft (RPA)

2.1.1. ;Qué es un RPA?

Seguramente, si se utiliza este acréonimo en una conversacién comun, la mayoria de
personas no entenderian a qué se estan refiriendo. Esto se debe a que coloquialmente
se ha extendido el término ‘drone’ que tanto escuchamos en la prensa cuando se
comunican noticias al respecto. Por ello, se realiza a continuacion la definicion de
diferentes conceptos que encontramos, tanto en internet como en documentacion
técnica, como referencia a aeronaves no tripuladas. Servira para entender y

diferenciar cada uno de los acronimos que recoge el campo de la aviacion.

e Dron: sustantivo adaptado de la palabra inglesa ‘drone’ originaria de asociar este
término a las primeras aeronaves no tripuladas de uso militar. Dicha
denominacion parte de su traduccion que significa zangano o abeja macho y que,
por el simil de su sonido, se denominé a dichos vehiculos aéreos. Sin embargo,
debido a la introduccién de estos aviones en el mercado, podemos encontrar
diferentes apellidos en funcion de su uso; dron militar para un uso bélico y dron
civil para un uso, apartado del campo de batalla, como herramienta util para la

sociedad.
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e UCAV: ‘Unmanned Combat Aerial Vehicle’ acronimo utilizado para referirse a los
vehiculos aéreos de combate no tripulados capaces de llevar instalados artilleria
para realizar ataques con drones.

e UAV/UAS: por un lado tenemos el concepto ‘Unmanned Aerial Vehicle (UAV) y
gue se utiliza para referirse Unicamente a la aeronave. En castellano lo podemos
encontrar, ya mencionado anteriormente, como Vehiculo Aéreo No Tripulado
(VANT). Si a ello le sumamos el sistema o la plataforma utilizada para el control
nos referimos a todo el conjunto como ‘Unmanned Aerial System (UAS)’. En
alguna ocasiones lo podemos encontrar como UVS (Unmanned Vehicle System).

e RPA/RPAS: en este caso se trata de un subconjunto dentro de las aeronaves no
tripuladas, con la diferencia del anterior porque se especifica su pilotaje de
manera remota. De la misma manera que anteriormente, tenemos ‘Remotely
Piloted Aircraft (RPA)’ como referencia solo al vehiculo aéreo pilotado
remotamente y, por otro lado, ‘Remotely Piloted Aircraft System (RPAS)’ incluido

el sistema de control.

Estas definiciones deben quedar bien claras a la hora de referir cada una de las
aeronaves para no causar incongruencias en la legislacion especifica del uso del
espacio aéreo. Cabe mencionar que en la Organizacién de Aviacion Civil Internacional
(OACI) habla de los drones como ‘Unmanned Aircraft (UA)’ mientras que se conoce
mas técnicamente como UAV. Y, si se quiere ser mas preciso, para nuestro caso es
RPA. Entonces, teniendo en cuenta las aeronaves que se utilizan para un uso civil o
comercial, se especifica estos aviones con el término RPA mientras que los términos

dron, UAV y UAS se utiliza para fines militares.

2.1.2. Historia del RPA dron
Segun el articulo de Priscariu (2017) en el Journal of Defense Resources Management
ubica la aparicion de los primeros vehiculos aéreos no tripulados en el afio 1849. Esto
ocurre en un ataque de los austriacos a la ciudad italiana de Venecia mediante globos

no tripulados que contenian bombas con temporizador.

Sin embargo, ya es después de la presentacion del concepto de control inalambrico
de Tesla en el 1900 cuando se desarrollan los vehiculos no tripulados. Durante el 1916
hubieron los primeros intentos fallidos por parte de los ingleses que abandonaron el

proyecto por tener limitaciones militares. A pesar de ello, los americanos sacaron una
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version, el Hewitt-Sperry, que tras mostrar su potencial frente a los representantes del
ejército de E.E.U.U, encargaron una produccion masiva de una version llamada
Kettering Bug. No obstante, su desarrollo fue muy tarde para usarse en la Primera

Guerra Mundial y nunca fue utilizado.

Durante el periodo de paz, sobretodo en la década de los 20, se generaron bastantes
proyectos en relacion a los drones militares. Entre ellos, en septiembre del 1924, hubo
el primer vuelo exitoso a control remoto que dominaba todas las fases de vuelo
(despegue, maniobra y aterrizaje). Por otro lado, la armada britanica desarroll6 el
Queen Bee (abeja reina) que al transplantar dicha tecnologia en américa se empieza
a utilizar el término Drone (zangano). Durante la década de los 30 se desarrollaron

drone militares usados para entrenamiento de la artilleria americana.

En la Segunda Guerra Mundial, en el afio 1944 los alemanes utilizaron el Fi-103 (V1)
mas conocido como misiles crucero. Por otro lado, los estadounidenses
bombardearon una base japonesa con un TDR-1. Ambos basados en ser drones
bomba controlados remotamente y sin la necesidad de la presencia del piloto sobre la

aeronave.

Ya en la posguerra, se desarrollo el Ryan Firebee en el 1951, un disefio de avion
reactivo que a dia de hoy sigue dominando la historia de los drones. Posteriormente,
en el 1955 se consigue realizar el primer vuelo de un VANT dedicado al

reconocimiento del territorio.

Desde entonces, la aparicion de los drones se hace mas presente y evolucionada en

la Guerra Fria, la Guerra Koreana, la Guerra de Vietnam y en la Guerra del Golfo.

En cuanto al uso de los drones civiles, Manuel Ofiate, presidente de la AERPAS
(Asociacion Espanola de RPAS), explica en una entrevista que se inicia en los afnos
80 tras la peticion del Ministerio de Agricultura a la empresa Yamaha del desarrollo de
un sistema que permitiera la fertilizacién de los cultivos.

Finalmente, en el 2009 Reino Unido regulé por primera vez en el mundo el uso de los
drones en actividades civiles dando paso al auge comercial de los drones entre la

sociedad y como actividad profesional.

Axel Lubong Blanza 15



Estudio del uso de drones en el flujo de trabajo BIM

2.1.3. Clasificacion de los drones
La Agencia Estatal de Seguridad Aérea (AESA) es la encargada de redactar el marco
regulatorio y controlar el espacio aéreo de Espafa. En el Real Decreto 1036/2017, de
15 de diciembre, por el que se regula la utilizacién civil de las aeronaves pilotadas por
control remoto se contempla un grupo de clasificacion por tipo. A pesar de ello,

también se pueden clasificar las aeronaves por peso y por uso.

En una primera instancia, tenemos una clasificacion por tipo que divide los RPA en
funcion de la forma en la que se sustentan. Encontrandonos en este grupo los
siguientes:

e Tipo avién: comunmente conocidos como drones de ala fija por su principio de
sustentacion. Tienen la mejor autonomia de los tres tipos y un desplazamiento
con mayor velocidad permitiendo, para el fin que nos interesa, sobrevolar grandes
extensiones de superficie. Por ello, son ideales para realizar levantamientos
fotogramétricos para trabajos topograficos. Sin embargo, estos tienen el
inconveniente de no realizar vuelos estacionarios y solo realizando

desplazamientos frontales.

Figura 1: Dron tipo ala fija. Modelo Trimble UX5 HP. Fuente: https://www.trimble.com

e Tipo helicéptero: en este caso nos encontramos con una sustentacion basada
en alas giratorias y con las ventajas, en comparacion al anterior tipo, de la
posibilidad de realizar vuelos estacionarios y de desplazarse en los tres ejes.
También son RPA con buena autonomia y con una gran capacidad de “payload”
(carga acoplado al dron) permitiendo abarcar de manera polivalente los trabajos
técnicos. En su contra, debido a su complejidad mecanica, su mantenimiento es

mas elevado y costoso y, también, su pilotaje es mas complejo que los demas.
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Figura 2: Dron tipo helicoptero. Modelo Alpha 800 UAV. Fuente: https://alphaunmannedsystems.com/

e Tipo multirrotor: es el mas extendido y conocido por su gran comercializacion y
gran alcance de la sociedad civil. Se basa en una sustentacion de alas giratorias
como el tipo helicéptero pero con mayor cantidad de rotores. Comiunmente vemos
los RPA de cuatro rotores llamado cuadricoptero pero también existen
hexacdpteros y octocopteros para trabajos que se requiera mayor potencia de
sustentacion por la carga que debe transportar.

Sus principales ventajas son la estabilidad y el menor mantenimiento por la
sencillez mecanica. Sin embargo, su autonomia es el punto flaqueante de este
tipo de RPA.

Figura 3: Dron tipo multirotor. Modelo DJI Matrice 200. Fuente: https://www.dji.com

Por otro lado, tenemos una clasificacion por peso que, dependiendo de dicha
caracteristica, tendra diferentes particularidades definidas por las legislacion vigente.
Previamente vemos la necesidad de definir VLOS (Visual Line Of Sight) referente al
alcance visual del piloto, EVLOS (Extended Visual Line Of Sight) para cuando se
utilizan observadores de refuerzo y BVLOS (Beyond Visual Line Of Sight) para
operaciones fuera del campo visual. De igual importancia cabe decir que el peso de
referencia en esta clasificacion es el resultante en su momento de despegue.
Encontramos la siguientes categorias:

e De 0 a 2 kg: para la categoria mas ligera se permite realizar vuelos tanto fuera

como dentro del alcance visual, siempre y cuando se tenga conexién con la
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controladora. En el caso de estar fuera del rango visual se debe poseer de un
certificado de piloto profesional avanzado. Todo ello bajo el cumplimiento de la
normativa al respecto.

e De 2 a 25 kg: destacar de esta categoria que solo se pueden utilizar dentro del
rango visual sin exceder 500 m. de distancia o, en el caso de estar equipado de
un sistema que permita detectar la presencia de otros usuarios, se podria realizar
vuelos BVLOS.

e De 25 a 150 kg: como elemento diferenciador a las anteriores categorias ésta
debe tener en posesion de un certificado de aeronavegabilidad. Dicho certificado
determina el cumplimiento con seguridad las condiciones de uso previstas del
RPA. Ademas, la aeronave debe estar registrada con su marca de nacionalidad y
de matricula.

e Mas de 150 kg: su regulacién viene determinada por la normativa europea
excluidos los RPA para la lucha contra incendios y servicios y salvamento. Estos

se integran en la categoria anterior.

Y por ultimo, tenemos la clasificacion que tiene en cuenta el uso para el que se va a
emplear la aeronave. Perteneciente a dicha clasificaciéon nos encontramos con:

e Uso militar: empleados en el ejército y conocidos como UCAV (Unmanned
Combat Aerial Vehicle). Son utilizados para realizar vigilancias, reconocimiento
del area de combate y como armamento. Podemos encontrarnos drones de gran
envergadura (unos 1000 kg) capaces de transportar misiles o inclusive utilizarlos
como bombas automaticas (kamikaze). Como ejemplo existe el MQ-1 Predator

mostrado en la Figura 4.

Figura 4: Dron militar MQ-1 Predator. Fuente: https://www.af.mil

En el otro extremo, en cuanto a tamafo, nos encontramos mini UCAYV utilizados
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para inspeccion de zonas de combate y también como explosivo automatico. En
la Figura 5 se muestra el mini dron denominado Black Hornet el cual se aprecia

su minusculo tamano.

Figura 5: Dron Black Hornet. Fuente: https://www.af.mil

Cabe recordar que los primeros drones fueron destinados a uso militar para

preservar la seguridad de los militares y no poner sus vidas en peligro.

e Uso civil: abarca los drones destinados a las necesidades de la sociedad que
pueden ser de uso recreativo o comercial. Se utilizan para un gran abanico de
actividades como pueden ser desde la filmografia hasta la inspeccion de una obra,
pasando por la monitorizacion de cultivos. En este caso nos encontramos drones
como el DJI Phantom 4 Pro (Figura 6).
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Figura 6: Dron de uso civil. Modelo DJI Phantom 4 Pro.. Fuente: https://www.dj.com.
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2.1.4. Entidades y normativa aeronautica
A continuacion, se hace referencia a las entidades y a la reglamentacion aeronautica

que, de algun modo u otro, afecta a la hora de realizar un vuelo con un RPA.

Debemos tener en cuenta que el desarrollo tecnoldgico es mucho mas avanzado que
el legislativo en cuanto a los RPAS, es por eso que para este tipo de aeronaves se les
aplica la normativa aplicada en aviacion privada. A pesar de ello, existe una normativa

especifica para drones que es la rigurosamente aplicable a este tipo de aeronaves.

Como el objeto de la investigacion no trata de cédmo ser un piloto de drones no
entraremos en profundidad en aspectos de circulacion, uso de instrumentos de
comunicacion, etc. sino de aquellos aspectos mas relevantes para el desarrollo del

vuelo fotogramétrico con seguridad dentro del espacio aéreo.

2.1.4.1. Organizacion de Aviacién Civil Internacional (OACI)

Internacionalmente conocida como ICAO por sus siglas en
inglés de “International Civil Aviation Organization” es la
organizacion aeronautica que regula internacionalmente Ila

aviacion civil. En tiempos de paz se convocé en el 1944 una

Convencion sobre Aviacion Civil Internacional en el cual se creé
la OACI y se constituy6 tres anos posteriores a la fecha. También conocida como
Convenio de Chicago esta formado por 96 articulos y 19 anexos que establecen
estandares y practicas recomendadas en materia de aviacion civil para los 191
Estados miembros. Entendemos entonces que la OACI se encarga de administrar

los principios establecidos en el Convenio de Chicago.
En cuanto a los RPAS, han visto la necesidad de entender, definir e integrarlos en

el panorama de la aviacion a través de la Circular 328 AN/190. Con ella tiene como

objetivo proporcionar un marco normativo fundamental de manera internacional.
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2.1.4.2. European Aviation Safety Agency (EASA)

Entidad que ejerce como 6rgano central y supervisor del nivel
comun de la proteccion de seguridad de los ciudadanos europeos
y sobre la proteccion medioambiental. También asegura la
implementacion legislativa y el proceso de certificacion sobre los

miembros europeos. Todo ello trabajando con las demas

organizaciones de aviacion internacionales.

Su papel sobre los RPAS se encuentra en pleno proceso de propuesta de un marco
regulatorio frente a la Comision Europea. Este pretende armonizar el reglamento

europeo asegurando seguridad, privacidad y proteccién del medio ambiente.

2.1.43. Agencia Estatal de Seguridad Aérea (AESA)

Organismo Estatal que asegura el cumplimiento de las normas
% de aviacién civil y su actividad en el territorio espafol. Su mision
AESA es la supervision, inspeccion y ordenacion del transporte aéreo,

AGENCIA ESTATAL . s P . .
DE SEGURIDADAEREA (€ la navegacion aérea y de la seguridad aeroportuaria.
Ademas, evaluan los riesgos en la seguridad del transporte
aéreo y tienen la potestad sancionadora ante las infracciones de las normas de

aviacion civil.

Entre sus competencias se encuentran los trabajos aéreos, formacién, navegacion

aérea, seguridad operacional, ensefianzas aeronauticas, espacio aéreo, etc.

Su cometido también es el desarrollo y la aplicacion de las normas de aviacién
nacional e internacional ya que estan presentes en organismos como la
Organizacién de Aviacion Civil Internacional (OACI), Conferencia Europea de
Aviacion Civil (CEAC), Agencia Europea de Seguridad Aérea (EASA) y
Organizacion Europea para la Seguridad de Ila Navegacion Aérea
(EUROCONTROL).

Por la parte que nos interesa, AESA regula las operaciones que se ejecutan con
drones de hasta 150kg. En cuanto al marco regulatorio aplicable a los RPAS, como
ya indicamos con anterioridad, se utiliza la correspondiente para vuelos privados.

Son los siguientes:
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e Ley 48/1960, de 21 de junio, sobre Navegacion Aérea.

e Ley 21/2003, de 7 de julio, de Seguridad Aérea

e Reglamento de Circulacion Aérea aprobado por el RD 57/2002, de 18 de enero

e RD 552/2014, de 27 de junio, por el que se desarrolla el Reglamento del aire
y disposiciones operativas comunes para los servicios y procedimientos de
navegacion aérea y se modifica el RD 57/2002, de 18 de enero, por el que se
aprueba el Reglamento de Circulacién Aérea.

e Ley 18/2014, de 15 de octubre, de aprobacion de medidas urgentes para el

crecimiento, la competitividad y la eficiencia.

Sin embargo, durante la investigacion y redaccién de la memoria, el Consejo de
Ministros aprobé el RD 1036/2017, de 15 de diciembre, por el que regula la
utilizacién civil de las aeronaves pilotadas por control remoto, y se modifican el RD
552/2014, de 27 de junio, por el que se desarrolla el Reglamento del aire y
disposiciones operativas comunes para los servicios y procedimiento de
navegacion aérea y el RD 57/202, de 18 de enero, por el que se aprueba el

Reglamento de Circulacion Aérea.

A continuacion, se desarrollan cada una de ellas para comprender su evolucion

legislativa en el campo de los drones.

21.4.4. Leyde Navegacion Aérea (LNA)
Ley 48/1960, de 21 de junio, sobre Navegacion Aérea

Recoge la legislacion basica sobre aviacion relacionado con el espacio aéreo
situado sobre el territorio espafiol y su mar territorial como se indica en el primer

articulo.

El articulo onceavo tenia definido el concepto de aeronave sin tener en cuenta los
RPAS. Sin embargo, con la Ley 18/2014 dicho articulo tiene una modificacion
dejando su definicion de la siguiente manera:
a) Toda construccion apta para el transporte de personas o cosas capaz de
moverse en la atmoésfera merced a la reacciones del aire, sea 0 no mas ligera

que éste y tenga o no 6rganos motopropulsores.
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b) Cualquier maquina pilotada por control remoto que pueda sustentarse en la
atmosfera por reacciones del aire que no sean las reacciones del mismo contra

la superficie de la tierra.

La ley también hace referencia a un documento identificativo de la aeronave, con
sus caracteristicas y la nacionalidad del mismo. Dicho documento se denomina
Certificado de Aeronavegabilidad. Por otro lado también menciona la necesidad de

un Registro de Matricula de Aeronaves. Sin embargo, el articulo 151 indica:

Las actividades aéreas que se realicen a los fines del articulo anterior, excepto las
de turismo y las deportivas, requeriran la comunicacion previa a la Agencia Estatal
de Sequridad Aérea o su autorizacion, a efectos de mantener la seguridad en las
operaciones aeronauticas y de terceros, en los casos en que la naturaleza de estas
operaciones, el entorno o circunstancias en que se realizan supongan riesgos
especiales para cualquiera de ellos, y estaran sometidas a su inspeccion en los

términos establecidos por la legislacion vigente.

Aquellas aeronaves de limitados usos, caracteristicas técnicas y actuaciones,
podran ser exceptuadas, en las condiciones que reglamentariamente se
establezcan, de los requisitos de inscripcion en el Registro de Aeronaves y de la
obtencion del certificado de aeronavegabilidad a los cuales se refieren,
respectivamente, los articulos 29 y 36 de esta Ley. Para tripular estas aeronaves
no es exigible el titulo que requiere el articulo 58 de esta Ley, determinandose por
el Ministerio de Fomento, en su caso, las condiciones que deben cumplir los

tripulantes para su pilotaje.

Dos parrafos que en nuestro caso, segun la normativa especifica, entramos en el
grupo de aeronaves exceptuadas de dichos documentos. Es a partir de 150 kg
cuando la aeronave debe tener su Registro de Matricula y su Certificado de

Aeronavegabilidad.

21.4.5. Leyde Seguridad Aérea (LSA)
Ley 21/2003, de 7 de julio, de Seguridad Aérea

Su objeto, como indica el articulo 1, es el siguiente:
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Esta ley tiene por objeto determinar las competencias de los organos de la
Administracion General del Estado en materia de aviaciéon civil, regular la
investigacion técnica de los accidentes e incidentes aéreos civiles y establecer el
régimen juridico de la inspeccion aeronautica, las obligaciones por razones de
sequridad aérea y el régimen de infracciones y sanciones en materia de aviacion

civil.

Sus disposiciones tienen por finalidad preservar la seguridad, el orden y la fluidez
del trafico y del transporte aéreos, de acuerdo con los principios y normas de

Derecho internacional reguladores de la aviacion civil.

En cuanto a los VANT, tratdndose de aviacion civil, estan sujeto a dicha ley y

consecuentemente a la regulacion sobre infracciones y sanciones.

2.1.4.6. Reglamento de Circulacion Aérea (RCA)
Reglamento de Circulacion Aérea aprobado por el RD 57/2002, de 18 de enero

RD 552/2014, de 27 de junio, por el que se desarrolla el Reglamento del aire y
disposiciones operativas comunes para los servicios y procedimientos de
navegacion aérea y se modifica el RD 57/2002, de 18 de enero, por el que se
aprueba el Reglamento de Circulacion Aérea.

Es el reglamento que administra las operaciones con aeronaves y que juntamente
con Anexos de la OACI y otras regulaciones de la Unién Europea desarrollan la
LNA. Su importancia recae sobre todo en la conducta que debe conocer y realizar

un usuario del espacio aéreo, como puede ser un piloto de RPAS.

Como hemos mencionado anteriormente, al estar fuera del objeto de investigacion
no entraremos en detalles circulatorios en el espacio aéreo. Dentro de la normativa
especifica para RPAS se introduciran los conceptos relevantes para el desarrollo

de un vuelo dentro de la legalidad.
En este caso, solo mencionar las restricciones del espacio aéreo. ENAIRE es el
ente que delega AESA para la gestién de navegacion aérea en Espafa y

recientemente ha publicado aplicaciones de consulta respecto al espacio aéreo.
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Por un lado tenemos INSIGNIA, nos da acceso a las cartas aeronauticas del

territorio espafol y, por otro lado, tenemos /ICARO que nos permite consultar

restricciones temporales o segregadas de la zona a volar.

A la hora de consultar y comprobar en las cartas aeronauticas las limitaciones
debemos saber que existen diferentes tipos de restricciones que vienen
identificadas por Coédigo del pais + Tipo + Numero.

« TENERIFENORTE ATZ °,

.

G B ;
| . TENERFENORTECTR
5 .

)

-« TENERIFESURATZ [
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: . TENERIFESURCTR |
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1

Figura 7: Representacion de carta aeronautica . Fuente: aplicacion Insignia de ENAIRE

Los codigos para el territorio espafiol son: LE (peninsula, Baleares y Ceuta), GE
(Melilla) y GC (Canarias).

En cuanto a los diferentes tipos de restricciones y su identificacion tenemos:
e Zona peligrosa (D)
e Zona prohibida (P)

e Zona restringida (R)

También podemos encontrarnos con areas de vuelo temporalmente restringidas
(TRA) y areas temporalmente segregadas (TSA + Numero de identificacién) que
son publicadas mediante un NOTAM (Notice To Airmen). Dicho concepto se explica

en el apartado en el que se habla sobre los parametros prevuelo a tener en cuenta.
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Como ejemplo tenemos el Parque Nacional del Teide con una identificacion

GCR151 (Figura 7) indicando que se trata de una zona restringida.

21.4.7. Ley18/2014

Ley 18/2014, de 15 de octubre, de aprobacion de medidas urgentes para el
crecimiento, la competitividad y la eficiencia.

Con esta ley entramos en normativa especifica para RPAS. De hecho, debido a la
ausencia de una normativa reguladora definitiva, provisionalmente se aplicaba el
articulo 50 dedicado exclusivamente a las operaciones de aeronaves civiles

pilotadas por control remoto.

Durante tres afos fue la ley de referencia para el uso de VANT en espacio aéreo
espafol. A pesar de ello, a finales del 2017 entra en vigor el Real Decreto
1036/2017 que finalmente se dedica a regular en exclusividad las operaciones con

drones.

21.4.8. RD 1036/2017

Real Decreto 1036/2017, de 15 de diciembre, por el que se regula la utilizacion civil
de las aeronaves pilotadas por control remoto, y se modifican el Real Decreto
552/2014, de 27 de junio, por el que se desarrolla el Reglamento del aire y
disposiciones operativas comunes para los servicios y procedimientos de
navegacion aérea y el Real Decreto 57/2002, de 18 de enero, por el que se aprueba
el Reglamento de Circulacion Aérea.

En cuanto a nuestra investigacion se refiere, los articulos de interés seran los
correspondientes a aeronaves pilotadas por control remoto con una masa maxima
al despegue inferior a 25 kg. El Real Decreto se estructura en 44 articulos divididos

en 6 capitulos.

En resumidas cuentas, la informacion de utilidad es la siguiente:

Se debe:
e Volar a una altura maxima de 120 m. sobre la cota de despegue.
e Volar de dia y en buenas condiciones meteorologicas.

e Volar con seguridad y bajo supervision, si es necesario.
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Ser responsable de los posibles dafios que se ocasione. Recomendable seguro a
terceros.
Tener autorizacion en caso de difundir imagenes de personas o emplazamientos
privados.

Cumplir la Ley de Proteccion de datos

Se prohibe:

Volar sobre zona urbana y aglomeraciones de edificios.

Volar sobre personas.

Volar de noche

Volar a una distancia inferior a 8km de aeropuertos, aerédromos, etc.

Volar en espacio aéreo controlado

Para uso profesional se permite, bajo autorizacion de AESA:

Volar sobre zona urbana, aglomeraciones de edificios y personas.

Volar de noche

Volar a una distancia inferior a 8km de aeropuertos, aerédromos, etc.

Volar en espacio aéreo controlado y zonas de informacion de vuelo.

Volar en BVLOS (Beyond Visual Line of Sight) con un RPA con un peso superior a
2 kg.

2.1.5. Aplicaciones de los RPA en la construccion

Seguramente relacionamos directamente con la captura de imagenes con drones el

campo de filmacién y fotografia. Sin embargo, dentro del sector de la construccién

tiene un gran abanico donde formar parte dichas aeronaves.

Charfen (2015) para su trabajo final de master realizé la investigacién sobre

“Recomendaciones para la aplicaciéon de los drones en el mundo de la arquitectura”

basandose sobre todo en la experiencia de empresas que se dedican a explotar esta

herramienta. Teniendo en cuenta su trabajo, lo utilizamos como documento de partida

para desarrollar la idea de este apartado.
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A continuacién, citaremos todas las aplicaciones encontradas tras realizar una
revision bibliografica de articulos, noticias y videos demostrativos en relacion al uso

de drones desde la fase de proyeccion hasta la vida util de un edificio.

Emplazamiento y programacion de obras

Desde las fases previas a un proyecto arquitecténico podemos utilizar los drones para
obtener informacién. Ya con la idea de saber que podemos realizar capturas
fotograficas y videograbaciones se puede, por un lado, conocer el emplazamiento y
su entorno a vista de pajaro, adaptando e integrando la construccion en su ambiente
inmediato. Por otro lado, si tenemos en cuenta la metodologia empleada por El
Meouche, Hijazi, Poncet, Abunemeh y Rezoug (2016) para realizar su comparacion
entre un método tradicional frente al proceso de adquisicion de imagenes mediante
dron, podemos obtener una nube de puntos de la topografia del lugar de interés.
Posteriormente, esta nube puede ser utilizada tanto para la topografia del proyecto

como para emplazar la obra y su posterior programacion.

Sequimiento de obras, control de calidad y seguridad y salud

Fang, Chen, Cho y Zhang (2017) plantean el uso de los RPA en sustitucion al uso de
camaras situadas en posiciones fijas para el modelado as-is de las condiciones del
emplazamiento. Estas presentan mayores ventajas debido a que las fijas pueden sufrir
alteraciones al situarse en localizaciones auxiliares de la obra, por condiciones de
iluminacion o que se queden las camaras ocluidas por algun elemento constructivo.
Con ello pretenden monitorizar activos moviles de una obra como puede ser los
trabajadores, los camiones hormigonera, los materiales, etc. con la finalidad de
obtener una nube de puntos y realizar el seguimiento de los elementos con el objetivo

de contribuir al progreso de la obra, control de calidad y seguridad y salud.

En la investigacion de Tuttas, Braun, Borrmann y Stilla (2016) evaltan tres modos de
adquirir imagenes para el seguimiento de una obra a través de su monitorizacion: (1)
de manera movil con una camara digital y manualmente, (2) de manera movil con un
RPA 'y (3) con camaras fijas situadas en las gruas. De esta manera obtienen una nube
de puntos as-built con la que estudiar y realizar el seguimiento de la obra. Cada una
de las estrategias presentan diferentes limitaciones ya que en uno se perciben mas
los elementos verticales (pilares, muros,...) y en otros los horizontales (forjados,...).

Finalmente, tras la valoracion de los resultados, los autores concluyen la necesidad
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de utilizar las imagenes obtenidas con el dron para complementar las otras maneras

de adquisicion.

Inspecciones y mantenimiento
Como ya hemos visto en el apartado de la clasificacion de drones existen de diferentes

pesos, sobre todo debido a las diferentes capacidades de los mismos. Si utilizamos
un multirotor capaz de soportar una camara multiespectral obtenemos una
herramienta aérea con fines de inspeccion. Precisamente, el trabajo de Mader,
Blaskow, Westfeld y Weller (2016) estudian la alternativa de usar drones con este tipo
de camaras para sustituir el uso de vehiculos pesados, cortar trafico y el tiempo
requerido para realizar inspecciones de obras civiles. En su caso utilizan utilizan tres
vehiculos no tripulados: (1) con un laser escaner 2D low-cost, (2) con una camara
RGB y (3) con un multiespectral formado por una camara RGB, una camara infrarrojos
y una camara térmica, todas ellas fijadas en una barra. Con todo ello inspeccionaron
el estado en el que se encontraba un puente gracias a las nubes de puntos obtenidas

en los distintos formatos.

Otro ejemplo de un estudio de inspecciéon y mantenimiento es el realizado por Branco
y Segantine (2015) en el que “presentan MaNIAC-UAV (Methodology for Asphalt
Automatic Characterization - using Unmanned Aerial Vehicles) una metodologia low
cost y automatica para la deteccién de defectos en la superficie del asfalto usando
VANTSs para soportar la Gestion de Sistemas de Pavimento”. Definen el flujo de trabajo
desde la recopilacion de informacién mediante fotografias aéreas hasta la deteccion y

definicion de los defectos encontrados en el pavimento.

De la misma forma que que los autores anteriores han aplicado las inspecciones y el

mantenimiento en la obra civil, ésta es aplicable a la edificacion.

Eficiencia energética

Previtali, Barazzetti, Brumana y Roncoroni (2013) publican un trabajo en el que
realizan un analisis de las aplicaciones del uso de VANTSs para la eficiencia energética.
Ven la importancia de utilizar estos vehiculos como técnica para inspecciones vy, asi,
detectar puentes térmicos o pérdidas de calor. Por ello, destacan la importancia de
integrar modelos BIM y la informacion de datos térmicos en un modelo unico.
Sobrevuelan dos edificios, el D’Oggiono Building en Lecco y el Edificio 21 en Milan,

con un octocéptero que lleva consigo instalada una camara Sony-NEX5N y una
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camara térmica FLIR Tau 640. Los resultados obtenidos son utilizados como texturas
en un modelo BIM para integrar los datos térmicos en él. También utilizan TLS
(Terrestrial Laser Scanning) para generar nubes de puntos de las fachadas a

investigar.

Levantamiento

En este caso el uso del dron se traslada a la aplicacién sobre el parque edificatorio
existente. Se trata de realizar un levantamiento fotogramétrico mediante la informacién
obtenida y trabajar su modelado o delineado en programas CAD, BIM, etc. Sus
finalidades pueden ser muy variables, desde utilizar el modelo para una ampliacién,
un levantamiento topografico, medicion de fachadas o, como muestran Nasir y Tahar
(2017) en su investigacion, para la conservacion de patrimonio. En su estudio
proponen el uso de la fotogrametria mediante VANT como herramienta para la

recopilacién de imagenes y generar posteriormente el modelo 3D.

Patologia, rehabilitacion y conservacion del patrimonio

En este campo de la edificacién bien podemos citar trabajos como el anterior, cuyo
cometido es realizar un levantamiento para la conservacién del patrimonio. Sin
embargo, queremos destacar el trabajo de Pereira y Pereira (2015) sobre el
reconocimiento de grietas durante el vuelo de un RPAs a través de un sistema
integrado en el mismo. La investigacion consiste en utilizar diferentes métodos de

deteccién de este tipos de aberturas en las fachadas.

El primero método, conocido como operador de Sobel, convierte las imagenes RGB
(Red Green Blue) en escala de grises aplicando una ecuacion. Tras ello emplean un
algoritmo para detectar los limites de la grieta obteniendo una derivada que procesa
los diferentes niveles de grises de la imagen. Seguidamente, los pixeles se convierten
en un nivel Iégico de 0 y 1 que permiten la deteccion de discontinuidades de una grieta.
Tras el procesado de imagenes finalmente obtienen informacién como la orientacion,
grosor y longitud que permiten clasificar las hendiduras. El segundo método consiste
en un algoritmo Filtro de Particulas. Este estudia segmentos de la imagen
relacionando la probabilidad de existir un corte o no, basandose en la intensidad de

cada uno de los pixeles y de los que se encuentran alrededor.
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También, se plantean como implementar el proceso de imagenes llegando a dos
posibles escenarios: (1) El dron recopila la informacién, la almacena y (1a) tras
finalizar el vuelo se procesan las imagenes con un ordenador de sobremesa con Linux
o (1b) se envian inalambricamente desde el dron a la estacién de tierra. (2) Equipar el
dron con un procesador Raspberry-Pl con el proceso de imagen implementado y
trabajando durante el vuelo o (3) que el RPA esté equipado con un dispositivo

programable FPGA que ejecute un programa C/C++ con un procesador Microblaze.

Finalmente, tras comparar todos los escenarios posibles con los diferentes algoritmos
y procesadores, los autores llegan a una conclusion de que la mejor opcion es utilizar
el algoritmo Filtro de Particulas con una Raspeberry-Pl para una deteccion preliminar
y en caso de altas posibilidades procesar la informacion con el operador de Sobel con

un ordenador de sobremesa.

Legalidad
Para reflejar la aplicacion del uso de drones en la legalidad de una construccion

emplearemos una noticia como recurso. Segun Bussines Insider Espafia (2019) en su
articulo online dan la noticia de que el Ministerio de Hacienda emplearan vehiculos no
tripulados para la inspeccién de obras ilegales en un millar de municipios de Espafia.
Pretenden localizar fraudes inmobiliarios no declarados como pueden ser piscinas,
ampliaciones, garajes, terrazas, etc. ya que en el articulo 11 de la Ley del Catastro
Inmobiliario legisla la obligatoriedad de declarar de forma completa y correcta las altas
de nuevos bienes inmuebles o las modificaciones realizadas para que concuerde con
la realidad catastral. La motivacion de esta aplicaciéon de RPA es regularizar los
aumentos de valor de inmuebles y, consecuentemente, el valor del IBI (Impuesto sobre

Bienes Inmuebles).

Promocién

La parte mas comercial de la construccion de un edificio es la promocién inmobiliaria,
fase cuyo objetivo es conectar con los clientes o inversores con la finalidad de realizar
la transaccion de compra-venta de una vivienda. Como se ha mencionado
anteriormente, una de las aplicaciones mas conocidas de un RPA es la filmacion
gracias a la camara que estos vehiculos aéreos portan anexada a su sistema.
DronAirProjects es una empresa que realiza videografias promocionando inmuebles.

Un ejemplo de su trabajo es el video titulado Promocién inmobiliaria / Dron Air Projects
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contenida en la plataforma de YouTube. Con dichos trabajos filmograficos se ofrece
una perspectiva a vista de pajaro que cambia la vision que se tiene de la vivienda,
permitiendo ver el entorno inmediato, sus vias de acceso, una vision estructural fuera
del alcance del nivel terrestre, etc. provocando una captacion visual mayor que otros

medios infograficos.

2.2. Building Information modeling (BIM)

2.2.1. ;Qué es BIM?

Nos encontramos en un momento profesional de la construccion en el que no paramos
de escuchar las palabras ‘Building Information Modeling (BIM)’ pero, sin embargo, esta
metodologia surge en el 1974 con la publicacion ‘An Outline of the Building Description
System’de Charles M. Eastman (Aryani, Brahim y Fathi, 2014). El profesor no empleé
concretamente el término BIM pero si hace referencia a una metodologia de un unico

archivo con los diferentes aspectos del edificio.

Actualmente, la mejor definicion que podemos emplear es que se trata de una
metodologia de trabajo colaborativo que gestiona el disefio y los datos del proyecto

en formato digital durante el ciclo de vida del edificio.

2.2.2. CAD vs. BIM

Como se puede observar se han resaltado unas palabras clave en la definicion que

dan sentido al concepto de ‘Building Information Modeling’ por su directa relacion.

Con respecto a ‘Building’ tenemos el ciclo de vida del edificio. En el método tradicional
CAD (Computer Aided Design), se entregaba la documentacion a los interesados en
cada una de las fases. Sin embargo, existe la pérdida de dicha informacion al estar
descentralizado. El objetivo final de una practica integrada de un archivo sin pérdida
de informacion seria llegar a desarrollar el mantenimiento y el uso del edificio durante

su ciclo de vida.
En cuanto a la inicial |, la parte mas innovadora de este concepto, se refiere a los

datos mas esenciales del proyecto. Con el modelo BIM se pretende gestionar la

informacion que los diferentes agentes intervinientes (arquitectos, arquitectos
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técnicos, ingenieros, promotores, fabricantes, constructores, etc.) desarrollan sobre
un proyecto y, asi, administrarla de manera ordenada. Esta metodologia nos
proporciona esquemas, planos, tablas de cuantificacion, detalles constructivos,
imagenes, videos, mediciones, calculos energéticos, céalculos de instalaciones y
célculos de estructura. A diferencia de CAD, la informacién que tenemos es
meramente grafica. Por ejemplo, en la representaciéon de un muro tendriamos dos
lineas, un relleno, el nombre y el color de la capa. Sin embargo, en un software BIM
se puede almacenar la composiciéon del muro, los materiales, el grosor, la altura, coste,

las transmitancias térmicas de los materiales, etc.

Y finalmente, la parte geométrica del disefio se asimila con la M. Utilizando la
metodologia BIM existe un mayor control de los cambios al tener enlazado todas vistas
entre si, inclusive el 3D. Al producirse una modificacion en el modelado
automaticamente se actualiza toda su geometria e informacion. No obstante, si dicho
cambio se realiza en un proyecto CAD se debe realizar de manera manual en todos

aquellos planos y parametros de afecte.

En conclusion, con la metodologia BIM conseguimos las siguientes ventajas:
e Mayor coordinacién
e Aumento de productividad
e Control de informacion
e Disefio y mejor calidad de detalle
e Facilita la relacién con el cliente
e Mejores flujos de trabajo
e Reduccion de errores

e Reduccion de costes imprevistos

2.2.3. Dimensiones BIM

Representa el ciclo de vida de un proyecto, es decir, el alcance de la metodologia BIM
que va desde una idea principal hasta el mantenimiento del edificio y su posterior
demolicién. Dicho ciclo se recoge el siete dimensiones:
e 1D Idea: es el punto de origen de un proyecto en el que, partiendo de la idea
principal, se define la viabilidad de la obra, estimacion de trabajo, la
localizacién, su condicion inicial y el plan de ejecucion que se va a llevar a

cabo.
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e 2D Documentacion: se establece la informacion necesaria para desarrollar el
proceso de modelado y su calculo. El objetivo es determinar los materiales, la
dimension energética a alcanzar, las cargas estructurales, etc.

e 3D Modelado: llegados a este punto se procede en plasmar todos los datos
obtenidos en las dimensiones anteriores en un modelo tridimensional en las
tres disciplinas: arquitectura, estructura e instalaciones. La informacién
plasmada en esta dimension sera la que posteriormente se coordine en las
siguientes dimensiones.

e 4D Tiempo: analiza, planifica y programa la duraciéon de la obra pudiendo
definir las diferentes fases del proyecto. De igual modo permite realizar el
control del modelado en cuanto a conflictos de obra. Ello permite optimizar el
tiempo en diseno y evitar solventar el problema en obra. También otorga la
posibilidad de realizar el seguimiento y control de obra para su estudio de
tiempos.

e 5D Coste: analiza la estimacion de coste con su respectivo control en obra.
En esta dimensién vemos la importancia de definir los materiales a utilizar en
un proyecto BIM. Por otro lado, también no solo tiene protagonismo en el
desarrollo de un proyecto edificatorio sino que también a posteriori, durante su
uso y mantenimiento.

e 6D Sostenibilidad: gracias a la definiciéon de materiales, a su ubicacién y a
parametros meteorolégicos podemos realizar la simulacién energética del
edificio. Este avance permite realizar analisis energéticos y la simulacion de
las diferentes opciones. Todo ello siempre con el fin de plantear la solucion
con mejor comportamiento frente a la gestién de los recursos de optimizacion
de energia.

e 7D Mantenimiento: la gran ventaja de realizar un modelo integrado de
informacion hace que durante el ciclo de vida del edificio permite ir

actualizando los datos para su mantenimiento.

2.2.4. Level Of Development (LOD)

En el vocabulario BIM el término LOD se utiliza para determinar el nivel de desarrollo
de un proyecto. Segun la publicacién en BIMFORUM sobre el LOD existen seis niveles

de desarrollo:
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e LOD 100: se utilizan elementos que representen de manera aproximada la
informacion grafica que se quiere modelar. Indican la existencia de un
componente pero su forma, medida y su localizaciéon exacta.

e LOD 200: seguimos teniendo una representacion grafica aun bastante
genérica pero en este nivel recoge informacion tal y como las cantidades,
medidas, forma, ubicacion y orientacion.

e LOD 300: es el nivel 200 pero con una representacion grafica mas especifica.

e LOD 350: de igual manera que el anterior nivel pero con informacion sobre
sistemas de construccion.

e LOD 400: en este caso ya debe recoger informacién sobre fabricacién
instalacion y ensamble del elemento.

e LOD 500: un modelado preciso y apurado en todos los términos. Siendo un

as-built del edificio.

2.2.5. Equipos multidisciplinares
Fuera de la metodologia BIM la informacién que se tenia sobre un proyecto era de
manera dispersa y con una complejidad de coordinacion elevada. Ello se pretende
solucionar con un modelo ideal en el que colaboran los diferentes agentes de la
construccion partiendo de un mismo archivo. Hay que entender que dicho archivo de
debe permitir construir fielmente aquello que plasmamos, evitando colisiones entre los
diferentes elementos constructivos para evitar solucionarlo en obra. De ahi la

importancia de la coordinaciéon y comunicacion entre los agentes de la obra.

Para que todo proyecto se pueda llevar a cabo de manera ordenada se debe tener
redactado una serie de pautas. Todo ello se ve reflejado en un documento llamado
BEP (BIM Execution Plan) y que contendra informacion como el alcance del proyecto,
la planificacion, el flujo de trabajo, la nomenclatura de los archivos, sistemas de
gestion, reuniones, LOD, etc. Todo ello para garantizar el buen funcionamiento y la

transferencia de informacién entre todos.

Por ultimo, cabe mencionar que el BEP es un documento vivo y en constante

actualizacién para la mejora continua de la implementacion.
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2.2.6. Interoperabilidad

Cuando escuchamos sobre la metodologia BIM se tiene la utopia de un unico archivo
con todas las disciplinas sin embargo la realidad es otra. Como ya hemos dicho
anteriormente, cada uno de los profesionales parte de un archivo central el cual
importan en el programa que dominan. Para ello se necesita una interoperabilidad de

archivos entre los diferentes programas informaticos.

De ahi parte la idea de un formato de archivo capaz de transferir informacién mediante
un documento de texto o una tabla excel. Dichos formatos estandarizados son .ifc y el

.cob.

Por un lado, tenemos el IFC (Industry Foundation Classes) surgido en los paises
nordicos. Es un estandar de intercambio de informacion de proyectos que almacena
los datos geométricos de un proyecto BIM. El hecho de tener un tipo de archivo de
almacenaje de datos nos permite utilizar diferentes plataformas de molado sin
necesitar estar atado a un producto comercial. De este modo, también permite que
diferentes departamentos con otras disciplinas pueda trabajar con un mismo proyecto.
También permite el intercambio de archivos para la adjudicacion de proyectos publicos

en caso de concurso.
Por otro lado, esta el COBie, otro modelo de datos que almacena informaciéon de

activos del edificio que permiten la busqueda de informacion en sus tablas de datos

de una hoja de calculo.
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3. Estudios previos de trabajos de investigacion

Para desarrollar el actual trabajo de investigacion se ha realizado previamente un revision
bibliografica de articulos relacionados con el objeto de estudio. Se ha seguido la metodologia
descrita anteriormente obteniendo un numero reducido de recursos por su escasez de
resultados.

A continuacién, se menciona los diferentes trabajos de investigacion estudiados como
referencia de partida. En cada uno de ellos se realiza un resumen de las ideas principales de
su contenido para entender la base de la investigacion.

Se ha realizado la lectura de trabajos de investigacion con fines similares al establecido en
este documento. Por ello, seguidamente, veremos trabajos en los cuales principalmente han
realizado documentacion 3D mediante la recopilacién de informacién grafica mediante el uso
de drones. Se ha ordenado las investigaciones segun el afio de publicacién para conocer la
evolucién de los estudios a los largo de los afios.

En una primera instancia Qin, Gruen y Huang (2012) en su trabajo “UAV Project -
Building a reality-based 3D model of the NUS (National University of Singapore)
Campus”realizaron el levantamiento de un modelo 3D del Campus de la Universidad
de Singapur. Su investigacion consistio en describir las misiones del RPA y el flujo de
trabajo para generar el modelo. En este caso utilizaron un drone octocoptero con una
camara mirrorless como parte de su payload. Sobre su trabajo de campo destacar las
dificultades con las que se encontraron. Debido a la regulaciones aéreas su mision
fue aprobada tras 6 meses de evaluacion del departamento aéreo pertinente de su
pais, por otro lado, debido a la bateria del RPA tuvieron que dividir la mision en varios
vuelos, concretamente 43. Ademas hay que tener presente la dificultad de coordinar
el despegue, el vuelo y el aterrizaje sobre una superficie con transeuntes y en un area
segura. También las posibles alteraciones electromagnéticas de la zona y las rafagas
de viento. En su caso también tenian calibrar y georeferenciar las imagenes extraidas
para su posterior procesado. Finalmente, tras dar solucion a todos los obstaculos,
realizaron el modelado con Cyber-City Modeler. Cabe mencionar que se trata de un
estudio realizado anteriormente al 2012 y desde entonces muchos de los problemas

encontrados son mas facil de resolver en la actualidad.

Siebert y Teizer (2014), por otro lado, en su publicacion “Mobile 3D mapping for
surveying earthwork projects using an Unmanned Aerial Vehicle (UAV) system”
realizan un trabajo similar al anterior pero aplicado en el levantamiento de la superficie

donde se realizan trabajos de movimientos de tierra. A pesar de utilizar los mismos
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conceptos y en algunos casos tener las mismas dificultades, introducen los conceptos
Global Positioning Systems (GPS) y gimbal (estabilizador) que ayudan a obtener las
fotografias georeferenciadas y estables. También, hacen uso de un programa
comercial sobre procesamiento de imagenes llamado Agisoft PhotoScan que
actualmente es de los mas conocidos del mercado y facilitan su flujo de trabajo. Y por
ultimo, queremos destacar de esta publicacion la comparacion que realizan entre la
obtencion de la topografia mediante RTK GPS y fotogrametria con RPA, resultando
este Ultimo con un rendimiento tres veces mayor teniendo en cuenta la preparacion,

recopilacién, evaluacion y procesado de la informacion obtenida.

Ruzgiene, BerteSka, Gedyte, Jakubauskiene y Aksamitauskas (2015) a través de la
publicacion “The surface modelling based on UAV Photogrammetry and qualitative
estimation” investigan la cantidad necesaria de Ground Control Point (GCP), puntos
de referencia, sobre la superficie a escanear para tener una calidad de imagen y una
mayor precision de medida. Inician la captura de imagenes con 12 GCP, a modo de
investigacion bajan a 10 y finalmente a 5 puntos de control. El procesado de imagenes
lo realizan con otro programa comercial llamado Pix4D que, juntamente con el
PhotoScan, abarcan el mayor mercado para esta parte del flujo de trabajo con drones.
Finalmente, concluyen que si distribuyes los 5 GCP de manera uniforme en vez de 10
de manera aleatoria o lineal, la comparacién de precision entre ambos casos es

practicamente inexistente.

Siguiendo con la revisién bibliografica Zarnowski, Banaszek y Banaszek (2015) en su
“Application of technical measures and software in constructing photorealistic 3d
models of historical building using ground based and UAV digital images” realizan una
investigacion de gran interés para el presente trabajo debido a que (1) utilizan un RPA,
de igual modo que nosotros, de la compania DJI aunque con mayores prestaciones,
(2) también realizan la obtencién de fotos con la camara propia del dron teniendo
georeferenciacion y compara los resultados con una camara compacta y una réflex,
ambas sin georeferenciacion, (3) comparan los tiempos de procesado entre
ordenadores de mesa con la unica diferencia de que uno tiene una tarjeta RAM de
48GB y otra de 64GB y (4) enfrentan los resultados obtenidos tanto del Agisoft
PhotoScan como el Pix4D comparando la nube de puntos, la nube densay las texturas

generadas.
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En este caso, Themistocleous, Agapiou, y Hadjimitsis (2016) en su trabajo “3D
Documentation and Bim Modeling of Cultural Heritage Structures Using Uavs: the
Case of the Foinikaria Church” se diferencia de los anteriores porque realiza el
levantamiento de un modelo 3D de un bien de patrimonio cultural mediante la
metodologia BIM. A pesar de utilizar un drone DJI, que actualmente tienen montadas
sus camaras propias, en este caso anexan una camara GoPro Hero+ y realizan la
recopilacién de manera manual para evitar los obstaculos que se presentan. Debido
al gran angular que tiene la camara el equipo de investigacion tuvo que eliminar la
distorsién de la lente reflejada en las imagenes anteriormente al procesado mediante
Agisoft PhotoScan. Tras ello convierten la nube de puntos al formato .rcp para
importarlo a Autodesk Revit y redactar informacion grafica de la Iglesia Foinikaria.
Finalmente, los autores concluyen que la informacion BIM generada puede ser

utilizada para futuras renovaciones o ampliaciones del lugar.

Incluimos la investigacion de Yastikli y Ozerdem (2017) sobre “Architectural heritage
documentation by using low cost UAV with fisheye lens: Otag-l Humayun in Istanbul
as a case study” porque, a pesar de ser muy similar a las anteriores, en este caso
realizan la recopilacion de informacion volando un dron lowcost. y que forma como
condicién de este trabajo. Los investigadores concluyeron con una viabilidad positiva

el uso de este rango economico del VANT.

El trabajo de Nasir y Tahar (2017) sobre “3D model generation from UAV: Historical
mosque (Masjid Lama Nilai)” ya ha sido citado con anterioridad en el apartado de
aplicaciones con drones en la construccion. Su investigacion sigue la linea de la
conservacion de patrimonio pero lo queremos mencionar de nuevo en este apartado
ya que emplean una metodologia que ellos dividen en cuatro fases; “Fase | es el
estudio preliminar y una exploracioén inicial de los problemas. Fase Il adquisicion de
datos para el plan de vuelo y la calibracion de la camara. Fase |l procesado de datos
para generar el modelo 3D usando cinco pasos que son procesado de imagenes,
alineacion de imagenes, nube de puntos densa, malla y textura. Fase IV es el
resultado y analisis obtenido del modelo 3D evaluando la precision y el render del
modelo”. Para tener una mayor precision del modelo realizan varias mediciones in situ
con un flexémetro para trasladarlas al programa Agisoft PhotoScan y escalar el

volumen. Aprovechando los datos realizan una comparacion entre los obtenidos con
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el software y los valores medidos, obteniendo una RDCM (Raiz de la Desviacion

Cuadratica Media) entre los dos conjuntos de datos de +0.05m.

Y por ultimo, cabe mencionar el estudio de Karachaliou, Georgiou, Psaltis y Stylianidis
(2019) titulado “UAV for mapping historic buildings. From 3D modelling to BIM”. Es el
trabajo con mayor aproximacion con el objetivo de este TFM, realizando un
levantamiento de un museo como parte del Patrimonio Cultural de Metsovo, Grecia.
Introducen el concepto de Historic Building Information (HBIM) tras realizar una
revision bibliografica de articulos relacionados con esta idea. Se trata del desarrollo
de documentacion sobre patrimonio cultural con la metodologia BIM, en este caso
obteniendo datos fotogramétricos con un dron, apoyandose de documentacion
arquitectonica existente del edificio de interés y de mediciones realizadas en el lugar.
Acabando con el razonamiento de la gran utilidad del modelo BIM para usarse, no
solo, en “renovaciones y ampliaciones del museo, si no que también para actividades

académicas”.
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4. Casos de Estudio

4.1. Antecedentes del proyecto

Figura 8: Complejo industrial del Elevador de Aguas. Fuente: CICOP

En la actual investigacion se ha planteado el levantamiento del Elevador de Aguas de
La Gordejuela como la principal edificacién de estudio. Realizando una revision
bibliografica en la Fundacion CICOP (Centro Internacional para la Conservacion del
Patrimonio) encontramos informacion en una ficha técnica, adjuntada como Anexo |,
sobre este bien cultural que forma parte del patrimonio industrial de la isla. De igual
manera, se encontrd informacion, planos de situacion y planos de la edificacién en un
TFM consistente en una “Propuesta de proyecto de Restauracion y Rehabilitacion del
antiguo Elevador de Aguas de la Gordejuela” (Ruiz, Farifia y Gonzalez, 2004) que se

adjunta como Anexo 2.

Se trata de una obra realizada en el 1903 por el ingeniero militar José Galvan
Balaguer. En su momento, como podemos ver en la Figura 8, era un complejo

industrial formado por tres edificios, un depdsito y una gran chimenea.
El primero de ellos, situado junto a la gran chimenea, se trataba de un edificio de una
planta rectangular y una cubierta a dos aguas destinada para los trabajadores.

Descendiendo por las escaleras se llegaria al edificio donde se situaba las calderas.
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Y por ultimo, el edificio emblematico y que se aprecia desde el sendero para su
acceso, se trata de una edificacion asentada sobre la roca del acantilado a una cota
de 40 metros sobre el mar. Vista en planta se aprecia que es de forma rectangular con
una coronacion de una cubierta de dos aguas. En su fachada se diferencian cinco
alturas. La inferior era principalmente la cimentacion con una galeria que conecta las
fachadas Este-Oeste y la superior a esta estaba constituida por dos estancias donde
se situaba la maquinaria auxiliar. Seguidamente, sobre éstas, una altura con dos
estancias ventiladas, dos estancias con funcion de camaras, un pasillo transversal
como la que tenia la cimentacion y su acceso al nivel superior. En este, tratandose del
nivel principal, se encuentran los pasillos y las escaleras de distribucion, ademas tiene
la particularidad de que los muros se aligeran con respecto a las cotas inferiores. Y
por ultimo, la planta superior es la destinada para albergar la maquina principal del

complejo.

Mencionar que dicho complejo industrial esta situado en un acantilado de la zona baja
del Valle de la Orotava y albergaba la primera maquina de vapor de la isla, apreciada
en la Figura 9. Esta tenia el cometido de salvar las diferencias de cotas en aguas para
regadio. Actualmente, forma parte del patrimonio industrial de Tenerife que, debido a
su ubicacion, se valora una dificultad de vuelo con dron por su orografia y dificil
acceso. Es por ello, que tras una primera revision ocular se ha decidido realizar vuelos

de familiarizacion del RPAS en la Leproseria de Arico.

Figura 9: Maquina de vapor del Elevador de Aguas de la Gordejuela. Fuente: CICOP
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Esta ultima ubicacion se encuentra en las cercanias del pueblo de Abades. Se trata
de un complejo de edificaciones en ruinas que fueron previstas para asistir a enfermos

de lepra y elefantiasis.

La creacion de lugares de aislamiento, tratamiento y cuidado, como el mencionado
anteriormente, fue debido a la inexistencia de instituciones para prestar estos servicios
y se queria mantener unas condiciones salubres para la poblacion islefia. En una
primera instancia, arquitecténicamente se plantearon tres esquemas para asistir a los
enfermos: (1) un hospital, (2) una colonia o (3) un sanatorio. El primero de los casos
se entiende como un lugar de diagndsticos y tratamiento de enfermos. Este primer
esquema se descarté porque, en el mejor de los casos, un enfermo consigue una
mejoria a lo largo de afos y teniendo en cuenta que se sitian en las urbes esto
imposibilita la reclusién de los afectados de manera aislada. La Unica via posible para
aceptar es si este tipo de esquema se encuentra en una colonia o en un sanatorio. En
cuanto a una colonia, se refiere a una agrupacion de enfermos aislados y ubicados en
un mismo lugar en el cual forman una relacion econdémica social entre sus miembros.
Ello les permitiria tener un desarrollo de sus vidas sin tener presente la enfermedad.
Los miembros se construyen su propio hogar, disponen de terreno para cultivar y asi
comercializar entre ellos. Y por ultimo, el sanatorio, se define como una estructura
esquematica que consiste en un complejo de edificaciones con objeto hospitalario en
exclusividad para los afectados de la lepra. En este caso los miembros pueden
desarrollar algunas actividades pero de una manera mas limitada que en una colonia,
y su estancia se centra al tratamiento en si. Finalmente, para el proyecto instaurado
en Arico se optd por una solucion combinada de un sanatorio-colonia aportando lo

mejor de cada esquema.

El arquitecto José Marrero Regalado fue el encargado de disefar el proyecto. Prepard
dos propuestas teniendo en cuenta la separacion por sexo de los enfermos de los
sanos y se quedaron con la Solucion A, ajustandose a las caracteristicas de la finca
de Arico. “El complejo se articulaba a partir de tres secciones definidas: una para
recinto de enfermos, en la que se encontraba el hospital, el espacio de recreo, los
comedores y los servicios generales, a la que se le unia otra destinada a zona
residencial para los enfermos, encontrandose alli la escuela y la iglesia, esta ultima,
que por su volumetria y altura la convertian en el edificio referente en el Sanatorio.

Anexa a ellas, pero con un cierto aislamiento, una zona destinada a individuos sanos.
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[...] Edificios como la iglesia (Figura 10) o sala de conferencias destaca en su fachada
una amplia arqueria junto a una inmersa cruz por su tamafo y altura en una
arquitectura que se desarrolla basicamente de manera horizontal, lo que deja claro el
protagonismo de este edificios y su significado en el Complejo.”

Figura 10: Vista aérea de la Iglesia del Sanatorio de Abades. Fuente: Elaboracion propia

En cuanto al timeline de su proceso de construccion se remonta a julio de 1942 por
su inicio de las obras. En junio del 1943 se habilité mayor capital para la construccion
de la Leproseria. Sin embargo, en su mayoria de las edificaciones no fueron
finalizadas. El motivo no se sabe con seguridad, “pero el profesor Justo Hernandez ha
querido aventurarse al culpar a los avances médicos que en el campo de la lepra se

hicieron en estos afos” (Castro, 2012, p.424-434)

Debido al aislamiento de dicho complejo respecto a la zona urbana y de su
homogeneidad orografica, hace que la simplicidad de vuelo sea mayor que en el caso
del Elevador de Aguas. Es por ello que se realiza un primer levantamiento
fotogramétrico para conocer las limitaciones que se pueden presentar en una mision
de vuelo. Afadir que la edificacion de estudio, en este caso, ha sido el respectivo al

Sanatorio de Abades.

4.2. Parametros a tener en cuenta para la misién de
un vuelo

La mision de un vuelo hace referencia a la planificacion y programacion que debe
realizar el dron para el trabajo aéreo de interés. Para llevar a cabo dichas tareas se
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deben tener en cuenta caracteristicas y parametros para una correcta ejecucion de
vuelo y, es por ello que se desarrolla un subepigrafe recogiendo aquellos mas

importantes a tener en cuenta.

4.2.1. Caracteristicas del RPA
En cuanto al sistema y al vehiculo aéreo pilotado remotamente se utilizara un modelo
DJI Mavic Pro mostrado en la Figura 11. Es el dron por excelencia en la actualidad en

cuanto a portabilidad junto a buenas prestaciones para el desarrollo del estudio.

Figura 11: DJI Mavic Pro. Fuente: https://www.dji.com/es/

Las caracteristicas principales a tener en cuenta para la misién del vuelo son:
e Autonomia: 27 min
e Velocidad maxima: 6,9 m/s
e Camara:
o 1/2.37 (CMOS), Pixeles efectivos: 12.35 M (Pixeles totales: 12.71M)
o FOV 78.8° 26mm (formato equivalente a 35 mm) /2.2

o Distorsion < 1.5% Enfoque de 0.5 ma»

e Rango de temperatura operacional: 0° a 40°C

4.2.2. Parametros prevuelo
Para llevar a cabo una buena planificacion del vuelo también se deben tener en cuenta
parametros externos a los sistemas aéreos previos a la misiéon. En este caso se citan
los siguientes:

e Zona de vuelo: implica estudiar la ubicacion del lugar de interés para verificar
la legalidad del vuelo. Las zonas de vuelo restringidas son aquellas que
incurren en espacio aéreo controlado. Existen varios tipos:

o CTR: Region de trafico controlado asociado a un aerédromo y que

protege las entradas y salidas de los vehiculos aéreos.
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o ATZ: Zona de transito del aerédromo que se define por el lugar donde
las aeronaves realizan las esperas en las proximidades inmediatas.
o TMA: Area de control terminal definida como la zona controlada por
encima de uno o varios aeropuertos y donde confluyen las rutas.
o CTA: Areas de control de traficos establecidas desde una altura y que
se extienden hacia arriba.
o AWY: Aerovias, espacio por donde se canaliza el recorrido del transito
aéreo.
También existen zonas de vuelo donde el espacio aéreo es limitado. En
algunos casos su acceso es prohibido y en otros se pueden realizar vuelos con
previa solicitud de permisos.

e NOTAM: es el acronimo de ‘Notice To Airmen’y se trata de informacién para
aviadores. En el caso de vuelos de drones se deben tener presente para
verificar que el espacio aéreo donde se pretende realizar el vuelo no sufre de
modificaciones temporales sobre el mismo. Dichas modificaciones pueden ser
ocasionadas por parapentistas, paracaidistas, ejercicios militares, exhibicion
aérea, etc. La informacion que un NOTAM contiene son las fechas y las horas
en que se encuentra segregado el espacio aéreo. También se especifica la
actividad que se realiza y los limites de cota. En la web espafiola de ENAIRE
podemos consultar tanto las zonas de vuelo como los NOTAM de la zona de
interés.

e Meteorologia / Viento: se hace evidente tener presente la prevision
meteorologica donde se pretende realizar el vuelo. Por un lado, es necesario
saber si la condiciones climaticas permiten ejecutar la mision de vuelo con la
seguridad que se requiere para esta actividad y, por otro lado, se deben tener
en cuenta para las limitaciones mecanicas del propio dron.

Podemos creer que un dia despejado para volar el RPA es perfecto, sin
embargo, obtendremos mejores resultados de imagen cuando el cielo se
encuentra cubierto sin prevision de lluvia. Esto implica que las imagenes
tomadas y, consecuentemente el levantamiento fotogramétrico, no tengan
problemas de sombreamiento y todas las fachadas del edificio presenten la
misma claridad de detalle.

También la velocidad del viento tiene un protagonismo importante a la hora del
vuelo debido a la estabilidad y durabilidad de la bateria. A pesar de tener un

testeo limite de 30 km/h de viento se recomienda no volar con un viento
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superior a 20 km/h. Si se planifica una misién con dos baterias esto podria
ocasionar la necesidad de utilizar una tercera que o bien tenemos que tener
en cuenta o reducir la calidad de imagen.

e Tormentas solares: son también conocidas como tormentas geomagnéticas.

Son el resultado de fulguraciones, explosiones electromagnéticas de radiacion
procedentes de la superficie del Sol cuando este produce una liberacion de
energia magnéticas. El impacto de dichas fulguraciones en la Tierra produce
una alteracién en el campo magnético terrestre afectando la comunicaciones
y la electricidad.
Respecto a la actividad que podemos llegar a realizar con un RPAS puede
verse alterada por las tormentas solares. Pueden ocasionar interrupciones de
sefales de radio ocasionando pérdidas de comunicacién. También puede
alterar la posicion de la aeronave debido a la recepcion de sefal del sistema
GPS integrado. De igual modo, ocurre con equipos FPV (First Person View),
tablets, moviles u otros equipos.

e Nubes: el conocimiento de los diferentes tipos de nubes existentes puede
darnos indicios de la previsidn de lluvias o posibles turbulencias.

e Entorno: se debe estudiar y comprobar que el entorno esta libre de obstaculos
que puedan dificultar el seguimiento del vuelo. Entre ellos se debe vigilar la
presencia de torres eléctricas y su cableado, fabricas con salidas de humo que
puedan impedir la vision del dron, arboles de gran altura, pequefias montafias

gue puedan interponerse en la conexion con el control remoto, etc.

4.2.3. Parametros vuelo. Planificacion de mision
Para la planificacion de la misién de vuelo se deben conocer previamente aspectos
relevantes que nos permitirdn obtener un resultado u otro. Los parametros que a
continuacion citaremos son propiedades que los programas de planificacion de vuelo

nos permiten configurar. Se muestran en la siguiente tabla:
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Parametros para planificar una misién de vuelo

Velocidad Velocidad deseada durante el vuelo. Parametro importante si la toma de fotografias no

Speed es estacionario. También en la conducta de la bateria, a mayor velocidad menor
cantidad de minutos.

Altura Es la diferencia de cota entre la aeronave y la superficie. Segun qué programa de

Offset planificaciéon se puede determinar si esta altura es fija respecto el punto de despegue

0 se mantiene a la misma altura respecto la superficie que va escaneando. Su
importancia reside en que a mayor altura mayor superficie fotografiada pero con menor
resolucion. De manera inversa, a menor altura menor superficie y su resoluciéon es
mayor. Sin embargo, mayor necesidad de bateria.

Solapamiento o
recubrimiento
Overlap

Superficie fotografica superpuesta de una imagen a otra para unificarlas. Existen
recubrimientos de dos maneras:

- Longitudinal: area entre tomas sucesivas a lo largo del recorrido.

- Transversal: area entre tomas de diferentes pasadas.

Las recomendaciones en porcentaje de solape son:
- 90% Renderizado detallado de elementos de gran altura.
- 80% Terrenos, estructuras, arboles bajos.
- 70% Terrenos planos con pocos arboles.
- 60% No es recomendable por debajo de este porcentaje.

Modo de vuelo
Mission or flight mode

Los modos de vuelo son los diferentes tipos de recorridos que podemos programar al
dron de manera auténoma. Los mas interesantes para realizar trabajos aéreos en
levantamiento fotogramétrico son los siguientes:
- POI (Point Of Interest): vuelo circular alrededor del elemento de interés. Ideal
para edificaciones aisladas.

- Grid: recorrido formado por pasadas paralelas entre ellas. Suficiente para
levantamientos de terrenos con poco relieve.

- Double grid: de igual manera que el anterior pero con una segunda parrilla
perpendicular a la primera. Empleados para terrenos muy agresivos o superficies
con mucho relieve. Puede ser el caso del escaneo de una ciudad.

- Linear: realiza un vuelo a lo largo de un recorrido lineal. Opcién para escanear
carreteras, tendidos eléctricos, etc.

Resoluciéon cm/pixel
Resolution

Viene dada por diferentes factores como puede ser la altura del vuelo, el sensor de la
camara y el GSD (Ground Sampling Distance). Este ultimo término es la distancia que
hay entre los centros de cada pixel sobre el terreno por lo que a menor numero de
GSD (cm/pixel) mayor resolucion. Se recomienda un valor inferior a 2 cm/pixel para
obtener resultados éptimos.

Cabe mencionar que el GSD no determina la precision sino que esta aumenta gracias
a los puntos de control que utilicemos en el campo de trabajo.

Puntos de referencia
Waypoints

Son los puntos que el programa de planificacion necesita para geolocalizar mediante
GPS la aeronave. Es un parametro a tener en cuenta porque algunos programas tienen
un nimero limite de waypoints por mision.

Estabilizador
Gimbal

Dependiendo del elementos que se pretende escanear debemos ajustar el angulo del
gimbal y consecuentemente la camara. En los trabajos topograficos lo tendremos a -
90°, sin embargo, para elementos donde usemos el modo POI se establecera entre -
30°y -45°.

Numero de fotos
Images

La cantidad de imagenes dependera sobretodo de la superficie de estudio, la
resolucion deseada y el porcentaje de solape.

A priori cuanta mayor cantidad de imagenes tengamos mayor es la calidad de los
detalles, sin embargo algunos programas de gestion de imagenes tienen limitaciones
en cantidad de fotos por modelo.

Tabla 1: Principales clases IFC relacionadas con niveles de estructura espacial
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4.2.4. Comprobaciones postvuelo
De la misma manera que se realiza una comprobacion antes de salir hacia el lugar de

interés, se debe realizar un comprobacion posterior al vuelo de los elementos del dron.

Ademas, se aconseja llevar, dentro de la posibilidad de transporte, un portéatil para
analizar y comprobar que las fotografias han sido tomadas correctamente para su

postproceso de imagenes.

Por otro lado, segun el articulo 16.2 del RD 1036/207 se debe llevar un seguimiento

de los vuelos realizados con la siguiente informacion:

a) Los vuelos realizados y el tiempo de vuelo.

b) Las deficiencias ocurridas antes de y durante los vuelos, para su analisis y
resolucion.

c) Los eventos significativos relacionados con la seguridad, y

d) Las inspecciones y acciones de mantenimiento y sustitucion de piezas

realizadas.

Todo ello nos permite llevar nuestro propio libro bitacoras o “logbook” sobre las horas

de vuelo acumuladas como piloto.

4.3. Software de planificacion de vuelos

En el mercado informatico existen una gran variedad de programas que nos permiten
realizar el plan de vuelo previsto para la zona en cuestién. Por ello, se ha realizado
una recogida de aquellos programas mas conocidos para compararlos teniendo en
cuenta unos parametros. En este caso valoramos la sencillez de uso de su interfaz,
las plataformas o sistemas operativos requeridos, los modos de vuelos capaces de

planificar, si tienen “terrain aware” (seguimiento del terreno) y si son de pago.

El dispositivo de seguimiento que se va a utilizar para el vuelo es un Ipad Mini 4.

4.3.1. Comparacion de aplicaciones / software
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Aplicacion

Descripcion

Plataforma

Modos de
vuelos

Seguimiento
terreno

Pago

DJI GS Pro

GSP
r

Se trata de una aplicacion desarrollada por
la empresa DJI para sus propios drones.
Garantiza el buen funcionamiento entre el
VANT y la emisora siempre a través de un
dispositivo iOS.

i0S

Virtual Fence
3D Map Area
3D Map POI
Waypoint
Flight

No

Modo
3D Map
POI de

pago

Pix4dCapture

4
Pix

CAPTURE

Uno de los productos que ofrece la
empresa Pix4D especializada en mapeo y
fotogrametria con dron. La gran ventaja es
que ofrece productos de pago de gestién
de imagenes y data para actualizacién de
modelos As-built en BIM. Hace que el flujo
de trabajo sea mas fluido debido al uso de
productos de la misma empresa.

Android
i0S

Polygon
Grid
Double grid
Circular

No

No

UgCS

UgCs

Viene siendo una aplicacion universal ya
que soporta las controladoras mas
comerciales. También tiene registradas
las camaras més usadas en drones con
posibilidad de configurar aquellas que no
aparezcan. De igual manera podemos
realizar un registro de un dron construido
por nosotros.

La planificacién de vuelo se realiza a
través de un ordenador siguiendo el flujo
de trabajo que realizaria el dron en el
campo de trabajo. Posteriormente se
carga la mision al dron.

La gran ventaja de este programa es la
gran capacidad de configuracion de los
vuelos, permitiendo modificar parametros
que otros no disponen. Por ejemplo, la
configuracion del disparo en los waypoints
e incluso introducir las coordenadas de
despegue

Windows
MacOs
Linux
Android

Waypoint
Grid
Double grid
Circle
Perimeter

Si

Mission
Planner

Mp

Es un programa para configurar vy
gestionar controladoras terrestres de
helicopteros, planeadores, aviones y
drones. Por lo tanto, es ideal para aquellos
que se construyen su propio dron y deben
configurar el comportamiento de los sticks.
Ademas, permite cargar misiones
planificadas anteriormente.

El control y la supervisién del vuelo se
realiza juntamente con un portatil teniendo
acceso a informacién similar a la de un
piloto de aviones comercial. Es como un
cuadro de mandos de una cabina de avion.
Se necesitan mayores conocimientos
aeronauticos.

Windows

Waypoints
Autogrid
Circle

No

No

DroneDeploy

Se trata de una aplicacién mas compleja
que permite afiadir plugins especializados
en diferentes sectores. Por ello también
su alcance es mayor que el resto
permitiendo realizar no solo la
planificacion de vuelo sino también la
gestion de imagenes. Algunas de sus
opciones de visualizacion ya tiene que
ser a través de su web oficial.

Android
i0S

Autogrid

Version beta

Si

Made Easy
Maps Pilot

Tiene una interfaz sencilla y permite la
configuracion de parametros que no tiene
la mayoria. Por ejemplo, permite planificar
vuelos con seguimiento del terreno
permitiendo uniformidad en la resoluciéon

i0S

Grid
Double grid
Linear

Si
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de la capturas de imagenes. Ademas,
? tiene una funcion Linear ideal para el
escaneo de carreteras.
MARS
Aplicacion propia de la compafriia DJI que | Android Waypoints Si No
permite introducir modos de vuelo | iOS POI (Terrain follow)

principalmente ideales para filmacién. Sin
embargo, se puede aprovechar estos
modos para realizar capturas de imagenes
de manera manual.

Litchi for DJI Con la misma finalidad que el DJI Go App | Android Waypoint Si, através de Si
pero siendo una aplicacion externa a DJI. | iOS Orbit Google Earth

o

Tabla 2: Principales clases IFC relacionadas con niveles de estructura espacial

4.3.2. Conclusién
Después de realizar una comparacion entre las diferentes aplicaciones para realizar
planificaciones de vuelo y, tras consultar con D. Angel Fernandez Archilla, Ingeniero
Técnico en Topografia y profesional en trabajos con drones, las aplicaciones mas
idoneas para realizar y alcanzar el objetivo son DJI GS Pro y Made Easy Maps Pilot.
También cabria la posibilidad de utilizar DJI Go 4.0. para captura de imagenes de

manera manual con modos de vuelo inteligentes.

4.4. Software de gestion de imagenes

En el mercado informatico existen una gran variedad de programas que nos permiten
gestionar las imagenes extraidas a partir de la aeronave o cualquier sistema
fotografico. Dichos programas nos permiten extraer el levantamiento fotogramétrico

del volumen de interés.

A continuacion, se presentan tres opciones de los cuales los dos primeros son los que
se han utilizado para el desarrollo fotogramétrico. La motivaciéon del uso de estos

programas es simplemente porque se ha tenido acceso para investigar su uso.

4.4.1. Autodesk ReCap Pro

Se trata de un programa de la familia de Autodesk que nos permite, mediante

fotografias o laser escaner, obtener un modelo 3D como resultante de una nube de
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puntos o una malla. Posteriormente, se puede importar a programas CAD o BIM para

la extraccion de informacion grafica.

Para la parte que nos interesa, Autodesk ReCap Photo es una extension de Autodesk
ReCap Pro encargada de convertir las imagenes 2D extraidas del dron en la

volumetria que le corresponde.

La gran ventaja frente a otros programas es que Autodesk nos permite almacenar las
imagenes en su servidor y en cuestion de menos de 24 horas tenemos la nube de
puntos disponible. Sin embargo, haciendo uso de la licencia educacional s6lo nos
permiten subir un maximo de 100 fotografias que tendremos que tener en cuenta a

la hora de la planificacion de vuelo.

4.4.2. Agisoft PhotoScan

En este caso no tenemos una cantidad limitada de fotografias para procesar y
presenta una interfaz mas compleja que Autodesk ReCap por su mayor potencial. La
gran diferencia que presenta es que el procesado de las imagenes depende de los
recursos del ordenador del que disponemos. Es por ello que, para la actual
investigacion, primase el uso de Autodesk ReCap, ya no solo por los requisitos
minimos sino por la limitacion que existe a la hora de definir el resultado final. Se hace
evidente que al tener una maquina con unos requisitos limitados su resultado también

lo sea. En la Figura 12 se muestra los requisitos recomendados por Agisoft.

Recommended hardware

Basic configuration

CPU: Quad-core Intel Core i7 CPU
Socket LGA 1150 or 1155 (Kaby
Lake, Skylake, Broadwell, Haswell
Ivy Bridge or Sandy Bridge)

Motherboard: Any LGA 1150 or
1155 model with 4 DDR3 slots and at
least 1 PCI Express x16 slot

RAM: DDR3-1600, 4 x4 GB (16 GB
total) or 4 x 8 GB (32 GB total)

GPU: Nvidia GeForce GTX 980 or
GeForce GTX 1080 (optional)

Advanced configuration

CPU: Octa-core or hexa-core Intel
Core i7 CPU, Socket LGA 2011-v3 or
2011 (Broadwell-E, Haswell-E, vy
Bridge-E or Sandy Bridge-E)

Motherboard: Any LGA 2011-v3 or
2011 model with 8 DDR4 or DDR3
slots and at least 1 PCl Express x16
slot

RAM: DDR4-2133 or DDR3-1600, 8
x4 GB (32 GB total) or 8 x 8 GB (64
GB total)

GPU: Nvidia GeForce GTX 980 Ti
GeForce GTX 1080 or GeForce
TITAN X

Extreme configuration

For processing of extremely
large data sets a dual socket
Intel Xeon Workstation can be
used

Figura 12: Requisitos recomendados para Agisoft PhotoScan
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En una primera instancia se empezo a trabajar con un portatil con las caracteristicas

mostradas en la Figura 13. Sus recursos no permitieron ejecutar el procesado de

imagenes teniendo que tener acceso a un mejor ordenador.

Informacion del sistema

Fecha y hora actuales:
Nombre del equipo:
Sistema operativo:
Idioma:

Fabricante del sistema:
Modelo del sistema:
BIOS:

Procesador:

Memoria:

Archivo de paginacion:
Version de DirectX:

martes, 28 de agosto de 2018, 17:04:19
DESKTOP-LDCAPR3

Windows 10 Home 64 bits (10.0, compilacién 17134)
espaniol (configuracion regional: espariol)
Hewlett-Packard

HP Pavilion dm4 Notebook PC

InsydeH20 Version 03.61.01F.0C

Intel(R) Core(TM) i5-2450M CPU @ 2.50GHz (4 CPUs), ~2.5GHz
8192MB RAM

5798MB usados, 3620MB disponibles

DirectX 12
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Figura 13: Caracteristicas del portatil utilizado. Fuente:Elaboracién propia

A pesar de ello, es un programa que tiene un alcance ingente capaz de realizar
trabajos de triangulacién fotogramétrica, edicién y clasificacién de nube de puntos,
modelos digitales de elevacion (MDE), ortofotos georeferenciados, mediciones de
distancias, areas y volumenes sobre levantamientos fotogramétricos con gran

precision gracias a los puntos de control.

44.3. Pix4D

Aunque no hemos tenido oportunidad de probar el programa no queremos pasar por
alto su mencioén. Se trata de un programa fotogramétrico que mediante algoritmos
transforma las imagenes en modelos 3D. Su alcance es similar a Agisoft PhotoScan
con la diferencia de que Pix4D ofrece postprocesado a través de la nube. Ademas,

entre los productos que promueven tienen uno llamado Pix4Dbim.

Se trata de una plataforma que permite gestionar y controlar la evolucion de la obra a
través de una linea del tiempo. También se puede realizar comprobaciones de
replanteo superponiendo los planos sobre el solar, mediciones, cubicaje de material y

enviar comentarios para el analisis As-built del modelo BIM.
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4.5. Software BIM: Autodesk Revit

Autodesk Revit es uno de los programas BIM existentes en el mercado de este
momento que permite el modelado paramétrico y la gestidon de informacién de las

diversas disciplinas (arquitectura, MEP y estructuras) de una construccion.

En realidad existen una gran cantidad de programas BIM, no solo enfocados al
modelado paramétrico sino que también son aquellos que complementan el flujo de
trabajo multidisciplinar. Sin embargo, en este caso hablamos del software de

parametrizacion de elementos constructivos.

La decision de utilizar Autodesk Revit ha sido motivada por el resultado obtenido en
Google Trends. En el buscador se ha introducido los nombres de los principales
programas BIM en el mercado, realizando asi, una comparacion entre las tendencias
de busqueda. Como se puede observar en la Figura 14, el programa mas consultado

via el buscador de Google es Autodesk Revit, siendo Archicad el mas préximo.

Ademas, se trata de un programa que ya hemos utilizado y probado. Siendo asi una

opcioén que nos ahorre tiempo de familiarizacion.

Compared breakdown by region

te ad del epresenta el porcentaje de ledas MAS INFORMACION
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M

Figura 14: Busqueda de los principales programas BIM. Fuente: Google Trends

5. Implementacion y diseno

Abarcando toda la informacién anteriormente expuesta ahora se pretende implementar en el
flujo de trabajo los conocimientos para conseguir el levantamiento mediante una herramienta
BIM.

En una primera instancia se expondra el trabajo realizado con el RPA vy las dificultades
presentadas tanto en el campo como en el resultado en el proceso de imagenes en cada uno

de los casos a estudiar.
Posteriormente se habla del flujo de trabajo que se debe realizar para obtener la nube de
puntos en Autodesk Revit desde las diferentes aplicaciones de gestion de imagenes que

finalmente utilizamos.

Cabe recordar que los programas de planificacion de vuelo que finalmente utilizaremos para

el proyecto seran principalmente DJI GS Pro y Made Easy Maps Pilot. En caso de ver la
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necesidad de realizar capturas fotogramétricas de manera manual haremos uso de la

aplicacion DJI Go 4.0 mediante sus vuelos inteligentes.

5.1. Flujo de trabajo en el caso de estudio del
Sanatorio de Abades

El levantamiento fotogramétrico del Sanatorio de Abades ha sido un vuelo de
familiarizacion del RPAS. Se ha elegido este emplazamiento por la facilidad que
representa hacer el escaneado de una edificacion abierta con una orografia del
entorno generalmente uniforme. Ademas, se encuentra ubicado en una zona que no

incurre, legislativamente hablando, en espacio aéreo controlado.

El modo de vuelo utilizado ha sido el Point Of Interest (POI) que dispone la aplicacién
DJI GS Pro. El proceso de planificacion se inicia ajustando dentro del circulo negro el
elemento de interés mientras que el verde indica el recorrido que el dron realizara
(Figura 15). Este se puede ajustar tanto con los parametros que queremos como

directamente sobre el mapa.

p. N\ ) y ) 13;‘; (/'T
D ® @ ) (- @ ) (@) =i ()

\ . - \ s

Q 25 M P
- M2. POI V Sanatorio Abades s
. ’ s
— 92PTS 483M
" o W | N '
h \ | 23Lines .
’
g \ "~ y Camera Model Mavic Pro Camera >
/ Flight Course Mode Vertical Mode
/ @ Ca Hover&Capture at Point >
\\\ // NS 10.8 KM/H
e T
<
- G Flight Rad.  34.6M DA Resolution 0,4 CM/PX
T @ Building Radius
* 2.2 N
Dy, W, < —_— 22u
.
» \\\ ’: @ Min Alt.  64M ® Max Alt.  20.6M

W/ N Speed vgu‘r N/A
N/AKM/H s LON: N/A

Z Altitude

N/AM

E LAT 28145278 A

Figura 15: Planificacion de vuelo con DJI GS Pro. Fuente: Elaboracion propia

Haciendo uso de la Guia del usuario del programa nos encontramos con la primera

limitacion para este modo de vuelo. No podemos superar la cantidad de 99 Waypoints
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por mision. En caso de necesitar una cantidad mayor se deberia realizar tantas

misiones sean necesarias para cubrir el escaneado total.

Tenemos que recordar que si vamos a hacer uso de Autodesk ReCap para la gestion
de las imagenes éstas no pueden superar la cantidad de 100 fotografias. Ademas
también hay que tener en cuenta que la resolucién no deberia superar los 2cm/px si

queremos unos resultados aceptables.

Por otro lado, la aplicaciéon dispone de dos maneras de ejecutar el POI; un modo
circular y uno vertical. En la Figura 16 podemos observar las diferencias que existen
en su vuelo y recorrido. En nuestro caso se ha realizado una misiéon para cada uno y

asi posteriormente estudiar las diferencias en los resultados.

(a) (b)

Figura 16: Recorrido del dron (a) modo circular (b) modo vertical. Fuente: https://www.dji.com/es

En adicién, también podemos configurar el modo de captura de las imagenes de tres
modos. Se puede configurar de manera que capture cada cierto tiempo, cada cierta
distancia o que se detenga por cada waypoint y realice un fotografia (Hover&Capture
at Point). Esta ultima opcion hace que las imagenes sean estables sin embargo

requiere de mayor bateria.

Por ultimo, las configuraciones resultantes para los dos modos de vuelo dentro del

POI quedan de la siguiente manera:
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MODO CIRCULAR

Parametros configurables:

- Modo de captura: Hover&Capture at Point

- Velocidad: 15 km/h (4,16 m/s) Parametros resultantes

- Radio de vuelo: 55,9 m - Waypoints: 36 puntos

- Resolucién: 1,0 cm/px - Numero de patrones: 2 capas

- Radio del edificio: 22,5 m - Longitud de vuelo: 712 m

- Altura minima: 10,0 m - Tiempo de vuelo estimado: 4 min. 7 seg.
- Altura maxima: 29,9 m - Baterias: 1

- Solape frontal: 80% - Fotografias estimadas: 36

- Solape transversal: 60%

- Angulo del gimbal cabeceo: -30,0°

MODO VERTICAL

Parametros configurables: Parametros resultantes

- Modo de captura: Hover&Capture at Point - Waypoints: 92 puntos

- Velocidad: 10,8 km/h (3,0 m/s) - Numero de patrones: 23 lineas

- Radio de vuelo: 34,6 m - Longitud de vuelo: 483 m

- Resolucién: 0,4 cm/px - Tiempo de vuelo estimado: 6 min. 17
- Radio del edificio: 22,2 m seg.

- Altura minima: 6,4 m - Baterias: 1

- Altura maxima: 20,6 m - Fotografias estimadas: 92

- Solape frontal: 69%
- Solape transversal: 59%

- Angulo del gimbal cabeceo: 0,0°

Finalmente se ha podido configurar y realizar el escaneado fotogramétrico con una
cantidad menor a 100 fotografias. El programa utilizado para la gestién de las

imagenes ha sido Autodesk ReCap Photo.

Teniendo en cuenta que la imagen de la izquierda se ha realizado con un modo circular
y la de la derecha con un modo vertical, el resultado obtenido a partir de los dos modos

de ejecucion del vuelo es el siguiente:

COMPARACION DE RESULTADOS
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Figura 18: Comparacion de resultados. 1zq. modo circular. Dcha. modo vertical. Fuente: Elaboracion propia

Figura 19: Comparacion de resultados. 1zq. modo circular. Dcha. modo vertical. Fuente: Elaboracion propia
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Figura 20: Comparacioén de resultados. 1zq. modo circular. Dcha. modo vertical. Fuente: Elaboracién propia

Como podemos observar, las imagenes obtenidas a partir del modo vertical presentan
un resultado superior frente al modo circular. La calidad de imagen resultante es mas
nitida ya que nos ha permitido obtener una mejor resolucion. En cuanto a la
volumetria, en la Figura 17 solo podemos apreciar la diferencia de color entre un modo
u otro. Sin embargo, en la Figura 18 comenzamos a diferenciar la claridad y la
hendidura de los arcos. También, en la Figura 19 vemos que en el modo vertical la
definicion, tanto de la parte superior como de la parte inferior del espiritu santo de la
cruz, queda resuelta de manera mas completa. En el modo circular se observa la
ausencia de la parte superior de la cruz y de los huecos inferiores. Finalmente, en la
Figura 20 los pilares y los arcos de la imagen derecha tienen una mayor definicion

debido a que la altura minima ha sido inferior que la del modo circular.

Tras la comparacion de los diferentes resultados obtenidos de los dos modos de
ejecucion del POI del DJI GS Pro concluimos que el uso del modo vertical obtiene

mejor informacion grafica y volumétrica que el modo circular.

5.2. Flujo de trabajo en el caso de estudio del

Elevador de Aguas de la Gordejuela

Tras la experiencia con el caso de la Iglesia del Sanatorio de Abades podemos
expresar que el uso de DJI GS Pro para el caso del Elevador de Aguas de la
Gordejuela puede dificultar la ejecucion de la mision. A pesar de tratarse de una
edificacion abierta, como se muestra en la Figura 21, también podemos apreciar que

el entorno es muy agresivo por la diferencia de cotas a salvar.
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Figura 21: Entorno del Elevador de Aguas de la Gordejuela. Fuente: Elaboracion propia

Si aplicaramos un modo de vuelo POI podria poner el peligro la aeronave por posible
impacto contra el risco donde se situa la escalera de acceso. Por ese motivo, vemos
la necesidad de utilizar una aplicacion capaz de adaptarse al relieve del terreno. En

nuestro caso hicimos uso de Made Easy Maps Pilot al tener dicha opcién.

Figura 22: Gréfica de la altura mantenida respecto el relieve. Fuente: Elaboracién propia

En este caso tenemos una limitacion de 250 waypoints con la posibilidad de

aumentarlos previo pago. De igual manera que con el otro, se pueden realizar tantas
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misiones como se necesite para cubrir la superficie a escanear. Como diferencia, sin

embargo, el angulo del gimbal no puede ser configurable quedando siempre a -90°.

INTENTO #1
119 hect ﬁ,‘

1.27 km Terrain Aware

4.0m/s

Figura 23: Patrén intento 1. Fuente: Elaboracion propia

Parametros configurables Parametros resultantes
° Terrain Aware: Activado Area: 1,19 Ha
e  Modo misién: Grid normal Distancia: 1,27 km
e  Solape frontal: 80% Duracién: 6 min. 17 seg.
e  Solape transversal: 85% Baterias: 1
e Velocidad max.: 4,0 m/s Imagenes: 99
e Tiempo maximo: 21,0 m Waypoints: < 250 puntos
° Offset: 0,0 m Almacenamiento: 0,49 GB
Altitud: 59 m

Resolucién: 2,0 cm/px

Tras el primer intento, se puede observar que los resultados obtenidos en la Figura 24
no son suficientes como para extraer informacion para patrimonio industrial. Es por

ello que se realiza un siguiente intento con un patrén diferente al anterior.
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Figura 24: Resultado intento 1. Fuente: Elaboracion propia

INTENTO #2
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Figura 25: Patrén intento 2. Fuente: Elaboracion propia

Parametros configurables

Terrain Aware: Activado
Modo mision: Grid normal
Solape frontal: 75%
Solape transversal: 75%
Velocidad max.: 4,0 m/s
Tiempo maximo: 16:02
Offset: 0,0 m

Parametros resultantes

Area: 2.23 Ha

Distancia: 1.57 km
Duracion: 7 min. 33 seg.
Baterias: 1

Imagenes: 74

Waypoints: < 250 puntos
Almacenamiento: 0,38 GB
Altitud: 61 m

Resolucién: 2,0 cm/px
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Figura 26: Resultado intento 2. Fuente: Elaboracion propia

De manera semejante se obtiene un resultado parecido al primer intento. Tras lo cual,
se optd consultar con Maximiliano L. Diaz , licenciado en Geografia y Cartografia,
especialista en Sistemas de Informacion Geogréfica y Piloto Profesional de RPAS.
Nos comentdé que para un resultado éptimo consiste en realizar dos misiones por
separados con distintos modos de vuelo. Por un lado, una misién utilizando Double
Grid con la aplicacion Made Easy Maps Pilot y, por el otro lado, una misiéon PO/ a una
altura suficiente para salvaguardar distancias con el risco y obtener imagenes de la
edificaciéon con DJI Go 4.0.

INTENTO #3a. Double Grid con Made Easy Maps Pilot

Area: 0.85 hect a0 ) Hi

Distance: 1.69 km

Terrain Aware  Active Connect  Grid Mission

Max Speed: 4.0 m/s = f i
Duration: 8m 3s ._—|I @ L 4

Batteries: 1 erlap 81/77 trol  Max: 40m/s Max Time: 21:00 Offset: 0 m
Images: 102 connected Range: 56% D --% “%é\\ Og‘@
Points: Free 4 4

Storage: 0.52GB

Altitude: 60 m

Resolution: 2.0 cm/px

Figura 27: Patrén intento 3 (double grid)P. Fuente: Elaboracion propia
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Parametros configurables Parametros resultantes
e  Terrain Aware: Activado e Area: 0.85Ha
e  Modo misién: Grid normal e Distancia: 1,69 km
e  Solape frontal: 81% e  Duracion: 8 min. 3 seg.
e  Solape transversal: 77% e Baterias: 1
e Velocidad max.: 4,0 m/s e Imagenes: 102
e Tiempo maximo: 21,0 m e  Waypoints: < 250 puntos
e Offset: 0,0m e Almacenamiento: 0,52 GB

e  Altitud: 60 m
e Resolucion: 2,0 cm/px

INTENTO #3b. Point Of Interest con DJI Go 4.0

En este caso se debe programar el vuelo inteligente in situ, de manera que cuando
estas en el aire con el RPA accedes a la opcion Point Of Interest de la aplicacién DJI
Go 4.0. Las indicaciones se van mostrando en la pantalla y consiste en (1) situarse
encima del punto de interés, (2) situar el dron a una altitud minima de 5 metros, (3)
configurar el radio de actuacién y (4) determinar la velocidad de vuelo. Una vez
determinada dicha informacion ejecutamos el vuelo. Con los controles del mando
podemos indicar si queremos el giro horario o antihorario y de manera manual

capturamos las imagenes necesarias.

Figura 28: Disposicion fotografias realizadas. Fuente: Elaboracién propia

Debido a la cantidad de imagenes tomadas al elevador se ha procedido a usarse el
programa Agisoft PhotoScan, quedando la distribucion de las imagenes como se
muestra en la Figura 28. Se ha adjuntado como Anexo Il el manual de usuario del
programa donde se explica detalladamente el flujo de trabajo que se debe llevar a
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término para obtener la nube de puntos, quedando como resultante de esta

investigacion las imagenes siguientes:

Figura 29: Resultado intento 3. Fuente: Elaboracion propia

Como se muestra en la Figura 29, el resultado muestra una mayor definicion valido
para comenzar con el modelado BIM. Previamente, se estudia los formatos soportados
por Autodesk Revit y cuales son los posibles flujos de trabajo para exportar e importar
la nube de puntos.
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5.2.1. Exportaciéon/importacion de nube de puntos a
Autodesk Revit
El paso mas importante del flujo de trabajo de la investigacion es la interoperabilidad
entre los diversos programas utilizados. En este apartado se estudia tanto la
exportacion desde los programas de postproduccién como la importacién de los

formatos soportados por Autodesk Revit.

En la Tabla 3, se muestran los diferentes formatos que Autodesk Revit es capaz de
importar como nube de puntos. Debemos tener en cuenta dicha tabla para conocer

qué programas permite la exportacion de datos para ser aceptado por Revit.

Tipos de archivos soportados de nube de puntos importados

Autodesk Revit *.rcp, *.rem, *.3dd, *.asc, *.d3, *.dr, *.e57, * fls, *.fws,
*.ixf, *.las, *.laz, *.1as84, *.mpc, *.obj, *.pcg, *.ptg, *.pts,
*.ptx, *.rds, *.rep, *.rxp, *.txt, *.zfprj, *.zfs

Tabla 3: Principales clases IFC relacionadas con niveles de estructura espacial
En la siguiente Tabla 4 se muestran los diferentes tipos de archivos de exportacién de

los diferentes programas de gestion de nube de puntos. Se han resaltados los

formatos compatibles con Autodesk Revit.

Tipos de archivos como nube de puntos de exportacion

Autodesk ReCap Photo | *.obj, *.fbx, *.stl, *.ply, *.pts

Autodesk ReCap Pro *.rep, . res, *.prs, *.e57

Agisoft PhotoScan *.0bj, *.ply, *.txt, *.las, *.laz, *.e57, *.cl3, *.pts, *.dxf,
*.u3d, *.pdf, *.zip, *.oc3

CloudCompare *.bin, *.e57, *.dxf, *.shp, *.pov, *.dp

Tabla 4: Principales clases IFC relacionadas con niveles de estructura espacial

Hemos anadido un programa OpenSource (codigo abierto) llamado CloudCompare.
Se trata de un programa de procesamiento de nube de puntos que nos puede facilitar
como ‘programa puente’ para realizar conversiones entre un tipo de formato a otro. La
gran ventaja que tiene en este sentido es que abre una multitud muy variada de
formatos y se puede extraer en un formato .e57. Un tipo de formato neutro muy

extendido que almacena datos capturados por sistemas 3D.
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6. Resultados

En este apartado llegamos a la parte final del flujo de trabajo de la investigacion. A partir del
levantamiento fotogramétrico obtenido con el dron y su posterior importaciéon a un programa

BIM se quiere realizar el correspondiente modelado.

Tras ello, para la valoracion de los resultados, nos hemos puesto en contacto con un miembro
de la Fundacion CICOP para analizar y debatir qué utilidad y alcance tienen los

levantamientos fotogramétricos con VANT.

6.1. Modelado BIM del Elevador de Aguas de la

Gordejuela

Teniendo en cuenta la interoperabilidad entre Agisoft PhotoScan y Autodesk Revit, el
flujo de trabajo empleado para importar y exportar la nube de puntos ha sido a través
del formato .e57. Se trata de un tipo de archivo universal cuando hablamos de nube
de puntos. Es la equivalencia del .ifc del BIM pero para datos capturados con sistema
de imagenes 3D.
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Figura 30: Nube de puntos en Autodesk Revit. Fuente: Elaboracion propia

Empezamos situando los diferentes niveles de la edificacion. (Figura. 31)
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Figura 31: Situacién niveles del edificio. Fuente: Elaboracion propia

En una seccion del modelo importamos la seccidn de la planimetria encontrada en la
bibliografia del CICOP, escalamos la imagen de tal manera que coincida con la
volumetria de la nube de puntos. (Figura 32)
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Figura 32: Seccion nube de puntos e imagen escalada de planimetria de serccion. Fuente: Elaboracion
propia
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Una vez tenemos todo coincidente, corregimos la cota de los diferentes niveles para

empezar a modelar el elevador de aguas. (Figura 33)

4

ar Importar
CAD  gbXML des
i

1100 % Gl & o b ld <
A e 5 Rl T ®AR BN P

Figura 33: Imagen de seccion escalada. Niveles corregidos. Fuente:Elaboracién propia

De igual manera hacemos lo mismo en cada uno de los niveles pero con la imagen de

las plantas. (Figura 34)
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Figura 34: Vista en planta Nivel -3 con nube de puntos e imagen de plano. Fuente: Elaboracién propia
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Finalmente, modelamos arquitecténicamente el edificio con un LOD100 para obtener
su planimetria y asi tener un volumen 3D (Figura 35) como punto de partida de un
modelo BIM. Creemos que en estos casos, la importancia de la informacion prevalece
frente a la geometria en si ya que esta la obtenemos directamente del levantamiento

fotogramétrico (Figura 36).

Figura 35: Levantamiento del volumen en Autodesk Revit. Fuente: Elaboracion propia

Figura 36: Informacion obtenida de la fachada. Fuente: Elaboracion propia
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6.2. Entrevista con experto de la Fundacién CICOP
(Centro Internacional para la Conservacion del

Patrimonio)

La Escuela Politécnica Superior de Ingenieria de la Universidad de La Laguna tiene el
privilegio de ubicarse en una ciudad declarada Bien Cultural de la Humanidad por la
Unesco. Ciudad en la que se asienta la Fundacion CICOP (Centro Internacional para
la Conservacion del Patrimonio), la cual se define en su carta de presentacion como
“privada, cultural y sin animo de lucro que, desde la solidaridad y cooperacién
internacional al desarrollo, se ordena en torno a la proteccion, conservacion,
restauracion, gestion, promocion y acrecentamiento del Patrimonio Cultural mueble,
inmueble e intangible de los pueblos, asi como al estudio, investigacion, intercambio,
formacion y promocién de los métodos, técnicas, modos, procedimientos, materiales
y protocolos empleados en la restauracion, rehabilitacion, gestion y consolidacién del

patrimonio cultural y de su puesta en uso y disfrute”.

Teniendo en cuenta todo lo anterior, no podemos dejar pasar la oportunidad de
entrevistar a José Luis Délera, arquitecto y arquitecto técnico del CICOP, y preguntar

su punto de vista sobre el resultado obtenido de esta investigacion.

1.  ¢Cree que puede ser de utilidad para la conservacion de patrimonio?
Si, esta claro. A priori, es una herramienta que entiendo que facilita tener un

registro visual del estado en que se encuentra los elementos del edificio.

2. ¢;Conociendo sus posibilidades, en qué tareas cree que puede ser de
utilidad?
Yo creo que el uso de los drones es mucho mas que esto, es decir, igual que
se ha hecho esto a través de fotografia, acoplando al dron camaras
termogréficas y otros elementos podemos obtener una informacion mucho
mas costosa de conseguir en elementos patrimoniales, como puede ser
cubiertas, elemento constructivo que generalmente tiene mayor dificultad su
acceso e inspeccion. Me imagino que la bateria de fotografias de esta malla
(refiriéndose a la cubierta de la iglesia del Sanatorio de Abades) te aporta una
informacion para empezar a realizar planteamientos de intervencion o del

estado del mismo. Sobre todo es util para acceder a puntos singulares, no solo
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por el exterior, sino también en el interior del edificio. Si tenemos que
inspeccionar, por ejemplo, el abside de la béveda y para ello tenemos que
utilizar medios auxiliares para obtener informacion, esta herramienta facilitaria

Su acceso.

3. ¢Las imagenes sobre el levantamiento del Elevador de la Gordejuela son
de utilidad para el CICOP?
He estado valorando los levantamiento fotogramétricos que me has pasado y
estimo que se puede afinar un poco mas el resultado obtenido con los drones.
Entiendo yo que si la calidad de imagen hubiera sido superior podriamos
obtener aun mayor informacién pero con el resultado que me muestras ya se
ve el potencial que tiene el uso de los drones, yo creo que es el futuro. Y sobre

todo es mucho mas rapido que utilizando los métodos tradicionales.

4. ;Se le ocurre alguna aplicacion futura con los drones en el mundo de la
Conservacion de Patrimonio?
En este campo ya no te sabria que decir, lo que si me parece interesante es
gue con esta herramienta podemos ver la vinculacion que tiene el edificio con
su entorno. El hecho de que el dron te permita poder modelar la topografia del
emplazamiento del edificio permite contextualizar y entender la historia del
mismo. Esto no solo es interesante para la conservacion sino que también es
extrapolable para el andlisis del lugar y su lectura para proyecto de nueva

arquitectura.

5. ¢Ve util y/o necesario tener modelos BIM del Patrimonio?
Siempre va a ser necesario trabajar posteriormente con un programa que
soporte la nube de puntos. El levantamiento fotogramétrico me permite
visualizar la volumetria pero a la hora de trabajar veo necesario extrapolarlo a
programas BIM que me permitan introducir informacién en cuanto su estado,
intervenciones, etc. Incluso se puede realizar diferentes levantamientos
fotogramétricos a lo largo del tiempo, por ejemplo cada 10 afios, que me
permita comparar los dos resultados y valorar su deterioro al cabo del tiempo.
6. ¢Le gustaria afadir o puntualizar algun aspecto?
Creo que con nuevas tecnologias, como la 5G, nos va a permitir solventar los

problemas legislativos actuales. Creo que, desde mi punto de vista, se deberia
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permitir volar el dron hasta una altura, mas o menos de 20 metro, sin necesidad
de pasar por todo el tramite para solicitar permisos. Avisar si, pero sin tener
que pasar por dicho tramites. Como decia, creo que con tecnologias 5G, donde
todo va a estar mas conectado y la respuesta de este tipo de herramientas es
mas precisa, permitira trabajar con los drones en espacios como por ejemplo

en la ciudad de La Laguna.

7. Conclusiones

El uso de los drones para la obtencidon de informacion para realizar levantamientos
fotogramétricos es un proceso que puede tener una buena proyeccién futura. A pesar de no
haber obtenido un resultado éptimo para desarrollar un modelo BIM completo para la

conservacion de patrimonio, el final de esta investigaciéon demuestra que un RPA es una
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herramienta perfecta para complementar otros sistemas de escaneado. Bien es cierto que la
inexperiencia como piloto se ve reflejada en su resultado y que el emplazamiento

seleccionado requiere de profesionales en el ambito de la topografia.

En cuanto al uso de estas aeronaves para el campo de la conservacion de patrimonio las
ventajas de esta herramienta son inmensas. Desde poder realizar inspecciones de elementos
constructivos de dificil acceso hasta el registro de levantamientos fotogramétricos de

patrimonio con informacién de su estado.

Al inicio de esta investigacion las aplicaciones que conociamos del dron en el sector AEC se
limitaba en la inspeccion y control de la obra. Sin embargo, tras la revision bibliografica para
justificar las diferentes aplicaciones, abre un abanico donde el lenguaje de programacion

puede cobrar un papel importante en la monitorizacion de informacion util.

Por ultimo, cabe esperar a ver como se va a ir desarrollando las nuevas tecnologias como las
redes 5G, SmartCity, City Information Modeling, Blockchain, etc. para prever que otras

aplicaciones pueden surgir con el uso de drones.

8. Lineas de trabajo futuro

Tras haber realizado este documento de investigacion y haber experimentado las dificultades
que supone el proceso de adquisicion de datos mediante el dron, en casos como el del
Elevador de Aguas, una linea de investigacion seria la creaciéon de una aplicacion para

realizar planificaciones de vuelo utilizando los mapas 3D generados por Google Earth, por
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ejemplo. De esta manera se podria previsualizar el recorrido planteado que debe realizar el

dron alrededor del elemento de interés.

También, hemos visto las dificultades que supone levantar el dron en funcién del espacio
aéreo. Por ello, seria conveniente realizar una guia, o protocolo, de toda la documentacion
burocratica para obtener los permisos pertinentes para realizar los vuelos. Dicha
documentacién deberia estar disponible publicamente en un formato tipo plantilla para que
los operadores puedan desarrollar y tramitar los permisos. Todo lo anterior, facilitaria realizar
trabajos como el registro patrimonial del parque edificatorio de un lugar ya que, en una primera

instancia, se ve limitado legislativamente.

Relacionado con la conservacién patrimonial, no podemos dejar pasar la oportunidad de
estudiar el estado y la catalogalizacién de los dafnos de un edificio. Esto nos puede llevar a
realizar un estudio sobre programar con la API (Application Programming Interface) de
Autodesk Revit o crear un plugin donde registrar dicha informacion e incluso poder visualizarla
en AR (Augmented Reality) o VR (Virtual Reality). Por otro lado, también se puede realizar la
gestion de esta informaciéon con proyectos como PetroBIM, herramienta de gestién sobre

bienes culturales.

Asimismo, seria de interés realizar un estudio econémico sobre el impacto de gasto para el
uso de drones. Investigar, desarrollar y evaluar la inversion inicial, su rendimiento y
amortizacion para ver si es factible realizar trabajos aéreos con esta herramienta, todo ello

para dar respuesta a la necesidad de invertir un capital o contratar los trabajos a terceros.

No solo existen lineas de trabajo como resultante de este documento de investigacién sino
que también nos podemos plantear qué papel puede llegar a tener los RPAS en conceptos
tecnoldgicos de la actualidad y en relacion con el sector AEC. Nos referimos a términos como

tecnologia 5G, City Information Modeling (CIM), fabricacion digital o blockchain.
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10. Anexos

10.1. Anexo I: Ficha descriptiva CICOP del Elevador de
Aguas
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FUNDACION CICOP

INSTITUTO DE CONSERVACION Y RESTAURACION DE BIENES CULTURALES ICON

CANARIAS

CODIGO TF-RE-IN-EXT0-ZC-032 PGO

PEP

DENOMINACION Elevador de Aguas de la Gordejuela

TIPOLOGIA Industrial — Recursos hidricos
UBICACION
MUNICIPIO Los Realejos
ZONA La Gordejuela
DIRECCION Barranco de la Gordejuela
X | 344651,49
COORDENADAS v | 3142410 12

ANTECEDENTES HISTORICOS

En la antigua ubicacién del molino de Juan de Gordejuela y junto a las cascadas que llevan su nombre, La Casa Hamiltn una empresa de
origen britanico en 1898 constituye el principal inversor en la constitucion de la sociedad de aguas Gordejuela, en 1902 adquiere la totalidad
de las acciones de la sociedad y dan comienzo las obras de la estacion de bombeo que elevara el agua hasta la cima del acantilado situada a
unos 200 metros sobre el nivel del mar. La instalacion disefiada por el ingeniero militar José Galvan Balaguer apoyado por Ledn deTorres y
Leodn Huerta. Debido a la caida de la exportacion la Casa Hamiltdn entro en perdidas e intento vender parte del agua a otras areas de la Isla,
pero estas propuestas no fueron escuchadas por los gobernantes. Pasando posteriormente a manos de la empresa Fyffes. En el interior de
sus edificaciones se alojo la primera maquina de vapor con fines industriales instalada en la isla de Tenerife.

DESCRIPCION ARQUITECTONICA DATOS ARQUITECTONICOS
Complejo industrial destinado al bombeo de aguas procedentes de los nacientes cercanos que

canalizados hasta la estacion. La configuracion original del complejo estuvo constituida por tres PLANTA Rectangular
edificio, un depdsito y una gran chimenea asi como las diferentes infraestructuras de acceso y

canalizacion de las aguas. ALTURAS 5

La primera edificacion situada en parte sur era el edificio destinado al alojamiento de los

trabajadores, de planta rectangular y una sola altura con muros de carga y cubierta a dos aguas VANOS

sobre cercha metdlica roblonada, lo destacable de esta edificacion es la cimentacion mediante un
gran dado de contencion, La fachada Oeste estd practicamente adosada a la ladera del barranco,
accediéndose a la edificacion por la Norte donde presenta un vano de acceso de dintel recto con una
apretura de medio punto sobre él. El resto de fachadas presentan la apertura de vanos con arqueria
de medio punto. Descendiendo el camino nos encontramos la ubicacion del antiguo edificio que
albergara la maquinaria de las calderas, de planta rectangular y de la que solo quedan restos del
pavimento y restos del muro Oeste.

La gran pieza de este complejo esta situada a una altura aproximada de 40 metros sobre el nivel del
mar apoyando su cimentacion sobre la roca del acantilado de tal forma que aparenta ser una
prolongacion de este. La edificacion de planta rectangular y una altura de unos veintisiete metros
dividida en cinco alturas. El nivel inferior corresponde principalmente a la cimentacion compuesta por
un gran bloque de basalto y argamasa, existiendo una galeria de paso Este-Oeste que atraviesa la
base del edificio, el nivel superior a este hay dos estancias que alojaban la maquina chica, con los
huecos para evacuar y ventilar la maguinaria. Sobre este otras dos estancias con simetria respecto al
macizo central con dos ventanas en cada una de ellas, junto a otras dos estancias que han quedado
sepultadas por el derrumbe de las bdvedas. En el nivel principal de entrada alberga los pasillos y
escaleras de distribucion en esta cota los muros se aligeran y se abren vanos con arqueria de medio
punto. La planta superior de distribucion diafana albergaba la maquina principal del complejo. Los
muros de carga presentan pilastras interiores sirviendo de soporte a los carriles de la gria carril.




FUNDACION CICOP

SISTEMA CONSTRUCTIVO Y MATERIALES

Amplia cimentacion y muros de piedra y mortero, con aplicacidn también en bévedas de medio cafion.
Con utilizacion en las plantas superiores de ladrillo, y arcos de descarga, asi como el uso de estructura de acero roblonado en cubiertas.

ALTERACIONES CONSERVACION

El complejo edificatorio ha perdido ya gran parte de sus edificaciones, como es el caso de la

chimenea y la edificacion de calderas. BUENO < 30%

El edificio principal, presenta ausencia de cubierta y desmoronamiento de forjados. REGULAR _ 30% <X < 70%

MALO >70%




INSTITUTO DE CONSERVACION Y RESTAURACION DE BIENES CULTURALES

FUNDACION CICOP

ICON

CANARIAS

NORMATIVA

DATOS CATASTRALES

| REFERENCIA

[ TIPO DE SUELO

[ USO ACTUAL

[ SUP. PARCELA

[ SUP. CONSTRUIDA

BIBLIOGRAFIA Y FUENTES

llustre Ayuntamiento de la Villa de Los Realejos, “Los Realejos: una sintesis historica”, Los Realejos, 1996.

llustre Ayuntamiento de la Villa de Los Realejos ,"Inventario de Bienes Inmuebles de la Villa de Los Realejos. Isla de Tenerife", Excmo.

Ayuntamiento de la Villa de Los Realejos, 2012.

Antonio Farifia, et al., “Propuesta de proyecto de restauracion y Rehabilitacion del antiguo elevador de aguas de la Gordejuela”, Maestria del

CICOP, 2004.

DATOS DE CONTROL

REALIZADO POR | Jose Luis Délera. — Nov-2013.
REVISADO POR Camilo Martin. — Dic-2013.

IMAGENES Y DETALLES DE INTERES

Imagen cedida por el fondo documental del Excmo.
Ayuntamiento de la Villa de Los Realejos, donde
podemos apreciar la configuracion inicial y el estado
actual a noviembre de 2013.

Vista superior de la
edificacion principal,
donde podemos apreciar
la perdida de la cubierta y
su estructura.

Vista general de Ila

fachada Este del
complejo.

Detalle de la planta
principal ~ donde  se
aprecia el colapso del
forjado de esta sala, asi
como los apoyos de la
viga grda existente sobre
las pilastras interiores con
las chapas metalicas

sobre ellas.

e
e 2 i
S,

Accesos a la edificacion | La  fachada de la

con la fachada Este al | edificacion presentaba un

Fachada  Oeste  del
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mayor esheltez

Visual del barranco de Palo
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fondo

tratamiento formal de sus
paramentos con una
composicion regular en la
distribucion de huecos.

corresponden a la planta
donde se alojo la
maquinaria de bombeo.

fondo.

\J

Visual ~ general  del
Barranco y el elevador

Interior de la sala
principal donde se puede
apreciar el colapso de la
planta donde se ubicaba
la maquinaria principal de
bombeo,

La fachada Norte esta
coronada por un frontén
con un oculo en la parte
central.

La formacion de los
vanos se realizo
mediante  roscas  de

ladrillo, como podemos
apreciar en laimagen.

Detalle del forjado de la
planta principal, asi como
de las pilastras de apoyo de
la viga grda.

El ndcleo central de la | Detalle del interior del | Detalle de uno de los | Vista desde el nivel -1 de | Pasillos interiores resueltos
edificacion  compuesto | complejo. huecos de iluminacién | la edificacion principal. mediante conformacion de
por un &rea maciza de con arco  escarzano béveda  revestida de
ladrillo  capaz  de compuesto por roscas de mortero.

soportar las cargas ladrillo.

principales transmitidas

por la pesada

maquinaria.

Formacion de  los
machones de apoyo de
las boévedas mediante
fabrica de ladrillo.

Visual interior de la
fachada sur.

Detalle de uno de los
arcos escarzanos de la
planta de acceso.

conformados

Forjados
mediante  encofrados y
relleno de hormigdn pobre
e interposicion de plana de
ladrillos.




INSTITUTO DE CONSERVACION Y RESTAURACION DE BIENES CULTURALES

FUNDACION CICOP

ICON

CANARIAS

Detalle de uno de los
arcos escarzanos de la
planta de acceso.

Detalle de la fabrica de
ladrillo.

Detalle de las plantas
inferiores resueltas
mediante el uso de piedra
basaltica y con
interposicion de ladrillos,

Mamposteria de piedra
basaltica con la formacion
de los arcos escarzanos
con ladrillo.

de la

Vista interior
edificacion.

Vista de uno de los
conductos interiores de
fabrica.

Vista interior fachada sur.

Detalle de uno de los
ventanucos presentes en
la planta baja.

Arcadas de las
canalizacion de las aguas
realizadas en la parte
alta.

Arcadas de las canalizacion
de las aguas realizadas en
la parte alta.

3
é‘s
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Camino de acceso a las
distintas  instalaciones
del complejo.

Visual general de la

edificacion

Detalle de las
infraestructuras de
acceso a la edificacion
mediante la ejecucion de
escaleras.

Fachada Este.

Imagen cedida por el
fondo documental del
Excmo.  Ayuntamiento
de la Villa de Los
Realejos.

Imagen cedida por el
fondo documental del
Excmo. Ayuntamiento de
la Villa de Los Realejos,
Interior de la maquinaria
en la planta principal,

Imagen cedida por el
fondo documental del
Excmo. Ayuntamiento de
la Villa de Los Realejos.
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Overview

Agisoft PhotoScan is an advanced image-based 3D modeling solution aimed at creating professional
quality 3D content from still images. Based on the latest multi-view 3D reconstruction technology, it
operates with arbitrary images and is efficient in both controlled and uncontrolled conditions. Photos can
be taken from any position, providing that the object to be reconstructed is visible on at least two photos.
Both image alignment and 3D model reconstruction are fully automated.

How it works

Generally the final goal of photographs processing with PhotoScan is to build 3D surface, orthomosaic
and DEM. The processing procedure includes four main stages.

1. Thefirst stageiscameraalignment. At this stage PhotoScan searchesfor common points on photographs
and matches them, as well as it finds the position of the camera for each picture and refines camera
calibration parameters. As aresult a sparse point cloud and a set of camera positions are formed.

The sparse point cloud represents the results of photo alignment and will not be directly used in further
processing (except for the sparse point cloud based reconstruction method, that is not recommended).
However it can be exported for further usage in external programs. For instance, the sparse point cloud
model can be used in a 3D editor as areference.

On the contrary, the set of camera positions is required for further 3D surface reconstruction by
PhotoScan.

2. Thenext stageisgenerating dense point cloud, that isbuilt by PhotoScan based on the estimated camera
positions and pictures themselves. Dense point cloud may be edited and classified prior to export or
proceeding to the next stage.

3. The third stage is generation of a surface; Mesh and/or DEM. 3D polygonal mesh model represents
the object surface based on the dense or sparse point cloud, this type of surface representation is not
always required, so the user may choose to skip mesh model generation step. Digital Elevation Model
(DEM) can be built in Geografic, Planar or Cylindrical projections according to the user's choice. If
the dense point cloud had been classified on the previous stage - it is possible to use particular point
classes for DEM generation.

4. After the surface is reconstructed, it can be textured (relevant for mesh model only) or an Orthomosaic
can be generated. Orthomosaic is projected on a surface of user's choice: DEM or Mesh model (if it
had been generated for the project).

About the manual

Basically, the sequence of actions described above covers most of the data processing needs. All these
operations are carried out automatically according to the parameters set by user. Instructions on how to
get through these operations and descriptions of the parameters controlling each step are given in the
corresponding sections of the Chapter 3, General workflow chapter of the manual.

In some cases, however, additional actions may be required to get the desired results. In some capturing
scenarios masking of certain regions of the photos may be required to exclude them from the cal cul ations.
Application of masksin PhotoScan processing workflow aswell as editing options available are described
in Chapter 6, Editing. Camera calibration issues are discussed in Chapter 4, Referencing, that also
describes functionality to optimize cameraalignment results and provides guidance on model referencing.




Overview

A referenced model, be it amesh or a DEM serves as a ground for measurements. Area, volume, profile
measurement procedures are tackled in Chapter 5, Measurements, which also includes information on
vegetation indices cal culations. While Chapter 7, Automation describes opportunitiesto save up on manual
intervention to the processing workflow, Chapter 8, Network processing presents guidelines on how to
organize distributed processing of the imagery data on several nodes.

It can take up quite along time to reconstruct a 3D model. PhotoScan allows to export obtained results
and save intermediate datain aform of project filesat any stage of the process. If you are not familiar with
the concept of projects, its brief description is given at the end of the Chapter 3, General workflow.

In the manual you can also find instructions on the PhotoScan installation and activation procedures and
basic rules for taking "good" photographs, i.e. pictures that provide most necessary information for 3D
reconstruction. For theinformation refer to Chapter 1, I nstallation and Activation and Chapter 2, Capturing
scenarios.

Vi



Chapter 1. Installation and Activation

System requirements

Minimal configuration

» Windows XP or later (32 or 64 hit), Mac OS X Mountain Lion or later, Debian/Ubuntu with GLIBC
2.13+ (64 hit)

¢ Intel Core 2 Duo processor or equivalent

* 4GB of RAM

Recommended configuration

» Windows7 SP 1 or later (64 bit), Mac OS X Mountain Lion or later, Debian/Ubuntu with GLIBC 2.13+
(64 bit)

* Intel Corei7 processor
* 16 GB of RAM

The number of photos that can be processed by PhotoScan depends on the available RAM and
reconstruction parameters used. Assuming that a single photo resolution is of the order of 10 MPix, 4 GB
RAM is sufficient to make a model based on 30 to 50 photos. 16 GB RAM will allow to process up to
300-400 photographs.

GPU acceleration

PhotoScan supports accelerated image matching, depth maps reconstruction and photoconsistent mesh
refinement due to the graphics hardware (GPU) explaiting.

NVidia
GeForce GTX 400 series and later with CUDA support.

ATI
Radeon HD 6000 series and later with OpenCL 1.1 support.

PhotoScan is likely to be able to utilize processing power of any CUDA enabled device with compute
capability 2.0 and higher or OpenCL 1.1 and higher enabled device with SPIR support for stages specified
above, provided that CUDA/OpenCL drivers for the device are properly installed. However, because of
the large number of various combinations of video chips, driver versions and operating systems, Agisoft
is unable to test and guarantee PhotoScan's compatibility with every device and on every platform.

The table below lists currently supported devices (on Windows platform only). We will pay particular
attention to possible problems with PhotoScan running on these devices.

Table 1.1. Supported Desktop GPUs on Windows platform

NVIDIA AMD

Quadro P6000 FirePro W9100
Quadro M6000 Radeon R9 390x
GeForce TITAN X Radeon R9 290x




Installation and Activation

NVIDIA AMD

GeForce GTX 1080 Radeon HD 7970
GeForce GTX TITAN X Radeon HD 6970
GeForce GTX 980 Radeon HD 6950
GeForce GTX TITAN Radeon HD 6870

GeForce GTX 780
GeForce GTX 680
GeForce GTX 580
GeForce GTX 570
GeForce GTX 560
GeForce GTX 480

Although PhotoScan is supposed to be able to utilize other GPU models and being run under a different
operating system, Agisoft does not guarantee that it will work correctly.

4 Note

¢ Use CPU enable flag to alow calculations both on CPU and GPU for GPU-supported tasks.
However if two or more GPUs are used it is recommended to disable CPU for stable processing.

« Using GPU acceleration with mobile or integrated graphics video chips is not recommended
because of the low performance of such GPUs.

* CUDA supported devices on Mac OS X may requireto install CUDA drivers from official web-
sitefirst: http://www.nvidia.com/object/mac-driver-archive.html.

Installation procedure

Installing PhotoScan on Microsoft Windows

To install PhotoScan on Microsoft Windows simply run the downloaded msi file and follow the
instructions.

Installing PhotoScan on Mac OS X
Open the downloaded dmg image and drag PhotoScan application bundle to the desired location on your

hard drive. Do not run PhotoScan directly from the dmg image to avoid issues related to the license
activation.

Installing PhotoScan on Debian/Ubuntu

Unpack the downl oaded archive with a program distribution kit to the desired location on your hard drive.
Start PhotoScan by running photoscan.sh script from the program folder.

Restrictions of the Demo mode

Once PhotoScan is downloaded and installed on your computer you can run it either in the Demo mode
or in the full function mode. On every start until you enter a serial number it will show a registration
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box offering two options: (1) use PhotoScan in the Demo mode or (2) enter a serial number to confirm
the purchase. The first choice is set by default, so if you are still exploring PhotoScan click the Continue
button and PhotoScan will start in the Demo mode.

The employment of PhotoScan in the Demo mode is not time limited. Several functions, however, are not
available in the Demo mode. These functions are the following:

 saving the project;
* build tiled mode!;
* build orthomosaic;
* build DEM;

* DEM and orthomosaic related features (such as vegetation index calculation, DEM-based
measurements);

» some Python APl commands;

« al export features, including exporting reconstruction results (you can only view a 3D model on the
screen);

* using network processing feature.

To use PhotoScan in the full function mode you have to purchaseit. On purchasing you will get the serial
number to enter into the registration box on starting PhotoScan. Once the serial number is entered the
registration box will not appear again and you will get full accessto all functions of the program.

Activation procedure

PhotoScan node-locked license activation

The Stand-Alone license for PhotoScan software is node-locked. Node-locked license files are unique for
each computer, and are tied to the system hardware. If you are to replace magjor system components or
re-install operational system, you should deactivate the software first and then activate it on the renewed
system.

£ Note

* To deactivate the license use Deactivate button in Help Menu -> Activate Product dialog or
argument --deactivate in the command line (terminal) to PhotoScan executable.

< Uninstallation of PhotoScan software does not deactivate the license automatically. If you have
uninstalled the software before deactivating it, please re-install PhotoScan and run deactivation
procedure, as described above.

PhotoScan software requires license key (a digital code) to be activated. First of all, make sure that you
haveavalid license key or atrial code at hand. Standard activation procedure, which alowsto activate the
product in the means of seconds, requires the machine to be connected to the Internet. If it is your case,
please follow the online activation procedure as described below. In case the system cannot be connected
to the Internet, please opt for the offline activation procedure, which is aso described in this section of
the manual.
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Online Activation Procedure - To activate PhotoScan on a machine with I nter net
connection

1. LaunchPhotoScan software, previously installed on your machine, and go to Help menu for Activate
product... command.

2. In Activation dialog insert license key according to the suggested 5 digit blocks structure. Please
note that license codes never include zero digit - only letter "O".

3. If the license code has been input correctly, then the OK button will become active. Click on it to
complete the activation procedure. If the button is still grayed out, please make sure that the key you
are using is meant for the product you are trying to activate: alicense key for the Standard Edition,
for example, will not activate the Professional Edition.

Offline Activation Procedure - To activate PhotoScan on a machine with NO
| nter net connection

1. Launch PhotoScan software, previously installed on your machine, and go to Help menu for Activate
product... command.

2. In Activation dialog insert license key according to the suggested 5 digit blocks structure. Please
note that license codes never include zero digit - only letter "O". Click OK button.

3. Click SaveActivation Request button. Browseto the destination folder for theactivation_request.act
filein the Save as dialog, type in the file name and click Save button.

4. Send the file saved at previous step to support@agisoft.com. Our support team will process your
activation request and send the special license file to your e-mail with the instructions to complete
the activation process.

If youwould liketo activate/deactivate PhotoScan softwarein headless mode, please seethelist of relevant
commands bel ow.

 photoscan --activate license_key

 photoscan --deactivate

 photoscan --activate-offline license _key file_name.act
* photoscan --deactivate-offline file_name.act

Run "photoscan --help" to see the complete list of the commands available.

Floating licenses

PhotoScan software can be used under floating license conditions. A floating license allows to install the
software on an unlimited number of machines, which are connected to a server network. However, at any
one time, PhotoScan can only run on the maximum number of computers for which licenses have been
purchased. Since PhotoScan can be installed on more systems than the number of licenses purchased, this
enables the licensee to efficiently share the product across the organization.

A software utility called Floating License Server (FLS) deployed on the server machine issues licenses
to client machines, up to the number of floating licenses purchased. If al floating licenses are in use, no
more computers can run PhotoScan until alicense is returned to the FLS, i.e. until PhotoScan process is
finished on one of the machines.
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PhotoScan floating licenses are borrowable. A borrowed license can be used on a machine disconnected
from the server network for a certain period (up to 30 days).

Floating license activation procedure is performed on the server machine and includes two steps
* FLSinstallation and activation

» Floating license activation

Thus, to activate a floating license you will need 3 components:

e FLSarchive (to be downloaded from the link provided upon license purchase)

» FLSactivation key (to be provided on purchasing a floating license)

» Floating license activation key (to be provided on purchasing a floating license), and the number of
floating licenses associated with the key.

[{ Note

¢ FLScannot beinstalled on avirtual machine.

To activate Floating License Server
1. Unpack the FLS archive and run FL S utility (rlm/rim.exe) on the server machine.

2. Go to http://server_address:5054 to use web-interface of the license management system. Enter
Status section of the left hand side menu. Find "agisoft” linein the | SV Serverstable. Click agisoft
button in ACTIVATE column of the table.

3. Set the following values for the parameters on the Activate/Deactivate Alternate Server Hostid
page. | SV: agisoft, Activation Key: enter FLS activation key. Leave Deactivate? box unchecked.
Click Activate/Deactivate Alter nate Server Hostid button.

4. TheFLSis successfully activated now.

5. To complete the procedure, go to the folder where the FLS utility has been unpacked to and delete
mock licensefile - agisoft.lic.

6. Returntoweb-interface of thelicense management system and go to Reread/Restart Server ssection
of the left hand side menu. Select "-al-" from the dropdown list of the ISV field. Click REREAD/
RESTART button.

7.  Now the FLS activation procedure is compl eted.

The next step is activation of the floating license itself.

To activate a floating license

1. Go to http://server_address:5054 to use web-interface of the license management system. Enter
Activate License section of the left hand side menu. Click BEGIN License Activation button on
License Activation page.

2. Do not change the suggested value of the | SV activation website parameter. Click Next.

3. On step 2 of License activation procedure set |SV parameter to "agisoft" value and enter Floating
license activation key into the License activation key textbox. Click Next.
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Go to thefolder wherethe FL S utility has been unpacked to, openrim_agisoft FLS-activation-key.lic
file. Copy string "license=server-serial-number" from the first line of the file and enter the datainto
the License Server or Node-lock hostid: textbox on the 3d step of the License activation procedure.

Indicate the number of floating licenses to be activated in the License count (for floating licenses)
field. The number should not excess the total amount of floating licenses associated with the floating
license activation key. Click Next.

On step 4 indicate the name of the license file to be created. Click Next.

On step 5 check Activation Request Data and if everything is correct, click REQUEST LICENSE
button.

Click (Re)Start License Server. Select "agisoft” from the dropdown list of the ISV field. Click
REREAD/RESTART button.

Floating license activation procedure is completed. Y ou can run PhotoScan on the client machines
connected to the server.

To run PhotoScan on a client machine, where the software has been installed, the client machine should
have network connection to the server, where FLS has been deployed. In case the connection is not via
alocal network, then a specialy prepared *.lic file should be properly placed to the PhotoScan folder on
the client machine. The datain the file should be the following string: "HOST FLS address'. In case the
server uses a port different from the standard 5053 one, then the string should be: "HOST FLS address
any the_port_number”.

Totransfer the Floating License Server

1

4.

Deactivate FLS in web-interface of the license management system: http://server_address;5054.
Enter Status section of the left hand side menu. Find "agisoft” linein the ISV Serverstable. Click
agisoft button in ACTIVATE column of the table. Set the following values for the parameters on
the Activate/Deactivate Alter nate Server Hostid page. | SV: agisoft, check Deactivate? box. Click
Activate/Deactivate Alternate Server Hostid button.

Activate FLS on a new server following steps 1-3 from the Floating License Server activation
procedure described above.

Copy all floating license files (i.e. al *.lic files but for the rim_agisoft_license server activation
key.lic) from the original server machine to the new server to the folder where floating license server
has been unpacked to.

Follow steps 5-6 from the Floating License Server activation procedure described above.

There is no need to perform Floating license activation procedure since the floating license is already
activated. PhotoScan can be run on the client machines connected to the new server.

To borrow afloating license

1.

Connect the machine you would like to borrow the license for to the server machine and make sure
that there is a spare floating license in the server pool.

Run PhotoScan software on the machine. Go to Help -> Activate Product... menu.

Click Borrow License button in the PhotoScan Activation dialog. Set the number of days you would
like to borrow the license for and click OK button. The number of days should not exceed 30.
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4.  Now the machine can be disconnected from the server network, with PhotoScan being kept activated
onit.




Chapter 2. Capturing scenarios

Photographs suitable for 3D model reconstruction in PhotoScan can be taken by any digital camera (both
metric and non-metric), as long as you follow some specific capturing guidelines. This section explains
genera principles of taking and selecting pictures that provide the most appropriate data for 3D model
generation.

IMPORTANT! Make sure you have studied the following rules and read thelist of restrictions before you
get out for shooting photographs.

Equipment
» Useadigital camerawith reasonably high resolution (5 MPix or more).

» Avoid ultrawide angle and fisheye lenses. The best choice is 50 mm focal length (35 mm film
equivalent) lenses. It isrecommended to usefocal length from 20 to 80 mm interval in 35mm equivalent.
If a data set was captured with fisheye lens, appropriate camera sensor type should be selected in
PhotoScan Camera Calibration dialog prior to processing.

 Fixed lenses are preferred. If zoom lenses are used - focal length should be set either to maximal or to
minimal value during the entire shooting session for more stable results, for intermediate focal lengths
separate camera calibration groups should be used.

Camera settings

» Using RAW datalosslessly converted to the TIFF filesis preferred, since JPG compression may induce
unwanted noise to the images.

» Takeimages at maximal possible resolution.
* SO should be set to the lowest value, otherwise high 1SO values will induce additional noise to images.

 Aperture value should be high enough to result in sufficient focal depth: it isimportant to capture sharp,
not blurred photos.

» Shutter speed should not be too slow, otherwise blur can occur due to slight movements.

Object/scene requirements

» Avoid not textured, shiny, highly reflective or transparent objects.
« If ill haveto, shoot shiny objects under a cloudy sky.

» Avoid unwanted foregrounds.

» Avoid moving objects within the scene to be reconstructed.

» Avoid absolutely flat objects or scenes.

Image preprocessing

 PhotoScan operates with the original images. So do not crop or geometrically transform, i.e. resize or
rotate, the images.
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Capturing scenarios

Generally, spending some time planning your shot session might be very useful.

Number of photos: more than required is better than not enough.

Number of "blind-zones' should be minimized since PhotoScan is able to reconstruct only geometry
visible from at least two cameras.

In case of aeria photography the overlap requirement can be put in the following figures: 60% of side
overlap + 80% of forward overlap.

Each photo should effectively use the frame size: object of interest should take up the maximum area.
In some cases portrait camera orientation should be used.

Do not try to place full object in theimage frame, if some partsare missing it isnot aproblem providing
that these parts appear on other images.

Good lighting is required to achieve better quality of the results, yet blinks should be avoided. It is
recommended to remove sources of light from camerafields of view. Avoid using flash.

If you are planning to carry out any measurements based on the reconstructed model, do not forget to
locate at least two markers with aknown distance between them on the object. Alternatively, you could
place aruler within the shooting area.

In case of aerial photography and demand to fulfill georeferencing task, even spread of ground control
points (GCPs) (at least 10 across the area to be reconstructed) is required to achieve results of highest
quality, both in terms of the geometrical precision and georeferencing accuracy. Y et, AgisoftPhotoScan
is able to complete the reconstruction and georeferencing tasks without GCPs, too.

The following figures represent advice on appropriate capturing scenarios:
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Restrictions

In some cases it might be very difficult or even impossible to build a correct 3D model from a set of
pictures. A short list of typical reasons for photographs unsuitability is given below.

Modifications of photographs

PhotoScan can process only unmodified photos as they were taken by a digital photo camera. Processing
the photos which were manually cropped or geometrically warped is likely to fail or to produce highly
inaccurate results. Photometric modifications do not affect reconstruction results.

Lack of EXIF data

PhotoScan calculates initial values of sensor pixel size and focal length parameters based on the EXIF
data. The better initial approximation of the parameter valuesis, the more accurate autocalibration of the
camera can be performed. Therefore, reliable EXIF datais important for accurate reconstruction results.
However 3D scene can also be reconstructed in the absence of the EXIF data. In this case PhotoScan
assumesthat focal length in 35 mm equivalent equalsto 50 mm and triesto align the photosin accordance
with this assumption. If the correct focal length value differs significantly from 50 mm, the alignment can
giveincorrect resultsor evenfail. In such casesit isrequired to specify initial cameracalibration manually.

The details of necessary EXIF tags and instructions for manual setting of the calibration parameters are
given in the Camera calibration section.
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Lens distortion

The distortion of the lenses used to capture the photos should be well simulated with the camera model
used in the software. Generally, Brown'sdistortion model implemented in PhotoScan workswell for frame
cameras. However, since fisheye/ ultra-wide angle lenses are poorly simulated by the mentioned distortion
model, it iscrucial to choose proper cameratype in Camera Calibration dialog prior to processing of such
data - the software will switch to the appropriate distortion model.

Lens calibration

It is possible to use PhotoScan for automatic lens calibration. PhotoScan uses LCD screen asacalibration
target (optionally it ispossibleto use aprinted chessboard pattern, providing that itisflat and all itscellsare
squares). Lens calibration procedure supports estimation of the full camera calibration matrix, including
non-linear distortion coefficients.

[{ Note

« Lenscalibration procedure can usually be skipped in common workflow, as PhotoScan cal culates
the calibration parameters automatically during Align Photos process. However, if the alignment
results are unstable, for example, due to the lack of the tie points between the images, the lens
calibration may be useful.

The following camera calibration parameters can be estimated:

f
Focal length measured in pixels.

CX, cy
Principal point coordinates, i.e. coordinates of lensoptical axisinterceptionwith sensor planein pixels.

b1, b2
Affinity and Skew (non-orthogonality) transformation coefficients.

k1, k2, k3, k4
Radia distortion coefficients.

pl, p2, p3, p4
Tangential distortion coefficients.

Before using lens calibration tool a set of photos of calibration pattern should be loaded in PhotoScan.

To capture photos of the calibration pattern:

1. Select Show Chessboard... command from the Lens submenu in the Tools menu to display the
calibration pattern.

2. Use mouse scroll wheel to zoom infout the calibration pattern. Scale the calibration pattern so that
the number of squares on each side of the screen would exceed 10.

3. Captureaseriesof photos of the displayed calibration pattern with your camerafrom slightly different
angles, according to the guidelines, outlined below. Minimum number of photos for a given focal
lengthis 3.

4. If you are cdibrating zoom lens, change the focal length of your lens and repeat the previous step
for other focal length settings.

11
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5. Click anywhere on the calibration pattern or press Escape button to return to the program.
6. Upload the captured photos to the computer.

When capturing photos of the calibration pattern, try to fulfill the following guidelines:

» Make sure that the focal length keeps constant throughout the on (in case of zoom lens).
» Avoid glare on the photos. Move the light sources away if required.

» Preferably, the whole area of the photos should be covered by calibration pattern. Move the camera
closer to the LCD screenif required.

Toload photos of the calibration pattern:

1 Create new chunk using ~& Add Chunk toolbar button on the Workspace pane or selecting Add

Chunk command from the Workspace context menu (available by right-clicking on the root element
on the Workspace pane). See information on using chunks in Using chunks section.

2. Select Add Photos... command from the Workflow menu.

3. Inthe Open dialog box, browse to the folder, containing the photos, and select files to be processed.
Then click Open button.

4. Loaded photos will appear in the Photos pane.

4 Note

« You can open any photo by double clicking on its thumbnail in the Photos pane. To obtain good
calibration, the photos should be reasonably sharp, with crisp boundaries between cells.

« If you have loaded some unwanted photos, you can easily remove them at any time.

« Before calibrating fisheye lens you need to set the corresponding Camera Type in the Camera
Calibration... dialog available from the Tools menu. See information on other camera calibration
settings in Camera calibration section.

To calibrate cameralens
1. Select Calibrate Lens... command from the Lens submenu in the Tools menu.

2. Inthe Cdlibrate Lens dialog box, select the desired calibration parameters. Click OK button when
done.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click the Cancel button.

4. The calibration results will appear on the Adjusted tab of the Camera Calibration... dialog available
from the Tools menu. The adjusted values can be saved to file by using Save button on the Adjusted
tab. The saved lens calibration data can later be used in another chunk or project, providing that the
same cameraand lensis used.

[{ Note

 After you have saved the calibration parametersfor the lens, you may proceed with the workflow
steps in a separate chunk for the actual image set captured by the same camera and lens. To
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protect the calibration datafrom being refined during Align Photos process one should check Fix
calibration box on the Initial tab for the chunk with the data to be processed. In this case initial
calibration values will not be changed during Align Photos process.

After calibration is finished, you will be presented with the following information:

Detected chessboard corners are displayed on each photo (the photo can be opened by double clicking on
its name in the Photos pane). It is preferable when the majority of the corners were detected correctly. For
each detected corner the reprojection error between the detected corner position and estimated position
according to the calculated calibration is also displayed. The errors are scaled x20 times for display.

13



Chapter 3. General workflow

Processing of images with PhotoScan includes the following main steps:
* loading photos into PhotoScan;

* inspecting loaded images, removing unnecessary images;
« aligning photos;

* building dense point cloud,;

* building mesh (3D polygonal model);

* generating texture;

* building tiled mode!;

* building digital elevation model;

* building orthomosaic;

* exporting results.

If you are using PhotoScan in the full function (not the Demo) mode, intermediate results of the image
processing can be saved at any stage in the form of project files and can be used later. The concept of
projects and project filesis briefly explained in the Saving intermediate results section.

The list above represents all the necessary steps involved in the construction of a textured 3D model
DEM and orthomosaic from your photos. Some additional tools, which you may find to be useful, are
described in the successive chapters.

Preferences settings

Before starting a project with PhotoScan it is recommended to adjust the program settings for your needs.
In Preferences dialog (General Tab) available through the Tools menu you can indicate the path to the
PhotoScan log file to be shared with the Agisoft support team in case you face any problem during the
processing. Here you can also change GUI language to the onethat is most convenient for you. The options
are: English, Chinese, French, German, Italian, Japanese, Korean, Portuguese, Russian, Spanish.

Switch Theme in case you have preferences between Dark or Light program GUI or leaveit as Classic for
the simplest view. Shortcuts can be adjusted for your convenience on the General tab aswell.

On the GPU Tab you need to make sure that all GPU devices detected by the program are checked.
PhotoScan exploits GPU processing power that speeds up the process significantly. However, Agisoft
does not recommend to use integrated graphic card adapters due to their possible unstable work under
heavy load. If you have decided to switch on GPUs to boost the data processing with PhotoScan, it is
recommended to uncheck "Use CPU when performing GPU accel erated processing” option, providing that
the number of GPUs available is more than one.

Advanced tab allows you to switch on such advanced features like rich Python console, for example.
Furthermore, you can enable loading of extra camera data from XMP (camera calibration, camera
orientation angles, camera location accuracy, GPS/INS offset).

To test new mesh generation method (for Build Mesh, Build Tiled Model processing step), you need
to check the corresponding option on the Advanced tab as well. This is recommended to be supported
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with Keep depth maps option (check the box on the Advanced tab). Keep depth maps option can also be
beneficial in terms of saving up the processing time, in case there might be a need to rebuild dense point
cloud, once generated, for a smaller part of the scene.

Starting from version 1.4, PhotoScan allowsfor incremental image alignment, which may be useful in case
of somedatamissing intheinitialy aligned project. If thismay bethe case, you should switch onthe Keep
key points option on the Advanced tab of the Preferences dialog before you start the processing of the data.

Loading photos

Before starting any operation it is necessary to point out what photos will be used as a source for 3D
reconstruction. In fact, photographs themselves are not loaded into PhotoScan until they are needed. So,
when you "load photos' you only indicate photographs that will be used for further processing.

Toload a set of photos

L Select Add Photos... command from the Workflow menu or click @ Add Photos toolbar button on

the Workspace pane.

2. In the Add Photos dialog box browse to the folder containing the images and select files to be
processed. Then click Open button.

3. Selected photos will appear on the Workspace pane.

4 Note

« PhotoScan accepts the following image formats. JPEG, TIFF, DNG, PNG, OpenEXR, BMP,
TARGA, PPM, PGM, SEQ, ARA (thermal images) and JPEG Multi-Picture Format (MPO).
Photos in any other format will not be shown in the Add Photos dialog box. To work with such
photos you will need to convert them in one of the supported formats.

If you have loaded some unwanted photos, you can easily remove them at any moment.

Toremove unwanted photos
1. Onthe Workspace pane select the photos to be removed.

2. Right-click on the selected photos and choose Remove Items command from the opened context

menu, or click X Remove Items toolbar button on the Workspace pane. The selected photos will
be removed from the working set.

Camera groups

If all the photos or a subset of photos were captured from one camera position - camera station, for
PhotoScan to process them correctly it is obligatory to move those photos to a camera group and mark
the group as Camera Station. It is important that for all the photos in a Camera Station group distances
between camera centerswere negligibly small compared to the camera-object minimal distance. 3D model
reconstruction will require at least two camera stations with overlapping photos to be present in a chunk.
However, it is possible to export panoramic picture for the data captured from only one camera station.
Refer to Exporting results section for guidance on panorama export.

Alternatively, camera group structure can be used to manipulate the image datain a chunk easily, e.g. to
apply Disable/Enable functions to all the camerasin agroup at once.
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To move photosto a camera group
1. Onthe Workspace pane (or Photos pane) select the photos to be moved.

2. Right-click on the selected photos and choose Move Cameras - New Camera Group command from
the opened context menu.

3. A new group will be added to the active chunk structure and selected photos will be moved to that
group.

4. Alternatively selected photos can be moved to a camera group created earlier using Move Cameras
- Camera Group - Group_name command from the context menu.

To mark group as camera station, right click on the camera group name and select Set Group Type
command from the context menu.

Inspecting loaded photos

L oaded photos are displayed on the Workspace pane along with flags reflecting their status.
The following flags can appear next to the photo name:

NC (Not calibrated)
Notifies that the EXIF data available is not sufficient to estimate the camerafocal length. In this case
PhotoScan assumes that the corresponding photo was taken using 50mm lens (35mm film equivalent).
If the actua focal length differs significantly from this value, manual calibration may be required.
More details on manual camera calibration can be found in the Camera calibration section.

NA (Not aligned)
Notifiesthat external cameraorientation parameters have not been estimated for the current photo yet.

Images loaded to PhotoScan will not be aligned until you perform the next step - photos alignment.

E=]
Notifies that Camera Station type was assigned to the group.

Multispectral imagery

PhotoScan supports processing of multispectral images saved as multichannel (single page) TIFF files.
The main processing stages for multispectral images are performed based on the primary channel, which
can be selected by the user. During orthomosaic export, all spectral bands are processed together to form
amultispectral orthomosaic with the same bands as in source images.

The overall procedure for multispectral imagery processing does not differ from the usual procedure for
normal photos, except the additional primary channel selection step performed after adding images to the
project. For the best results it is recommended to select the spectral band which is sharp and as much
detailed as possible.

To select primary channel

1. Add multispectral images to the project using Add Photos... command from the Workflow menu or
Add Photos toolbar button.
2. Select Set Primary Channel... command from the chunk context menu in the Workspace pane.

3. Inthe Set Primary Channel dialog select the channel to be used as primary and click OK button.
Display of images in PhotoScan window will be updated according to the primary channel selection.
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Rigid

4 Note

e Set Primary Channel... command is available for RGB images as well. You can either indicate
only one channel to be used as the basis for photogrammetric processing or leave the parameter
value as Default for al three channels to be used in processing.

Multispectral orthomosaic export is supported in GeoTIFF format only. When exporting in other formats,
only primary channel will be saved.

camerarigs

PhotoScan supports processing of multispectral datasets captured with multiple synchronized cameras
operating in different spectral ranges. In this case multiple images (planes) are available for each position
and PhotoScan will estimate separate calibration for each plane aswell astheir relative orientation within
camerarig.

The default assumption is that synchronized cameras have the same position in space. In case distance
between the cameras cannot be neglected, it is possible for PhotoScan to cal culate relative camera offset.

To calculaterelative camera offset for synchronized cameras
Select Camera Calibration command from the Tools menu.
Switch to Slave offset tab.

Check Fit location option.

A w b P

The distance for the active camera will be calculated in relevance to master camera - the camera
whose images were loaded to the project first of all.

To change master camera, you can use the corresponding command from the context menu of the camera
group displayed in the lefthand part of the Camera Calibration dialog.

Multiplane layout is formed at the moment of adding photos to the chunk. It will reflect the data layout
used to store image files. Therefore it is necessary to organize files on the disk appropriately in advance.
The following data layouts can be used with PhotoScan:

a. All image planes from each position are contained in a separate multilayer image. The number of
multilayer images is equal to the number of camera positions.

b. Corresponding planes from all camera positions are contained in a separate subfolder. The number of
subfoldersis equal to the number of planes.

c¢. For a special case of MicaSense cameras (MicaSense RedEdge, Parrot Sequoia), no specia layout
is required. In this case the arrangement of images into cameras and planes will be performed
automatically based on available meta data.

Once the data is properly organized, it can be loaded into PhotoScan to form multiplane cameras. The
exact procedure will depend on whether the multilayer layout (variant a), multifolder layout (variant b)
or if MicaSense datais used.

To create a chunk from multilayer images

L Select Add Photos... command from the Workflow menu or click Add Photos toolbar button.

2. Inthe Add Photos dialog box browse to the folder containing multilayer images and select files to
be processed. Then click Open button.
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3. Inthe Add Photos dialog select the data layout " Create multispectral cameras from files as cameras’.

4. Created chunk with multispectral cameras will appear on the Workspace pane.

To create a chunk from multifolder layout

L Select & Add Folder... command from the Workflow menu.

2. Inthe Add Folder dialog box browse to the parent folder containing subfolders with images. Then
click Select Folder button.

3. Inthe Add Photos dialog select the data layout " Create multispectral cameras from folders as bands®

4. Created chunk with multispectral cameras will appear on the Workspace pane. The labels of the
multispectral cameras would be taken from the image filenames of the first image folder used.

To create a chunk from MicaSense data

L Select Add Photos... command from the Workflow menu or click Add Photos toolbar button.

2. Inthe Add Photos dialog box browse to the folder containing MicaSense images and select filesto
be processed. Then click Open button.

3. Inthe Add Photos dialog select " Create multispectral cameras from files as bands”.

4. Created chunk with multispectral cameras will appear on the Workspace pane. The labels of the
multispectral cameras would be taken from the first band image filenames.

After chunk with multispectral camerasis created, it can be processed in the same way as normal chunks.
For these chunks additional parameters allowing to manipulate the data properly will be provided where

appropriate.
Video Data

PhotoScan allowsfor video dataprocessing aswell, which can be beneficial for quick inspection scenarios,
for example. The video is to be divided into frames which will be further used as source images for 3D
reconstruction.

Toimport avideofile

1. Select Import video command from the File menu.

2. Inthe Import video dialog you can inspect the video and set the output folder for the frames.
3. Set thefilename pattern for the frames and indicate the frame extraction rate.

4. Click OK button for the frames to be automatically extracted and saved to the designated folder. The
images extracted from the video will be automatically added to the active chunk.

After the frames have been extracted you can follow standard processing workflow for the images.

Aligning photos

Once photos are loaded into PhotoScan, they need to be aligned. At this stage PhotoScan finds the camera
position and orientation for each photo and builds a sparse point cloud model.

18



General workflow

Toalign a set of photos
1. Select Align Photos... command from the Workflow menu.
2. Inthe Align Photos dialog box select the desired alignment options. Click OK button when done.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Alignment having been completed, computed camera positions and a sparse point cloud will be displayed.
You can inspect alignment results and remove incorrectly positioned photos, if any. To see the matches
between any two photos use View Matches... command from a photo context menu in the Photos pane.

Incorrectly positioned photos can be realigned.

Torealign a subset of photos

1. Reset aignment for incorrectly positioned cameras using Reset Camera Alignment command from
the photo context menu.

2. Set markers (at least 4 per photo) on these photos and indicate their projections on at least two
photos from the already aligned subset. PhotoScan will consider these points to be true matches. (For
information on markers placement refer to the Setting coordinate system section).

3. Select photosto berealigned and use Align Sel ected Cameras command from the photo context menu.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

When the alignment step is completed, the point cloud and estimated camera positions can be exported
for processing with another software if needed.

Image quality

Poor input, e. g. vague photos, can influence alignment results badly. To help you to exclude poorly
focused images from processing PhotoScan suggests automatic image quality estimation feature. Images
with quality value of less than 0.5 units are recommended to be disabled and thus excluded from
photogrammetric processing, providing that the rest of the photos cover the whole scene to be

reconstructed. To disable a photo use @ Disable button from the Photos pane toolbar.

PhotoScan estimates image quality for each input image. The value of the parameter is cal culated based
on the sharpness level of the most focused part of the picture.

To estimate image quality
L Switch to the detailed view in the Photos pane using == Details command from the Change menu
on the Photos pane toolbar.

2. Select all photos to be analyzed on the Photos pane.

3. Right button click on the selected photo(s) and choose Estimate Image Quality command from the
context menu.

4. Once the analysis procedure is over, a figure indicating estimated image quality value will be
displayed in the Quality column on the Photos pane.
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Alignment parameters

The following parameters control the photo alignment procedure and can be modified in the Align Photos
dialog box:

Accuracy
Higher accuracy settings help to obtain more accurate camera position estimates. Lower accuracy
settings can be used to get the rough camera positions in a shorter period of time.

While at High accuracy setting the software workswith the photos of the original size, Medium setting
causes image downscaling by factor of 4 (2 times by each side), at Low accuracy source files are
downscaled by factor of 16, and Lowest value means further downscaling by 4 times more. Highest
accuracy setting upscales the image by factor of 4. Since tie point positions are estimated on the
basis of feature spots found on the source images, it may be meaningful to upscale a source photo
to accurately localize atie point. However, Highest accuracy setting is recommended only for very
sharp image data and mostly for research purposes due to the corresponding processing being quite
time consuming.

Pair preselection
Thealignment process of large photo sets cantake along time. A significant portion of thistime period
is spent on matching of detected features across the photos. Image pair presel ection option may speed
up this process due to selection of asubset of image pairsto be matched. Inthe Gener i ¢ preselection
mode the overlapping pairs of photos are selected by matching photos using lower accuracy setting
first.

In the Ref er ence preselection mode the overlapping pairs of photos are selected based on the
measured camera locations (if present). For oblique imagery it is necessary to set Ground altitude
value (average ground height in the same coordinate system which is set for camera coordinates data)
in the Settings dialog of the Reference pane to make the preselection procedure work efficiently.
Ground altitude information must be accompanied with yaw, pitch, roll datafor cameras. Y aw, pitch,
roll data should be input in the Reference pane.

Y ou can switch on both options to speed up the processing even more.

Reset current alignment
If thisoption is checked, all thetie, and key, and matching points will be discarded and the alignment
procedure will be started from the very beginning.

Additionally the following advanced parameters can be adjusted.

Key point limit
The number indicates upper limit of feature points on every image to be taken into account during
current processing stage. Using zero value allows PhotoScan to find as many key points as possible,
but it may result in a big number of lessreliable points.

Tiepoint limit
The number indicates upper limit of matching points for every image. Using zero value doesn't apply
any tie point filtering.

Apply mask to
If apply mask to key points option is selected, areas previousy masked on the photos are excluded
from feature detection procedure. Apply mask to tie points option means that certain tie points are
excluded from alignment procedure. Effectively thisimpliesthat if some areais masked at least on a
single photo, relevant key points on the rest of the photos picturing the same areawill be also ignored
during alignment procedure (atie point is a set of key points which have been matched as projections
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of the same 3D point on different images). This can be useful to be able to suppress background in
turntable shooting scenario with only one mask. For additional information on the usage of masks
please refer to the Using masks section.

Adaptive camera model fitting

This option enables automatic selection of camera parametersto beincluded into adjustment based on
their reliability estimates. For data sets with strong camera geometry, like images of a building taken
from all the sides around, including different levels, it helps to adjust more parameters during initial
camera alignment. For data sets with weak camera geometry , like atypical aeria data set, it helps
to prevent divergence of some parameters. For example, estimation of radial distortion parameters
for data sets with only small central parts covered by the object is very unreliable. When the option
is unchecked, PhotoScan will refine only the fixed set of parameters: focal length, principal point
position, three radial distortion coefficients (K1, K2, K3) and two tangentia distortion coefficients
(PL, P2).

4 Note

e Tie point limit parameter allows to optimize performance for the task and does not generally
effect the quality of the further model. Recommended valueis4000. Too high or too low tie point
limit value may cause some parts of the dense point cloud model to be missed. The reason isthat
PhotoScan generates depth maps only for pairs of photos for which number of matching pointsis
abovecertain limit. Thislimit equalsto 100 matching points, unless moved up by thefigure"10%
of the maximum number of matching points between the photo in question and other photos,
only matching points corresponding to the area within the bounding box being considered.”

» The number of tie points can be reduced after the alignment process with Tie Points - Thin Point
Cloud command available from Tools menu. As aresults sparse point cloud will be thinned, yet
the alignment will be kept unchanged.

Incremental image alignment

In case some extra images should be subaligned to the set of already aligned images, you can benefit
from incremental image alignment option. To make it possible, two rules must be followed: 1) the scene
environment should not have changed significantly (lighting conditions, etc); 2) do not forget to switch on
Keep key points option in the Preferences dialog, Advanced tab BEFORE the whole processing is started.

To subalign some extra images added to the chunk with already aligned set of
images

1. Add extraphotos to the active chunk using Add photos command from the Workflow menu.
2. Open Align photos dialog from the Workflow menu.

3. Set alignment parameters for the newly added photos. IMPORTANT! Uncheck Reset alignment
option.

4. Click OK. PhotoScan will consider existing key pointsand try to match them with key points detected
on the newly added images.

Point cloud generation based on imported camera data

PhotoScan supportsimport of external and internal camera orientation parameters. Thus, if precise camera
data is available for the project, it is possible to load them into PhotoScan along with the photos, to be
used asinitial information for 3D reconstruction job.
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Toimport external and internal camera parameters
1. Select Import Cameras command from the File menu.

2. Select the format of the file to be imported.

3. Browsetothefile and click Open button.

4. The datawill be loaded into the software. Camera calibration data can be inspected in the Camera
Calibration dialog, Adjusted tab, available from Tools menu. If theinput file contains some reference
data (camera position datain some coordinate system), the datawill be shown on the Reference pane,
View Estimated tab.

Cameradata can beloaded in one of thefollowing formats. PhotoScan *.xml, BINGO *.dat, Bundler * .out,
Autodesk FBX (*.fbx), VisionMap Detailed Report *.txt, Realviz RZML *.rzml.

Once the data is loaded, PhotoScan will offer to build point cloud. This step involves feature points
detection and matching procedures. As aresult, a sparse point cloud - 3D representation of the tie-points
data, will be generated. Build Point Cloud command isavailable from Tools- Tie Points menu. Parameters
controlling Build Point Cloud procedure are the same as the ones used at Align Photos step (see above).

Building dense point cloud

PhotoScan allows to generate and visualize a dense point cloud model. Based on the estimated camera
positions the program calculates depth information for each camera to be combined into a single dense
point cloud. PhotoScan tends to produce extra dense point clouds, which are of almost the same density,
if not denser, as LIDAR point clouds. A dense point cloud can be edited and classified within PhotoScan
environment and used asabasisfor such processing stages asBuild Mesh, Build DEM, Build Tiled Model.
Alternatively, the point cloud can be exported to an external tool for further analysis.

To build adense point cloud

1 Check the reconstruction volume bounding box. To adjust the bounding box use the Resize

Region, % Move Region and 2?’ Rotate Region toolbar buttons. To resize the bounding box, drag
corners of the box to the desired positions; to move- hotd the box with the left mouse button.

2. Select the Build Dense Cloud... command from the Workflow menu.

3. IntheBuild Dense Cloud dialog box select the desired reconstruction parameters. Click OK button
when done.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Reconstruction parameters

Quality
Specifiesthedesired reconstruction quality. Higher quality settings can be used to obtain more detailed
and accurate geometry, but they require longer time for processing. Interpretation of the quality
parameters here is similar to that of accuracy settings given in Photo Alignment section. The only
difference is that in this case Ultra High quality setting means processing of original photos, while
each following step implies preliminary image size downscaling by factor of 4 (2 times by each side).

Additionally the following advanced parameters can be adjusted.
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Depth filtering modes
At the stage of dense point cloud generation reconstruction PhotoScan cal cul ates depth mapsfor every
image. Due to some factors, like noisy or badly focused images, there can be some outliers among
the points. To sort out the outliers PhotoScan has several built-in filtering algorithms that answer the
challenges of different projects.

If there are important small details which are spatially distinguished in the scene to be
reconstructed, then it is recommended to set M | d depth filtering mode, for important features
not to be sorted out as outliers. This value of the parameter may also be useful for aerial projects
in case the area contains poorly textured roofs, for example.

If the area to be reconstructed does not contain meaningful small details, then it is reasonable
to chose Aggr essi ve depth filtering mode to sort out most of the outliers. This value of the
parameter normally recommended for aerial data processing, however, mild filtering may be
useful in some projects as well (see poorly textured roofs comment in the mild parameter valur
description above).

Moder at e depth filtering mode brings results that are in between the Mild and Aggressive
approaches. Y ou can experiment with the setting in case you have doubts which mode to choose.

Additionally depth filtering can be Di sabl ed. But this option is not recommended as the resulting
dense cloud could be extremely noisy.

Calculate point colors
This option can be unchecked in case the points color is not of interest. This will allow to save up
processing time.

Reuse depth maps
If you would like to reuse depth maps available in the chunk, select respective Quality and Depth
filtering parameters values (seeinfo next to Depth maps|abel on the Workspace pane) and then check
Reuse depth maps option.

Point cloud import

PhotoScan allows to import a point cloud to be interpreted at further processing stages as a dense
point cloud. If you want to upload a dense point cloud got from some external source (photogrammetry
technology, laser scanning, etc), you can use Import points command from the File menu. In the Import
points dialog browse to afile in one of the supported formats and click Open button.

Dense point cloud can beimportedin one of thefollowing formats: Wavefront OBJ, Stanford PLY , ASPRS
LAS,LAZ, ASTM E57, ASCII PTS.

Building mesh

Mesh based on point cloud data

Based on the point cloud information (Dense Cloud, Sparse Cloud, Point Cloud uploaded from external
source) PhotoScan can reconstruct polygona model - mesh.

To build amesh

1. Check the reconstruction volume bounding box. If the model has aready been referenced, the
bounding box will be properly positioned automatically. Otherwise, it is important to control its
position manually.
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To adjust the bounding box manually, use the Resize Region, & Move Region and 22’ Rotate
Region toolbar buttons. Rotate the bounding box and then drag corners of the box to the desired
positions - only part of the scene inside the bounding box will be reconstructed. If the Hei ght

fi el d reconstruction method is to be applied, it isimportant to control the position of the red side
of the bounding box: it defines reconstruction plane. In this case make sure that the bounding box
is correctly oriented.

2. Select the Build Mesh... command from the Workflow menu.

3. Inthe Build Mesh dialog box select the desired reconstruction parameters. Click OK button when
done.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Reconstruction parameters

PhotoScan supports several reconstruction methods and settings, which help to produce optimal
reconstructions for a given data set.

Surfacetype

Ar bi t rary surface type can be used for modeling of any kind of object. It should be selected
for closed objects, such as statues, buildings, etc. It doesn't make any assumptions on the type of
the object being modeled, which comes at a cost of higher memory consumption.

Hei ght fi el d surfacetypeis optimized for modeling of planar surfaces, such as terrains or
basereliefs. It should be selected for aerial photography processing as it requires lower amount
of memory and allows for larger data sets processing.

Sour ce data
Specifies the source for the mesh generation procedure. Spar se cl oud can be used for fast 3D
model generation based solely on the sparse point cloud. Dense cl oud setting will result in longer
processing time but will generate high quality output based on the previously reconstructed dense
point cloud.

Face count

Specifies the maximum number of polygons in the final mesh. Suggested values (High, Medium,
Low) are calculated based on the number of pointsin the previously generated dense point cloud: the
ratio is 1/5, 1/15, and 1/45 respectively. They present optimal number of polygons for a mesh of a
corresponding level of detail. It isstill possible for auser to indicate the target number of polygonsin
the final mesh according to their choice. It could be done through the Custom value of the Face count
parameter. Please note that while too small number of polygonsis likely to result in too rough mesh,
too huge custom number (over 10 million polygons) is likely to cause model visualization problems
in external software.

Additionally the following advanced parameters can be adjusted.
I nter polation

If interpolation mode is Di sabl ed it leads to accurate reconstruction results since only areas
corresponding to dense point cloud points are reconstructed. Manual hole filling is usually
required at the post processing step.

WithEnabl ed (def aul t) interpolation mode PhotoScan will interpolate some surface areas
within acircle of a certain radius around every dense cloud point. As aresult some holes can be
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automatically covered. Y et some holes can still be present on the model and are to be filled at
the post processing step.

In Ext r apol at ed mode the program generates holeless model with extrapolated geometry.
Large areas of extra geometry might be generated with this method, but they could be easily
removed later using selection and cropping tools.

Point classes
Specifiesthe classes of the dense point cloud to be used for mesh generation. For example, select only
"Ground Points" to produce aDTM as opposed to aDSM. Preliminary Classifying dense cloud points
procedure should be performed for this option of mesh generation to be active.

Calculate vertex colors
If source data have color information for the points, you can optionally calculate vertex colors.

4 Note

 PhotoScan tendsto produce 3D model swith excessive geometry resolution, soitisrecommended
to perform mesh decimation after geometry computation. Moreinformation on mesh decimation
and other 3D model geometry editing toolsis given in the Editing model geometry section.

Visibility consistent mesh

In addition to mesh generation method described above, PhotoScan allows to generate and visualize a
mesh model right from depth mapswithout i ntermedi ate dense cloud generation. Visibility consistent mesh
generation method is experimental. It is oriented on filling the holes and can filter most of the noise out of
the 3D surface, providing that visibility constraints are maintained: rays coming from cameras positions
to surface points should not intersect the surface. It is also possible to prohibit surface reconstruction in
designated space volume with strict visibility masks. Strict volumetric masks are useful, for example, to
suppress noise between fingers by masking space between them from a single camera. Furthermore, it
is recommended to suppress textureless background to prevent it from sticking to the object contours -
masking out background on a single image is enough for the purpose.

To build amesh with new experimental method

1. Open preferences dialog from the Tools menu. On the Advanced tab enable Use visibility consistent
mesh generation method (experimental).

2. Check the reconstruction volume bounding box. If the model has already been referenced, the
bounding box will be properly positioned automatically. Otherwise, it is important to control its
position manually.

To adjust the bounding box manually, use the Resize Region, & Move Region and 2?’ Rotate
Region toolbar buttons. Rotate the bounding box and then drag corners of the box to the desired
positions - only part of the scene inside the bounding box will be reconstructed. If the Hei ght

fi el d reconstruction method is to be applied, it isimportant to control the position of the red side
of the bounding box: it defines reconstruction plane. In this case make sure that the bounding box
is correctly oriented.

3. Sdect the Build Mesh... command from the Workflow menu.

4. In the Build Mesh dialog box select the desired reconstruction parameters. Click OK button when
done.

5. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.
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Reconstruction parameters

PhotoScan supports several reconstruction settings, which help to produce optimal surfaces for a given
data set.

Surfacetype

Ar bi t rary surface type can be used for modeling of any kind of object. It should be selected
for closed objects, such as statues, buildings, etc. It doesn't make any assumptions on the type of
the object being modeled, which comes at a cost of higher memory consumption.

Visibility consistent mesh generation method is applicable to 3D surface reconstruction only.
For 25D Hi eght fi el d surface type the standard processing algorythm will be run.
Corresponding parameters are described in the section above.

Quality
Specifiesthe desired reconstruction quality. Higher quality settings can be used to obtain more detailed
and accurate geometry, but they require longer time for processing. Interpretation of the quality
parameters here is similar to that of accuracy settings given in Photo Alignment section. The only
difference is that in this case Ultra High quality setting means processing of origina photos, while
each following step implies preliminary image size downscaling by factor of 4 (2 times by each side).

Additionally the following advanced parameters can be adjusted.

Use strict volumetric masking

When this option is enabled, space volume covered with mask from at least one photo will be
suppressed. Each mask is strict - so you should use them as little as possible to prevent accidental
suppressing some surface parts. Each mask also makes mesh reconstruction slower. For example strict
volumetric masks are useful to suppress noise between fingers by masking space between them from
single camera. Also thisis useful to suppress textureless background stuck to object contours - by
masking out background from single camera. For additional information on the usage of masks please
refer to the Using masks section.

Reuse depth maps
If you would like to reuse depth maps available in the chunk, select respective Quality and Depth
filtering parameters values (see info next to Depth maps|abel on the Workspace pane) and then check
Reuse depth maps option. This method is applicable only to mild filtering mode.

Building model texture

Color calibration

If the lighting conditions have been changing significantly during capturing scenario, it is recommended
to use 'Calibrate colors option from the Tools menu before Build texture procedure. The option can help
to even brightness and white balance of the images over the data set. Please note that for large data sets
Cadlibrate colors procedure can turn out to be quite time consuming.

To calibrate colors
1. Select Cdibrate colors... command from the Tools menu.

2. Select the desired colors calibration parameters in the Calibrate colors dialog box. Click OK button
when done.
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3. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Color calibration parameters

Sour ce data
Defines what data should be taken as the basis for overlapping areas estimation.
Spar se cl oud - the quickest yet the roughest estimation available.

Model - gives more precise results, but only on condition that the surface is detailed enough. This
parameter value is the recommended one if the aim is to calibrate colors to improve the quality of
the model texture.

DEM- isareasonablealternativeto'Model’ valuefor large datasetswhenit isnot feasible to reconstruct
solid polygonal model (mesh).

Calibrate white balance
Additional option to be switched on if white balance should be evened as well.

To generate 3D model texture
1. Select Build Texture... command from the Workflow menu.

2. Select the desired texture generation parameters in the Build Texture dialog box. Click OK button
when done.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Texture mapping modes

The texture mapping mode determines how the object texture will be packed in the texture atlas. Proper
texture mapping mode selection helps to obtain optimal texture packing and, consequently, better visual
quality of the final model.

Generic
The default mode isthe Gener i ¢ mapping mode; it allows to parametrize texture atlas for arbitrary
geometry. No assumptions regarding the type of the scene to be processed are made; program tries
to create as uniform texture as possible.

Adaptive orthophoto
In the Adapti ve orthophot o mapping mode the object surface is split into the flat part and
vertical regions. Theflat part of the surfaceistextured using the orthographic projection, whilevertical
regions are textured separately to maintain accurate texture representation in such regions. When in
the Adapti ve orthophot o mapping mode, program tends to produce more compact texture
representation for nearly planar scenes, while maintaining good texture quality for vertical surfaces,
such as walls of the buildings.

Orthophoto
In the Ort hophot o mapping mode the whole object surface is textured in the orthographic
projection. The Ort hophot 0 mapping mode produces even more compact texture representation
thanthe Adapt i ve ort hophot o mode at the expense of texture quality in vertical regions.

Spherical
Spher i cal mapping modeisappropriate only to acertain class of objectsthat have aball-likeform.
It allows for continuous texture atlas being exported for this type of objects, so that it is much easier
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to edit it later. When generating texture in Spherical mapping mode it is crucial to set the Bounding
box properly. The whole model should be within the Bounding box. The red side of the Bounding
box should be under the model; it defines the axis of the spherical projection. The marks on the front
side determine the O meridian.

Single photo
The Si ngl e phot o mapping mode allowsto generate texture from asingle photo. The photo to be
used for texturing can be selected from 'Texture from' list.

Keep uv
The Keep uv mapping mode generates texture atlas using current texture parametrization. It can
be used to rebuild texture atlas using different resolution or to generate the atlas for the model
parametrized in the external software.

Texture gen eration parameters

The following parameters control various aspects of texture atlas generation:

Texture from (Single photo mapping mode only)
Specifies the photo to be used for texturing. Available only inthe Si ngl e phot o mapping mode.

Blending mode (not used in Single photo mode)
Selects the way how pixel values from different photos will be combined in the final texture.

Mosai ¢ - implies two-step approach: it does blending of low frequency component for overlapping
images to avoid seamline problem (weighted average, weight being dependent on a number of
parameters including proximity of the pixel in question to the center of the image), while high
frequency component, that is in charge of picture details, is taken from a single image - the one that
presents good resolution for the area of interest while the camera view is ailmost along the normal to
the reconstructed surface in that point.

Aver age - uses the weighted average value of all pixels from individual photos, the weight being
dependent on the same parametersthat are considered for high frequency component in mosaic mode.

Max | ntensity - the photo which has maximum intensity of the corresponding pixel is selected.
M n | ntensity - the photo which has minimum intensity of the corresponding pixel is selected.

Di sabl ed - the photo to take the color value for the pixel from is chosen like the one for the high
frequency component in mosaic mode.

Texturesize/ count
Specifies the size (width & height) of the texture atlas in pixels and determines the number of files
for texture to be exported to. Exporting texture to severa files allows to archive greater resolution of
the final model texture, while export of high resolution texture to a single file can fail due to RAM
limitations.

Multi-page texture atlas generation is supported for Generic mapping mode only and Keep UV option,
if the imported model contains proper texture layout.

Additionally the following advanced parameters can be adjusted.

Enable ghosting filter
In case the scene includes some thin structures or moving objects which failed to be reconstructed
as part of polygona model, it can be useful to switch on this option to avoid ghosting effect on the
resulting texture.
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Enable holefilling
Thisoption is enabled on default since it helps to avoid salt-and-pepper effect in case of complicated
surface with numerous tiny parts shading other parts of the model. Only in case of very specific tasks
might it be recommended to switch the function off.

4 Note

» HDR texture generation requires HDR photos on input.

Improving texture quality

To improve resulting texture quality it may be reasonable to exclude poorly focused images from
processing at this step. PhotoScan suggests automatic image quality estimation feature. Imageswith quality
value of less than 0.5 units are recommended to be disabled and thus excluded from texture generation

procedure. To disable a photo use ' Disable button from the Photos pane toolbar.
PhotoScan estimates image quality as a relative sharpness of the photo with respect to other images in

the data set. The value of the parameter is calculated based on the sharpness level of the most focused
part of the picture.

To estimate image quality

1 Switch to the detailed view in the Photos pane using == Details command from the Change menu

on the Photos pane toolbar.
2. Select all photos to be analyzed on the Photos pane.

3. Right button click on the selected photo(s) and choose Estimate Image Quality command from the
context menu.

4. Once the analysis procedure is over, a figure indicating estimated image quality value will be
displayed in the Quality column on the Photos pane.

Building tiled model

Hierarchical tilesformat is a good solution for city scale modeling. It alows for responsive visualisation
of large area 3D models in high resolution. The tiled model can be either opened in PhotoScan itself or
with Agisoft Viewer - acomplementary tool included in PhotoScan installer package, or with some other
external application which supports a hierarchical tiles format.

Tiled model isbuild based on dense point cloud, or mesh, or depth mapsdata. Hierarchical tilesaretextured
from the source imagery.

4 Note
» Build Tiled Model procedure can be performed only for projects saved in .PSX format.

To build atiled model

1. Check the reconstruction volume bounding box - tiled model will be generated for the area within

bounding box only. To adjust the bounding box use the % Move Region, Resize Region and
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2?’ Rotate Region toolbar buttons. Rotate the bounding box and then drag corners of the box to the
desired positions.

2. Select the Build Tiled Model... command from the Workflow menu.

3. Inthe Build Tiled model dialog box select the desired reconstruction parameters. Click OK button
when done.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Reconstruction parameters

Sour ce data
Dense cl oud. Recommended for large projects when Build mesh procedure is not feasible due
to processing time and result management issues.

Mesh. Allowsto keep al the details in the tiled model if a very detailed mesh has been generated
previously.

Dept h maps. Usesvisibility consistent mesh generation method to create tiles of the most detailed
level possible.

Pixel size (m)
Suggested value shows automatically estimated pixel size due to input imagery effective resolution.
It can be set by the user in meters.

Tilesize
Tile size can be set in pixels. For smaller tiles faster visualisation should be expected.

Quality (Visibility consistent mesh generation method only)
Interpretation of the quality parameters here is similar to that of accuracy settings given in Photo
Alignment section. The only differenceisthat in this case UltraHigh quality setting means processing
of original photos, while each following step implies preliminary image size downscaling by factor
of 4 (2 times by each side).

4 Note

» Touse experimental visibility consistent mesh generation method you need to switch the option
on in the Preferences dialog, Advanced tab.

Building digital elevation model

PhotoScan allows to generate and visualize adigital elevation model (DEM). A DEM represents a surface
model as aregular grid of height values. DEM can be rasterized from a dense point cloud, a sparse point
cloud or amesh. Most accurate results are cal culated based on dense point cloud data. PhotoScan enables
to perform DEM-based point, distance, area, volume measurements as well as generate cross-sections for
a part of the scene selected by the user. Additionally, contour lines can be calculated for the model and
depicted either over DEM or Orthomosai ¢ in Ortho view within PhotoScan environment. Moreinformation
on measurement functionality can be found in Performing measurements on DEM section.

4 Note

« Build DEM procedure can be performed only for projects saved in .PSX format.
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« DEM can be calculated for referenced or scaled projects only. So make sure that you have set
a coordinate system for your model or specified at least one reference distance before going to
build DEM operation. For guidance on Setting coordinate system please go to Setting coordinate
system

DEM iscalculated for the part of the model within the bounding box. To adjust the bounding box use the

P Resize Region and g?’ Rotate Region toolbar buttons. Rotate the bounding box and then drag corners
of the box to the desired positions.

To build DEM
1. Select the Build DEM... command from the Workflow menu.
2. Inthe Build DEM dialog box set Coordinate system for the DEM or choose the projection type.
3. Select source datafor DEM rasterization.
4. Click OK button when done.
5. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.
Parameters

Projection type

CGeogr aphi ¢ - dlowsto choose a geographic coordinate system from the dropdown list or upload
parameters of a customised geographical coordinate system. The coordinate system set by default
is the coordinate system previously selected for the model itself. Y ou can switch to a different one,
providing that corresponding datum transformation parameters are available.

Pl anar . PhotoScan alows to project DEM onto a plane set by the user. Y ou can select projection
plane and orientation of the resulting DEM. The plane can be determined by a set of markers (if there
areno 3 markersin adesired projection planeit can be specified with 2 vectors, i. e. 4 markers). Planar
projection type may be useful for DEM generation in projects concerning facades, for example.
Cylindrical - alows to project DEM on a cylindrical surface. In this case height value is
calculated as the distance from the model surface to the cylindric surface. Refer to Building
orthomosaic section to see the options.

Sour ce data

It is recommended to calculate DEM based on dense point cloud data. Preliminary elevation data
results can be generated from asparse point cloud, avoiding Build Dense Cloud step for time limitation
reasons.

Interpolation

If interpolation mode is Di sabl ed it leads to accurate reconstruction results since only areas
corresponding to dense point cloud points are reconstructed.

With Enabl ed (def aul t) interpolation mode PhotoScan will calculate DEM for al areas of the
scene that are visible on at least one image. Enabl ed (defaul t) setting is recommended for
DEM generation.

In Ext r apol at ed mode the program generates holeless model with some elevation data being
extrapolated up to the bounding box extents.

Point classes

The parameter allows to select a point class (classes) that will be used for DEM calculation.
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To generate digital terrain model (DTM), it is necessary to classify dense cloud points first in order to
divide them in at least two classes: ground points and the rest. Please refer to Classifying dense cloud
points section to read about dense point cloud classification options. Select Ground value for Point class
parameter in Build DEM dialog to generate DTM.

To calculate DEM for aparticular part of the project, use Region section of the Build DEM dialog. Indicate
coordinates of the bottom left and top right corners of the region you woul like to build the DEM for.
Suggested values indicate coordinates of the bottom left and top right corners of the whole area to be
rasterized, the area being defined with the bounding box.

Resolution value shows effective ground resolution for the DEM estimated for the source data. Size of the
resulting DEM, calculated with respect to the ground resolution, is presented in Total size textbox.

Building orthomosaic

Orthomosaic export isnormally used for generation of high resolution imagery based on the source photos
and reconstructed model. The most common application is aerial photographic survey data processing,
but it may be also useful when a detailed view of the object is required. PhotoScan enables to perform
orthomosaic seamline editing for better visual results (see Orthomosaic seamlines editing section of the
manual).

For multispectral imagery processing workflow Ortho view tab presents Raster Calculator tool for NDVI
and other vegetation indices calculation to analyze crop problems and generate prescriptions for variable
rate farming equipment. More information on NDV | calculation functionality can be found in Performing
measurements on 3D model section.

4 Note

 Build Orthomosaic procedure can be performed only for projectssavedin .PSX format for chunks
with the existing mesh or DEM.

Color calibration

If the lighting conditions have been changing significantly during capturing scenario, it is recommended
to use 'Calibrate colors' option from the Tools menu before Build orthomosaic procedure. The option can
help to even brightness and white balance of the images over the data set. Please note that for large data
sets Calibrate colors procedure can turn out to be quite time consuming.

To calibratecolors
1. Sedlect Calibrate colors... command from the Tools menu.

2. Select the desired colors calibration parameters in the Calibrate colors dialog box. Click OK button
when done.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Color calibration parameters

Sour ce data
Defines what data should be taken as the basis for overlapping areas estimation. It is preferable to
select the source data type according to teh surface which you plan to project the orthomosaic on.
Spar se cl oud - the quickest yet the roughest estimation available.

32



General workflow

Build

Model - gives more precise results, but only on condition that the surface is detailed enough.

DEM- isareasonablealternativeto'Model' valuefor large datasetswhenitisnot feasible to reconstruct
solid polygona model (mesh).

Calibrate white balance

Additional option to be switched on if white balance should be evened as well.

To build Orthomosaic

1.

2.

Select the Build Orthomosaic... command from the Workflow menu.

In the Build Orthomosaic dialog box set Coordinate system for the Orthomosaic referencing or select
projection type.

Select type of surface data for orthorectified imagery to be projected onto.
Click OK button when done.

The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

orthomosaic parameters

Projection type

Geogr aphi ¢ - alowsto choose a geographic coordinate system from the dropdown list or upload
parameters of a customized geographical coordinate system. The coordinate system set by default
is the coordinate system previously selected for the model itself. Y ou can switch to a different one,
providing that corresponding datum transformation parameters are available.

Pl anar . PhotoScan allows to project the orthomosaic onto a plane set by the user, providing
that mesh is selected as the surface type. You can select projection plane and orientation of the
orthomosaic. The plane can be determined by a set of markers (if there are no 3 markersin adesired
projection plane it can be specified with 2 vectors, i. e. 4 markers). Planar projection type may be
useful for orthomosaic generation in projects concerning facades or other vertical surfaces.

Cylindrical - alowsto project orthomosaic on a cylindrical surface. It helps to avoid severe
distortions while projecting cylindrical objects, like tubes, round towers, tunnels, etc.

To project 3D pointson acylindrical surface oneneedsto: 1) definethecylinder, i.e. defineitsaxisand
itsradius; 2) drop aperpendicular fromthe 3D point to the axisof the cylinder - the point of intersection
of the perpendicular and the cylindrical surfaceis the projection of the 3D point in question; 3) agree
on how to define x and y coordinates of a point on the cylinder. For the purpose of orthomosaic and
DEM generation in cylindrical projection PhotoScan defines x and y coordinates of a point on the
cylinder in the following way: x - along the curve in the zero-plane, y - along the zero-element of the
cylindric surface (zero-line), where zero-plane and zero-line are to be defined.

PhotoScan offers four methods to perform projecting on cylindrical surface. They differ in how the
four core elements - cylinder axis and radius, zero-plane and zero-line - are defined.

Current Regi on. Thecylinder isinscribed in the Bounding box: the axis goes through the cross
sign on the bottom side of the Bounding box perpendicular to the bottom plane; the radius is defined
as one half of the shorter side of the rectangle in the bottom of the Bounding box. Zero-plane goes
through the center of the Bounding box perpendicular to the axis; zero-line belongs to the Bounding
box side which is opposite to the side with the vertical marks.
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Current View. Theaxisis set as the line from the viewpoint to the center of rotation for the
model. Radiusis defined as one half of the shortest of al the edges of the Bounding box. Zero-plane
goes through the center of rotation for the model perpendicular to the axis; zero-line goes through the
highest point (in monitor-related coordinate system) of the curve in the zero-plane.

Mar ker s. At least three marker are required. The first pair sets the axis. The third marker defines
zero-point, i.e. defines zero-plane and zero-line, on condition that radiusis the distance from the third
marker to the axis.

XYl Z. Theaxisistheline parallel to the corresponding Cartesian axis - X/Y/Z, going through the
center of the Bounding box. Radius (r) is defined as one half of the shortest edge of the Bounding box.
Zero-plane goes through the center of the Bounding box perpendicular to the axis; zero-line is the
line opposite to the cut line. The cut line definition for each of the three possible optionsisillustrated
on the Figure below.

Interior projection optionalowstoswitchto projecting ontheinner surface of the cylinder.

Surface
Orthomosaic creation based on DEM data is especially efficient for aerial survey data processing
scenarios alowing for time saving on mesh generation step. Alternatively, mesh surface type allows
to create orthomosaic for less common, yet quite demanded applications, like orthomosaic generation
for facades of the buildings or other models that might be not referenced at al.

Blending mode
Mosai ¢ (defaul t) - implements approach with data division into several frequency domains
which are blended independently. The highest frequency component is blended along the seamline
only, each further step away from the seamline resulting in aless number of domains being subject
to blending.
Aver age - uses the weighted average value of all pixelsfrom individual photos.
Di sabl ed - the color value for the pixel istaken from the photo with the camera view being almost
along the normal to the reconstructed surface in that point.

Pixel size
Default value for pixel size in Export Orthomosaic dialog refers to ground sampling resolution, thus,
it is useless to set a smaller value: the number of pixels would increase, but the effective resolution
would not. However, if it is meaningful for the purpose, pixel size value can be changed by the user
in coordinate system units or in meters.

Max. dimension (pix)
The parameter allows to set maximal dimension for the resulting raster data.

Back face culling
The option allows to neglect on projecting parts of the surface where normals are counter directed to
the targeted projection plane.
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PhotoScan generates orthomosaic for the whole area, where surface data is available. Bounding box
limitationsarenot applied. To build orthomosaic for aparticul ar (rectangular) part of the project use Region
section of the Build Orthomosaic dialog. I ndicate coordinates of the bottom left and top right corners of the
region to be exported in the left and right columns of the textboxes respectively. Estimate button allows
you to see the coordinates of the bottom |eft and top right corners of the whole area.

Estimate button enables to control total size of the resulting orthomosaic data for the currently selected
reconstruction area (all available data (default) or a certain region (Region parameter)) and resolution
(Pixel size or Max. dimension parameters). The information is shown in the Total size (pix) textbox.

Saving intermediate results

Certain stages of 3D model reconstruction can take a long time. The full chain of operations could
eventually last for 4-6 hours when building a model from hundreds of photos. It is hot always possible to
complete al the operations in one run. PhotoScan allows to save intermediate resultsin a project file.

PhotoScan project archive (.PSZ)

PhotoScan Archive files (*.psz) may contain the following information:;
* List of loaded photographs with reference paths to the image files.

 Photo alignment data such as information on camera positions, sparse point cloud model and set of
refined camera calibration parameters for each calibration group.

» Masks applied to the photosin project.
» Depth maps for cameras.
» Dense point cloud model with information on points classification.

» Reconstructed 3D polygonal model with any changes made by user. This includes mesh and texture
if it was built.

 List of added markers aswell as of scale-bars and information on their positions.
* Structure of the project, i.e. number of chunksin the project and their content.

Notethat since PhotoScan tendsto generate extradense point cloudsand highly detailed polygona models,
project saving procedure can take up quite along time. Y ou can decrease compression level to speed up the
saving process. However, please note that it will result in alarger project file. Compression level setting
can be found on the Advanced tab of the Preferences dialog available from Tools menu.

PhotoScan project file ((PSX)

The software also alows to save PhotoScan Project file (*.psx) which stores the links to the processing
resultsin *.psx file and the dataitself in * .files structured archive. Thisformat enables responsive loading
of large data (dense point clouds, meshes, etc.), thus avoiding delays on reopening a thousands-of -photos
project. DEM, orthomosaic and tiled model generation options are available only for projects saved in
PSX format.

Y ou can save the project at the end of any processing stage and return to it later. To restart work simply
load the corresponding file into PhotoScan. Project files can also serve as backup files or be used to save
different versions of the same model.
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Project files use relative paths to reference original photos. Thus, when moving or copying the project file
to another location do not forget to move or copy photographs with all the folder structure involved as
well. Otherwise, PhotoScan will fail to run any operation requiring source images, although the project
file including the reconstructed model will be loaded up correctly. Alternatively, you can enable Store
absol ute image paths option on the Advanced tab of the Preferences dialog available from Tools menu.

Exporting results

PhotoScan supports export of processing results in various representations: sparse and dense point clouds,
camera calibration and camera orientation data, mesh, etc. Orthomosaics and digital elevation models
(both DSM and DTM), aswell as tiled models can be generated according to the user requirements.

Point cloud and camera calibration data can be exported right after photo alignment iscompl eted. All other
export options are available after the corresponding processing step.

If you are going to export the results (point cloud / mesh / tiled model ) for the chunk that is not referenced,
please note that the resulting file will be oriented according to a default coordinate system (see axes in
the bottom right corner of the Model view), i. e. the model can be shown differently from what you see

e 1
in PhotoScan window. To align the model orientation with the default coordinate system use “4# Rotate

object button from the Toolbar. o Move object and Scale object instruments can be used to adjust
the size and location of the unreferenced model.

In some cases editing model geometry in the external software may be required. PhotoScan supports model
export for editing in external software and then allows to import it back as it is described in the Editing
model geometry section of the manual.

Main export commands are available from the File menu.

Point cloud export

To export sparse or dense point cloud

1. Select Export Points... command from the File menu.

2. Browsethe destination folder, choose the file type, and print in the file name. Click Save button.
3. Inthe Export Points dialog box select desired Type of point cloud - Sparse or Dense.

4. Specify the coordinate system and indicate export parameters applicable to the selected file type,
including the dense cloud classes to be saved.

5. Click OK bhutton to start export.

6. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Split in blocks option in the Export Points dialog can be useful for exporting large projects. It is available
for referenced models only. Y ou can indicate the size of the section in xy plane (in meters) for the point
cloud to be divided into respective rectangular blocks. The total volume of the 3D sceneis limited with
the Bounding Box. The whole volume will be split in equal blocks starting from the point with minimum
x and y values. Note that empty blocks will not be saved.

In some casesit may bereasonableto edit point cloud before exporting it. To read about point cloud editing
refer to the Editing point cloud section of the manual.
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PhotoScan supports point cloud export in the following formats:
* Wavefront OBJ

» Stanford PLY

* XYZ text file format
* ASPRSLAS

e LAZ

 ASTM E57
 ASCII PTS

» Autodesk DXF

* U3D

* potree

* Cesium 3D Tiles

» Agisoft OC3

» Topcon CL3

- PDF

£ Note

 Saving color information of the point cloud is not supported by the OBJ and DXF formats.

» Saving point normals information is not supported by the LAS, LAZ, PTS, CL3 and DXF
formats.

PhotoScan supports direct uploading of the point cloudsto the following resources: 4DMapper, PointBox,
PointScene and Sketchfab. To publish your point cloud online use Upload Model... command from the
File menu.

Tie points and camera calibration, orientation data
export

To export cameracalibration and camera orientation data select Export Cameras... command from the File
menu.

PhotoScan supports camera data export in the following formats:

» Agisoft XML structure

Bundler OUT file format

* CHAN file format

Boujou TXT file format

» Omega Phi Kappatext file format
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* Realviz RZML format

» PATB Exterior orientation

* BINGO project file

* ORIMA file

» AeroSys Exterior orientation
* Inpho project file

» Summit Evolution project

 Blocks exchange

[{ Note

» Cameradata export in Bundler and Boujou file formats will save sparse point cloud datain the
samefile.

» Cameradataexport in Bundler file format would not save distortion coefficients k3, k4.

To export tie points data one should choose one of the following exchange formats in the Export Cameras
diadog: BINGO, ORIMA, PATB, Summit Evolution or Blocks. Tie points can be exported only along with
camera calibration and orientation data.

To export / import only camera calibration data select Camera Calibration... command from the Tools

menu. Using =~/ P‘ buttonsit is possible to load / save camera calibration datain the following formats:
» Agisoft Camera Calibration (*.xml)

» Australis Camera Parameters (* .txt)

» PhotoModeler Camera Calibration (*.ini)

» 3DM CalibCam Camera Parameters (*.txt)

e CaCam Camera Calibration (*.cal)

* Inpho Camera Calibration (*.txt)

e USGS Camera Calibration (*.txt)

» Z/I Distortion Grid (*.dat)

Panorama export

PhotoScan is capable of panorama stitching for images taken from the same camera position - camera
station. To indicate for the software that loaded images have been taken from one camera station, one
should move those photos to a camera group and assign Camera Station type to it. For information on
camera groups refer to Loading photos section.

To export panorama
1. Select Export Panorama... command from the File menu.

2. Select camera group which panorama should be previewed for.
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5.
6.

Choose panorama orientation in the file with the help of navigation buttonsto the right of the preview
window in the Export Panorama dialog.

Set exporting parameters: select camera groups which panorama should be exported for and indicate
export file name mask.

Click OK button

Browse the destination folder and click Save button.

Additionally, you can set boundaries for the region of panorama to be exported using Setup boundaries
section of the Export Panorama dialog. Text boxes in the first line (X) alow to indicate the angle in the
horizontal plane and the second line (YY) servesfor angleinthevertica planelimits. Image size (pix) option
enables to control the dimensions of the exported image file.

PhotoScan supports panorama export in the following formats:

JPEG
TIFF
PNG
BMP
OpenEXR

TARGA

3D model export

To export 3D model

1.

2.

Select Export Model... command from the File menu.
Browse the destination folder, choose the file type, and print in the file name. Click Save button.

In the Export Model dialog specify the coordinate system and indicate export parameters applicable
to the selected file type.

Click OK button to start export.

The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

If amodel generated with PhotoScan is to be imported in a 3D editor program for inspection or further
editing, it might be helpful to use Shift function while exporting the model. It allows to set the value to
be subtracted from the respective coordinate value for every vertex in the mesh. Essentialy, this means
trangl ation of themodel coordinate system origin, which may be useful since some 3D editors, for example,
truncate the coordinates values up to 8 or so digits, while in some projects they are decimals that make
sense with respect to model positioning task. So it can be recommended to subtract a value equa to the
whole part of acertain coordinate val ue (see Reference pane, Camera coordinates values) before exporting
the model, thus providing for areasonable scale for the model to be processed in a3D editor program.

PhotoScan supports model export in the following formats:

* Wavefront OBJ
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+ 3DSfileformat

* VRML

« COLLADA

* Alembic

» Stanford PLY

* STL

» Autodesk FBX

» Autodesk DXF (in Polyline or 3DFace representation)
» U3D

» Google Earth KMZ
» Adobe PDF

Some fileformats (OBJ, 3DS, VRML, COLLADA, PLY, FBX) save texture image in aseparate file. The
texture file should be kept in the same directory as the main file describing the geometry. If the texture
atlas was not built only the model geometry is exported.

PhotoScan supports direct uploading of the models to Sketchfab resource. To publish your model online
use Upload Model... command from the File menu.

Tiled model export

To export tiled model
1. Select Export Tiled Model... command from the File menu.
2. Browsethe destination folder, choose the file type, and print in the file name. Click Save button.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

PhotoScan supports tiled model export in the following formats:
* Cesium 3D Tiles (*.zip)

» Scene Layer Package (*.5lpk)

PhotoMesh Layer (*.zip)

Agisoft Tiled Model (*.tls)

Agisoft Tile Archive (*.zip)

Agisoft Tiled Model can be visualised in Agisoft Viewer application, which is included in Agisoft
PhotoScan Professional installation file. Thanks to hierarchical tiles format, it allows to responsively
visualise large models.

PhotoScan supports direct uploading of the tiled models to the following resources. 4DMapper, Melown
Cloud, Sputnik. To publish your tiled model online use Upload Model... command from the File menu.
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Orthomosaic export

To export Orthomosaic
1. Select Export Orthomosaic... command from the File menu.
2. Inthe Export Orthomosaic dialog box specify coordinate system for the Orthomosaic to be saved in.

3. Check Write KML file and / or Write World file options to create files needed to georeference the
orthomosaic in the Google Earthand / or aGIS.

4. Click Export... button to start export.
5. Browsethe destination folder, choose the file type, and print in the file name. Click Save button.

6. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

4 Note

* Write KML file option is available only if the selected export coordinate system is WGS84 due
to the fact that Google Earth supports only this coordinate system.

« World file specifies coordinates of the four corner vertices of the exporting orthomosaic. This
informationisalready included in GeoTIFF file, however, you could duplicateit for somereason.
If you need to export orthomosaic in JPEG, PNG or BMP file formats and would like to have
georeferencing data this informations could be useful.

If the export file of afixed size is needed, it is possible to set the length of the longer side of the export
filein Max. dimension (pix) parameter. The length should be indicated in pixels.

Split in blocks option in the Export Orthomosaic dialog can be useful for exporting large projects. You
can indicate the size of the blocks (in pix) for the orthomosaic to be divided into. The whole areawill be
split in equal blocks starting from the point with minimum x and y values. Note that empty blocks will
not be saved.

To export a particular part of the project use Region section of the Export Orthomosaic dialog. Indicate
coordinates of the bottom left and top right corners of the region to be exported in the left and right columns
of the textboxes respectively. Estimate button allows you to see the coordinates of the bottom left and top
right corners of the whole area.

Alternatively, you can indicate the region to be exported using polygon drawing option in the Ortho view
tab of the program window. (For instructions on polygon drawing refer to Shapes section of the manual.)
Once the polygon is drawn, right-click on the polygon and set it as aboundary of the region to be exported
using Set Boundary Type option from the context menu.

Default value for pixel size in Export Orthomosaic dialog refers to ground sampling resolution, thus, it
is useless to set a smaller value: the number of pixels would increase, but the effective resolution would
not. If you have chosen to export orthomosaic with a certain pixel size (not using Max. dimension (pix)
option), it is recommended to check estimated Total size (pix) of the resulting file to be sure that it is not
too large to be correctly saved to the targeted file format.

For (Geo)TIFF export compression type may be set by the user. The following options are available:
LZW, JPEG, Packbits, Deflate. Additionally, the file may be saved without compression (None value
of the compression type parameter). Write BigTIFF file option allows to save files bigger than standard
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TIFF limit of 4Gb. Total size textbox in the Export Orthomosaic dialog helps to estimate the size of the
resulting file. However, it is recommended to make sure that the application you are planning to open the
orthomosaic with supports BigTIFF format. Alternatively, you can split a large orthomosaic in blocks,
with each block fitting the limits of a standard TIFF file.

While exporting orthomosaic in JPEG format, JPEG quality parameter controls balance between
compression level (i.e. quality of the result) and export file size: the higher the value of the parameter (%)
the more emphasisis on the quality at the expense of alarger resulting file.

The following formats are supported for orthomaosaic export:
» GeoTIFF

* JPEG

* PNG

« BMP

» Multiresolution Google Earth KML mosaic

» Google Map Tiles

» MBTiles

* World Wind Tiles

PhotoScan supports direct uploading of the orthomosaics to the following resources: 4ADMapper, MapBox,
Melown Cloud, Sputnik. To publish your point cloud online use Upload Model... command from the File
menul.

Multispectral orthomosaic export is supported in GeoTIFF format only. When exporting in other formats,
only primary channel will be saved. Multispectral orthomosaic has all channels of the original imagery.
Optionally the alpha channel may be included that defines transparency being used for no-data areas of
the orthomosaic.

To export Multispectral orthomosaic

1. Select Export Orthomosaic... command from the File menu.

2. Follow steps 2-3 from Orthomosai ¢ export procedure above.

3. Select None value for Raster transform parameter.

4. Click Export button to start export.

5. Browsethe destination folder, choose GeoTIFF type, and print in the file name. Click Save button.

6. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

NDVI data export

Vegetation index data export is available with the Export Orthomosaic... command from the File menu.
V egetation index data can be saved astwo types of data: asagrid of floating point index values calculated
per pixel of orthomosaic (multichannel orthomosaic if several vegetation indices have been calculated for
the project) or as an orthomosaic in pseudocolours according to a pallet set by user (exports only datafor
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the first vegetation index or combined data for selected 3 vegetation indices, providing that False Color
value is set for the colour palette parameter). The format is controlled with Raster transform option in
Export Orthomosaic / Export Google KMZ / Export Google Map Tiles/ Export MBTiles/ Export World
Wind Tiles dialogs. None value alows to export orthomosaic generated for the data before any index
calculation procedure was performed.

Digital Elevation Model (DSM/DTM) export

PhotoScan allows to calculate and then export both a digital surface model (DSM) and a digital terrain
model (DTM) (see Building digital elevation model section).

To export Digital Elevation M odel
1. Sedlect Export DEM... command from the File menu.
2. Inthe Export DEM dialog specify coordinate system to georeference the DEM.

3. Check Write KML file and/or Write World file options to create files needed to georeference the
DEM in the Google Earth and/or a GIS.

4. Click Export button to start export.
5. Browsethe destination folder, choose the file type, and print in the file name. Click Save button.

6. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

4 Note

* Write KML file option is available only if the model is georeferenced in WGS84 coordinate
system due to the fact that Google Earth supports only this coordinate system.

« World file specifies coordinates of the four corner vertices of the exporting DEM. This
information is already included in GeoTIFF elevation data as well as in other supported file
formats for DEM export, however, you could duplicate it for some reason.

If export file of afixed sizeisneeded, it is possible to to set the length of the longer side of the export file
in Max. dimension (pix) parameter. The length should be indicated in pixels.

Unlike orthomosaic export, it is sensible to set smaller pixel size compared to the default value in DEM
export dialog; the effective resolution will increase. If you have chosen to export DEM with a certain pixel
size (not using Max. dimension (pix) option), it is recommended to check estimated Total size (pix) of the
resulting file to be sure that it is not too large to be correctly saved to the targeted file format.

No-data value is used for the points of the grid, where elevation value could not be calculated based on
the source data. Default value is suggested according to the industry standard, however it can be changed
by user.

Split in blocks option in the Export DEM dialog can be useful for exporting large projects or meeting
special DEM requirements. (See Orthomosaic export section for details.)

To export a particular part of the project use Region section of the Export DEM dialog. (See Orthomosaic
export section for details.) Similarly to orthomosaic export, polygons drawn over the DEM on the Ortho
tab of the program window can be set as boundariesfor DEM export. (For instructions on polygon drawing
refer to Shapes section of the manual.)
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The following formats are supported for DEM export:

GeoTIFF elevation data

Arc/Info ASCII Grid (ASC)

Band interleaved file format (BIL)

XYZ file format

Sputnik KMZ

PhotoScan supports direct uploading of the elevation models to the following resources: 4ADMapper,
MapBox, Melown Cloud, Sputnik. To publish your elevation model online use Upload Model... command
from the File menu.

Extra products to export

In addition to main targeted products PhotoScan allows to export several other processing results, like

» Undistort photos, i. e. photosfree of lensdistortions (Undistort Photos... command avail able from Export
submenu of the File menu). Undistorted photos may be exported with the applied color correction, if
corresponding option is selected in the Undistort Photos dialog.

» Depth map for any image (Export Depth... command available from photo context menu).

« Individually orthorectified images (Export Orthophotos... command available from Export submenu of
the File menu).

* High resolution image of the model asit is shown in the Model view or in Ortho view mode. Capture
View command available from the context menu shown on right button click inthe Model or Ortho view.

Processing report generation

PhotoScan supports automatic processing report generation in PDF format, which contains the basic
parameters of the project, processing results and accuracy evaluations.

To generate processing report
1. Select Generate Report... command from the File menu.
2. Browsethe destination folder, choose the file type, and print in the file name. Click Save button.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

PhotoScan processing report presents the following data:
* Orthomosaic sketch.

» Survey data including coverage area, flying altitude, GSD, general camera(s) info, as well as overlap
statistics.

» Camera calibration results: figures and an illustration for every sensor involved in the project.

» Camera positioning and orientation error estimates.
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 Ground control and check points error estimates.

» Scale bars estimated distances and measurement errors.

Digital elevation model sketch with resolution and point density info.

» Processing parameters used at every stage of the project.
£ Note

« Processing report can be exported after alignment step. Processing report export option is
available for georeferenced projects only.

Survey Data
Nunber of i mages - total number of images uploaded into the project.
Canera stations - number of aligned images.
Fl yi ng al titude - average height above ground level.
Ti e poi nt s - total number of valid tie points (equals to the number of pointsin the sparse cloud).
Ground resol uti on - effective ground resolution averaged over all aligned images.
Pr oj ect i ons - total number of projections of valid tie points.
Cover age ar ea - size of the areathat has been surveyed.
Repr oj ecti on error -root mean square reprojection error averaged over al tie pointson all images.

Reprojection error is the distance between the point on the image where a reconstructed 3D point can be
projected and the original projection of that 3D point detected on the photo and used as a basis for the
3D point reconstruction procedure.

Camera Calibration

For precalibrated cameras internal parameters input by the user are shown on the report page. If acamera
was not precalibrated, internal camera parameters estimated by PhotoScan are presented.

Camera Locations
X error (n) -root mean square error for X coordinate for all the cameras.
Y error (n) -root mean square error for Y coordinate for all the cameras.
XY error (mn -root mean sguareerror for X and Y coordinates for all the cameras.
Z error (m -root mean square error for Z coordinate for al the cameras.
Total error (m -root mean squareerror for X, Y, Z coordinates for all the cameras.
Total error = sart(Sumi=1" [(Xi, est - X, in)” + (Yi, est - Yi,in)” + (Zi, et - Zi,in)°] / 1)
Xi. in - input value for X coordinate for i camera position,

Xi. est - €stimated value for X coordinate for i camera position,
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Yi,in - input value for Y coordinate for i camera position,
Y|, ex - estimated value for Y coordinate for i camera position,
Z; in - input value for Z coordinate for i camera position,

Z; o - estimated value for Z coordinate for i camera position,

Ground Control and Check Points
XY error (m -root mean squareerror for X and Y coordinates for a GCP location / check point.
Z error (m -erorforZ coordinate for a GCP location / check point.
Error (m -root mean square error for X, Y, Z coordinates for a GCP location / check point.
Pr oj ecti ons - number of projections for a GCP location / check point over al the images.

Error (pix) -root mean square error for X, Y coordinates on an image for a GCP location / check
point averaged over all theimages.

Tot al - impliesaveraging over all the GCP locations/ check points.

Scale Bars

Di st ance (n) - scalebar length estimated by PhotoScan.
Error (m - difference between input and estimated values for scale bar length.

Tot al - impliesaveraging over al the scale barsin Control/Check section.

Digital Elevation Model

Resol uti on - effective resolution of the exported DEM. The value depends on the Quality parameter
value used at Build point cloud step, providing that DEM has been generated from dense point cloud.

Poi nt Densi ty - average number of dense cloud points per square meter.

Processing Parameters

Processing report contains processing parametersinformation, which isalso available form Chunk context
menu. Along with the values of the parameters used at various processing stages, this page of the report
presents information on processing time.

For projects calculated over network processing time will be displayed as a sum of the time spent for
processing by each node.

PhotoScan matches images on different scales to improve robustness with blurred or difficult to match
images. The accuracy of tie point projections depends on the scale at which they were located. PhotoScan
uses information about scale to weight tie point reprojection errors. In the Reference pane settings dialog
tie point accuracy parameter now corresponds to normalized accuracy - i.e. accuracy of tie point detected
at the scale equal to 1. Tie points detected on other scales will have accuracy proportional to their scales.
This helps to obtain more accurate bundle adjustment results. On the processing parameters page of the
report (aswell asin chunk information dialog) two reprojection errors are provided: the reprojection error
in the units of tie point scale (this is the quantity that is minimized during bundle adjustment), and the
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reprojection error in pixels (for convenience). The mean key point size value is a mean tie point scale
averaged across al projections.
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Camera calibration

Calibration groups

While carrying out photo alignment PhotoScan estimates both internal and external camera orientation
parameters, including nonlinear radial distortions. For the estimation to be successful it is crucial to apply
the estimation procedure separately to photos taken with different cameras. Once photos have been loaded
in the program, PhotoScan automatically divides them into calibration groups according to the image
resolution and/or EXIF metadata like cameratype and focal length. All the actions described below could
and should be applied (or not applied) to each calibration group individually.

Calibration groups can be rearranged manually.

To createanew calibration group

1. Select Camera Calibration... command from the Tools menu.

2. Inthe Camera Cdlibration dialog box, select photos to be arranged in a new group.
3. Intheright-click context menu choose Create Group command.

4. A new group will be created and depicted on the |left-hand part of the Camera Calibration dial og box.

To move photos from one group to another
1. Select Camera Calibration... command from the Tools menu.
2. Inthe Camera Cdlibration dialog box choose the source group on the left-hand part of the dialog.

3. Select photos to be moved and drag them to the target group on the left-hand part of the Camera
Calibration dialog box.

To place each photo into a separate group you can use Split Groups command available at the right button
click on acalibration group name in the | eft-hand part of the Camera Calibration dialog

Cameratypes

PhotoScan supports four major types of camera: frame camera, fisheye camera, spherical camera and
cylindrical camera. Cameratype can be set in Camera Calibration dialog box available from Tools menu.

Fr ame camera. If the source data within a calibration group was shot with aframe camera, for successful
estimation of camera orientation parameters the information on approximate focal length (pix) isrequired.
Obviously, to calculate focal length valuein pixel it is enough to know focal length in mm along with the
sensor pixel sizein mm. Normally this data is extracted automatically from the EXIF metadata.

Frame camera with Fi sheye lens. If extra wide lenses were used to get the source data, standard
PhotoScan camera model will not allow to estimate camera parameters successfully. Fisheye cameratype
setting will initialize implementation of a different cameramodel to fit ultra-wide lens distortions.

Spheri cal camera (equirectangular projection). In case the source data within a calibration group
was shot with a spherical camera, camera type setting will be enough for the program to calculate
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camera orientation parameters. No additional information is required except the image in equirectangular
representation.

Spherical cameraCyl i ndri cal projection. In case the source data within a calibration group is a set
of panoramic images stitched according to cylindrical model, camera type setting will be enough for the
program to calculate camera orientation parameters. No additiona information is required.

In case source images lack EXIF data or the EXIF data is insufficient to calculate focal length in pixels,
PhotoScan will assume that focal length equalsto 50 mm (35 mm film equivalent). However, if theinitial
guess values differ significantly from the actual focal length, it islikely to lead to failure of the alignment
process. So, if photosdo not contain EX1F metadata, it is preferableto specify focal length (mm) and sensor
pixel size (mm) manually. It can be done in Camera Calibration dialog box available from Tools menu.
Generally, this data is indicated in camera specification or can be received from some online source. To
indicate to the program that camera orientation parameters should be estimated based on the focal length
and pixel size information, it is necessary to set the Type parameter on the Initial tab to Auto value.

Scanned Photos

PhotoScan supports processing of analog aerial images scanned to digital files. On uploading, all the
scanned photos from the same analog camera should be placed in a designated calibration group.
PhotoScan will automatically put the photosin the same calibration group, providing that they have been
scanned to the images of the same resolution. In case scanned anal og photos from different cameras have
been uploaded to the same chunk, you should manually divide them into different calibration groups. It
could be done in Camera Calibration dialog available from Tools menu.

Cameracalibrationin case of scanned imagesis performed based on thefiducial marksinfromation. That is
why cameracalibration startswith fiducial marks detection in thisworkflow. PhotoScan enables automatic
detection of most of the fiducial mark types. See Figure below.

To calibrate scanned images with automatically detectable fiducial marks
1. Select Camera Calibration... command from the Tools menu.

2. Inthe Camera Calibration dialog box check Film camerawith fiducial marks option.

3. Close Camera Calibration dialog with OK button.

4. Run Detect Fiducials... command from the Tools -> Markers menu.

5. Inthe CameraCalibration dialog box print in coordinates of the automatically detected fiducial marks
on the image according to the analog camera certificate. They should be measured in coordinate
system associated with the sensor: origin - in the center of the sensor; axes X - to the right, axes Y
- downwards; in milimeters (mm).

6. Close Camera Calibration dialog with OK button and proceed to general PhotoScan processing
workflow starting from Align Photos... step. The software will automatically scale and orientate al
the photos according to the fiducial marks information.

In case your fiducial markstype is not among those supported for automatic detection (see Figure above),
please place a feature request with our support team: support@agisoft.com. The currect version of the
software allows to perform calibration of the scanned images based on such fiducial marks manually
following the procedure outlined below.

To calibrate scanned images with non-standard fiducial marks manually

1. Select Camera Calibration... command from the Tools menu.
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10.

[

In the Camera Calibration dialog box check Film camera with fiducial marks option.

On the Fiducialstab add fiducial mark instances, te number should be equal to the amount of fiducial
marks used on the original photos.

Print in coordinates of the fiducial marks on the image according to the analog camera certificate.
They should be measured in coordinate system associated with the sensor: origin - in the center of
the sensor; axes X - to theright, axes Y - downwards; in milimeters (mm).

Close Camera Calibration dialog with OK button.

Then it is necessary to place al the fiducials on each photo from the calibration group.

Open the photo in Photo View.

Zoom in to afiducial mark center.

Right button click on the targeted fiducial mark and use Place Fiducial command from the context
menu. Y ou will need to chose a corresponding fiducial mark instance from the dropdoan list.

After placing all the fiducial mark instances, you can proceed to general PhotoScan processing
workflow. The software will automatically scale and orientate all the photos according to the fiducial
marks information.

Note

« If there is no camera certificate with fiducial marks coordinates information for the data set in
guestion, then it will be necessary to additionally run Calibrate Fiducias... command from the
context menu of the selected images in the Camera Calibration dialog box. All the images from
the respective calibration group should be selected for the purpose.

* Itisrecommended to mask out all the margins with auxiliary information on scanned photos to
avoid negative effect on the stability of the further processing.

Camera calibration parameters

Once you have tried to run the estimation procedure and got poor results, you can improve them thanks
to the additional data on calibration parameters.

To specify camera calibration parameters

1

2.

Select Camera Calibration... command from the Tools menu.

Select calibration group, which needs reestimation of camera orientation parameters on the left side
of the Camera Calibration dialog box.

In the Camera Calibration dialog box, select | ni ti al tab.

Modify the calibration parameters displayed in the corresponding edit boxes.
Set the Type to the Precalibrated value.

Repeat to every calibration group where applicable.

Click OK button to set the calibration.
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4 Note

« Alternatively, initia calibration datacan beimported from file using L oad button on thelnitial tab
of the Camera Calibration dialog box. In addition to Agisoft calibration file format it is possible
to import datafrom Australis, PhotoModeler, 3DM CalibCam, CalCam.

Initial calibration data will be adjusted during the Align Photos processing step. Once Align Photos
processing step is finished adjusted calibration data will be displayed on the Adjusted tab of the Camera
Calibration dialog box.

If very precise calibration dataisavailable, to protect it from recal cul ation one should check Fix calibration
box. In this caseinitia calibration data will not be changed during Align Photos process.

Adjusted camera calibration data can be saved to file using Save button on the Adjusted tab of the Camera
Calibration dialog box.

Estimated camera distortions can be seen on the distortion plot available from context menu of a camera
group in the Camera Calibration dial og. In addition, residuals graph (the second tab of the same Distortion
Plot dialog) allows to evaluate how adequately the camera is described with the applied mathematical
model. Note that residuals are averaged per cell of an image and then across al the images in a camera
group. Scale reference under the plot indicates the scale of the distortions/residuals.

Calibration parameters list

f
Focal length measured in pixels.

CX, cy
Principal point coordinates, i.e. coordinatesof lensoptical axisinterceptionwith sensor planein pixels.

b1, b2
Affinity and Skew (non-orthogonality) transformation coefficients.

k1, k2, k3, k4
Radia distortion coefficients.

p1, p2, p3, p4
Tangential distortion coefficients.

Setting coordinate system

Many applications require data with a defined coordinate system. Setting the coordinate system also
provides a correct scaling of the model alowing for surface area and volume measurements and makes
model loading in geoviewers and geoinformation software much easier. Some PhotoScan functionality
like digital elevation model export is available only after the coordinate system is defined.

PhotoScan supports setting a coordinate system based on either ground control point (marker) coordinates
or camera coordinates. In both cases the coordinates are specified in the Reference pane and can be either
loaded from the external file or typed in manually.

Setting coordinate system based on recorded camera positions is often used in aerial photography
processing. However, it may be also useful for processing close-range data sets collected with GPS enabled
cameras. Placing markersisnot required if recorded cameracoordinatesare used to initialize the coordinate
system.
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In case ground control points are used to set up the coordinate system, markers should be placed in the
corresponding locations of the scene.

Using camera data for georeferencing is faster since manual marker placement is not required. On the
other hand, ground control point coordinates are usually more accurate than telemetry data, allowing for
more precise georeferencing.

Placing markers

PhotoScan uses markersto specify locations within the scene. Markers are used for setting up a coordinate
system, photo alignment optimization, measuring distances and volumes within the scene as well as for
marker based chunk alignment. Marker positions are defined by their projections on the source photos.
The more photos are used to specify marker position the higher is the accuracy of marker placement. To
define marker location within a scene, it should be placed on at least 2 photos.

4 Note

« Marker placement is not required for setting the coordinate system based on recorded camera
coordinates. This section can be safely skipped if the coordinate system is to be defined based
on recorded camera locations.

PhotoScan supports two approaches to marker placement: manual marker placement and guided marker
placement. Manual approach implies that the marker projections should be indicated manually on each
photo where the marker is visible. Manual marker placement does not require 3D model and can be
performed even before photo alignment.

In the guided approach marker projection is specified for a single photo only. PhotoScan automatically
projects the corresponding ray onto the model surface and calculates marker projections on the rest of
the photos where marker is visible. Marker projections defined automatically on individual photos can be
further refined manually. Reconstructed 3D model surfaceis required for the guided approach.

Guided marker placement usually speeds up the procedure of marker placement significantly and also
reduces the chance of incorrect marker placement. It is recommended in most cases unless there are any
specific reasons preventing this operation.

To place amarker using guided approach
1. Open aphoto where the marker is visible by double clicking on its name.

2 Switch to the marker editing mode using ”:t? Edit Markers toolbar button.

3. Right click on the photo at the point corresponding to the marker location.

4. Select Create Marker command from the context menu. New marker will be created and itsprojections
on the other photos will be automatically defined.

4 Note

« If the 3D model is not available or the ray at the selected point does not intersect with the model
surface, the marker projection will be defined on the current photo only.

* Guided marker placement can be performed in the same way from the 3D view by right clicking

on the corresponding point on the model surface and using ":B Create Marker command from the
context menu. While the accuracy of marker placement in the 3D view isusually much lower, it
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may be still useful for quickly locating the photos observing the specified location on the model.

To view the corresponding photos use % Filter by Markers command again from the 3D view
context menu. If the command isinactive, please make surethat the marker in question is selected
on the Reference pane.

To place amarker using manual approach

1 Create marker instance using “%Add marker button on the Workspace pane or by Add Marker

command from the Chunk context menu (available by right clicking on the chunk title on the
Workspace pane).

2. Openthephoto wherethe marker projection needsto be added by double clicking on the photos name.

Switch to the marker editing mode using ”Q? Edit Markers toolbar button.

4. Right click at the point on the photo where the marker projection needsto be placed. From the context
menu open Place Marker submenu and select the marker instance previously created. The marker
projection will be added to the current photo.

5. Repeat the previous step to place marker projections on other photosif needed.

To save up time on manual marker placement procedure PhotoScan offers guiding lines feature. When a
marker is placed on an aligned photo, PhotoScan highlights lines, which the marker is expected to lie on,
on the rest of the aligned photos.

[ Note

e If a marker has been placed on at least two aligned images PhotoScan will find the marker

projections on the rest of the photos. The calculated marker positions will be indicated with }
icon on the corresponding aligned photos in Photo View mode.

Automatically defined marker locations can be later refined manually by dragging their projections on the
corresponding photos.

Torefine marker location

1. Open the photo where the marker is visible by double clicking on the photo's name. Automatically

placed marker will be indicated with [Fhi con.

Switch to the marker editing mode using ”Q? Edit Markers toolbar button.

3.  Movethe marker projection to the desired location by dragging it using left mouse button. Once the

marker location is refined by user, the marker icon will changeto ”‘—‘D

[{ Note

e To list photos where the marker locations are defined, select the corresponding marker on the
Workspace pane. The photos where the marker is placed will be marked with a":t? icon on the

Photos pane. To filter photos by marker use "ﬁ Filter by Markers command from the 3D view
context menu.
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In those cases when there are hesitations about the features depi cted on the photo, comparative inspection
of two photos can prove to be useful. To open two photos in PhotoScan window simultaneously Move to
Other Tab Group command is available from photo tab header context menu.

To open two photos simultaneously

1. Inthe Photos pane double click on one photo to be opened. The photo will be opened in a new tab
of the main program window.

2. Right click on the tab header and choose Move to Other Tab Group command from the context menu.
The main program window will be divided into two parts and the photo will be moved to the second
part.

3. The next photo you will choose to be opened with a double click will be visualized in the active tab
group.

PhotoScan automatically assignsdefault |abelsfor each newly created marker. Theselabel s can be changed
using the Rename... command from the marker context menu in the Workspace / Reference pane.

Assigning reference coordinates

To reference the model, real world coordinates of at least 3 points of the scene should be specified.
Depending on the requirements, the model can be referenced using marker coordinates, camera
coordinates, or both. Real world coordinates used for referencing the model aong with the type of
coordinate system used are specified using the Reference pane.

Themodel can belocated in either local Euclidean coordinates or in georeferenced coordinates. PhotoScan
supports a wide range of various geographic and projected coordinate systems, including widely used
WGS84 coordinate system. Besides, almost all coordinate systems from the EPSG registry are supported
aswell.

Reference coordinates can be specified in one of the following ways:
» Loaded from a separate text file (using character separated values format).
» Entered manually in the Reference pane.

» Loaded from GPS EXIF tags (if present).

Toload reference coordinates from atext file

1 Click = Import toolbar button on the Reference pane. (To open Reference pane use Reference

command from the View menu.) Browse to the file containing recorded reference coordinates and
click Open button.

2. Inthe Import CSV dialog set the coordinate system if the data presents geographical coordinates.
3. Select the delimiter and indicate the number of the data column for each coordinate.

4. Indicate columns for the orientation dataif present. Make sure that the proper angle triple (according
to the source data) is set: [yaw,pitch,roll] or [omega, phi, kappa].

5. Click OK bhutton. The reference coordinates data will be loaded onto the Reference pane.

4 Note

« Inthe datafile columns and rows are numbered starting from O.
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« If reference coordinates of amarker / camera position for aphoto are not specified in the loading
file the current value will be kept for them.

* An example of acoordinates datafile in the CSV format is given in the next section.

Information on the accuracy of the source coordinates (X, y, z) aswell as of the source orientation angles
can beloaded withaCSV fileaswell. Check Load Accuracy option and indicate the number of the column
where the accuracy for the data should be read from. It is possible to indicate the same accuracy column
for all three coordinates/angles.

To assign reference coordinates manually

1 Switch to the View Source mode using E View Source button from the Reference pane toolbar. (To

open Reference pane use Reference command from the View menu.)

2. Onthe Reference pane select x/y/z or angle data cells and press F2 button on the keyboard to assign
values to corresponding coordinates/angles.

3. Repeat for every marker/camera position (orientation angle) needed to be specified.

4. Toremove unnecessary reference coordinates select corresponding items from the list and press Del
key.

Click '_“JIIE Update toolbar button to apply changes and set coordinates.

The format of the orientation data ([yaw,pitch,roll] or [omega, phi, kappa]) can be switched in the
Reference Settings dialog. Do not forget to click OK button in the Reference Settings dialog to apply the
changes.

Additionally, it is possible to indicate accuracy data for the coordinates / orientation angles. Select Set
Accuracy... command from the context menu of an image on the Reference pane and input accuracy data
both for position (i.e. x,y,z coordinates) and orientation (i.e. [yaw,pitch,roll] or [omega, phi, kappa] angles)
data. It is possible to select several cameras and apply Set Accuracy... command simultaneously to all of
them. Alternatively, you can select Accuracy (m) or Accuracy (deg) text box for a certain camera on the
Reference pane and press F2 button on the keyboard to type the text data directly onto the Reference pane.
Note that "/" delimiter allows to enter different accuracy datafor x, y, z or yaw, pitch, roll (omega, phi,
kappa) data respectively.

Toload reference coordinates from GPS EXIF tags

Click E Import EXIF button on the Reference pane. (To open Reference pane use Reference
command from the View menu.) The reference coordinates data will be loaded into the Reference
pane.

If the corresponding options on the Advanced tab of Preferenceswindow are checked on, it isalso possible
to load camera orientation angles and location/rotation accuracy parameters from XMP extension of the

image header. The datawill be loaded on clicking E Import EXIF button.

After reference coordinates have been assigned PhotoScan automatically estimates coordinatesin alocal
Euclidean system and cal cul ates the referencing errors. To see the results switch to the View Estimated or

View Errors modes respectively using @ View Estimated and D View Errorstoolbar buttons.
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Setting georeferenced coordinate system

To set a geor eferenced coor dinate system

1.

2.

Assign reference coordinates using one of the options described above.

Click &% Setti ngs button on the Reference pane toolbar.

In the Reference Settings dialog box select the Coordinate System used to compile reference
coordinates dataif it has not been set at the previous step.

Specify the assumed measurement accuracy on the left-hand side part of the dialog.

If the information about GPS system shift with respect to the camera itself is available, it worth
inputting it on GPS/INS Offset tab of Camera Calibration dialog available from tools menu. See
Figure below.

Click OK button to initialize the coordinate system and estimate geographic coordinates.

Z cam

GPS
/' §

@

Ycam
Dol

Z offset

Yoffset

=/

» X cam

X offset

GPS offset.

Rotation angles for the camera coordinates in PhotoScan are defined around the following axes. yaw axis
runs from top to bottom, pitch axis runs from left to right wing of the drone, roll axis runs from tail to nose
of the drone. Zero values of the rotation angle triple define the following camera position aboard: camera
looks down to the ground, frames are taken in landscape orientation, and horizontal axis of the frame is
perpendicular to the central (tail-nose) axis of the drone. If the camera is fixed in a different position,
respective yaw, pitch, roll values should be input on GPS/INS Offset tab of Camera Calibration dialog.
The signs of the angles are defined according to the right-hand rule. See Figure below.
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INS offset.

4 Note

e Step 5 can be safely skipped if you are using standard GPS system (not that of superhigh
precision).

In Select Coordinate System dialog it is possible to ease searching for the required georeferencing system
using Filter option. Enter respective EPSG code (e.g. EPSG::4302) to filter the systems.

Using different vertical datums

On default PhotoScan requires all the source altitude values for both cameras and markers to be input as
values mesuared abovethe ellipsoid. However, PhotoScan allowsfor the different geoid model s utilization
as well. PhotoScan installation package includes only EGM 96 geoid model, but additional geoid models
can be downloaded from Agisoft's website if they are required by the coordinate system selected in the
Reference pane settings dialog. Downloaded geoid model from the supported list should be copied to
\ geoi ds\ folder in PhotoScan installation directory before using the corresponding coordinate system
from GUI.

Please refer to the following web-page to review the list of supported geoid models: http://
www.agi soft.com/downloads/geoids/.

Reference pane: some features more

To view the estimated geographic coordinates and reference errors switch between the View Estimated

and View Errors modes respectively using @ View Estimated and L_l_ View Errors toolbar buttons. A
click on the column name on the Reference pane sorts the markers and cameras by the datain the column.
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At this point you can review the errors and decide whether additional refinement of marker locationsis
required (in case of marker based referencing), or if certain reference points should be excluded.

To save the errors and/or estimated coordinates use I Export toolbar button on the Reference pane.

To reset a chunk georeferencing, use Reset Transform command from the chunk context menu on the
Workspace pane. [R] indicator of achunk being georeferenced will be removed from the chunk name.

4 Note

e Unchecked reference points on the Reference pane are not used for georeferencing and
optimization. Use context menu to check/uncheck selected items.

« After adjusting marker locations on the photos, the coordinate system will not be updated

automatically. It should be updated manually using '_“:rﬂ Update toolbar button on the Reference
pane.

« PhotoScan allows to convert the estimated geographic coordinates into a different coordinate
system. To calculate the coordinates of the camera positions and/or markers in a different

coordinate system use =il Convert toolbar button on the Reference pane.

Example of a reference coordinates file in CSV format
(*.txt)

Thereference coordinates can be loaded onto the Reference pane using character separated text fileformat.
Each reference point isspecifiedin thisfile on aseparateline. Samplereference coordinatesfileisprovided
bel ow:

# <l abel > <l ongi tude> <l atitude> <altitude>
| MG_0159. JPG 40. 165011 48. 103654 433. 549477
| MG_0160. JPG 40. 165551 48. 103654 434. 724281
| MG _0161. JPG 40. 166096 48. 103640 435. 630558

Individual entries on each line should be separated with at ab (space, seni col on, comma, e€tc)
character. All lines starting with # character are treated as comments.

Records from the coordinate file are matched to the corresponding cameras or markers basing on the
| abel field. Camera coordinates labels should match the file name of the corresponding photo including
extension. Marker coordinates |abels should match the labels of the corresponding markersin the project
file. All labels are case insensitive.

4 Note

» Character separated reference coordinates format does not include specification of the type of
coordinate system used. The kind of coordinate system used should be selected separately in the
Reference Settings dialog.

« PhotoScan requires z value to indicate height above the ellipsoid.
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Optimization

Optimization of camera alignment

PhotoScan estimates internal and external camera orientation parameters during photo alignment. This
estimation is performed using image data alone, and there may be some errorsin the final estimates. The
accuracy of the final estimates depends on many factors, like overlap between the neighboring photos, as
well as on the shape of the object surface. These errors can lead to non-linear deformations of the final
model.

During georeferencing the model is linearly transformed using 7 parameter similarity transformation (3
parameters for trandation, 3 for rotation and 1 for scaling). Such transformation can compensate only a
linear model misalignment. The non-linear component can not be removed with this approach. This is
usually the main reason for georeferencing errors.

Possible non-linear deformations of the model can be removed by optimizing the estimated point cloud
and camera parameters based on the known reference coordinates. During this optimization PhotoScan
adjusts estimated point coordinates and camera parameters minimizing the sum of reprojection error and
reference coordinate misalignment error.

To achieve greater optimizing results it may be useful to edit sparse point cloud deleting obviously
mislocated points beforehand. To read about point cloud editing refer to the Editing point cloud section
of the manual.

Georeferencing accuracy can be improved significantly after optimization. It is recommended to perform
optimization if the final model isto be used for any kind of measurements.

To optimize camer a alignment
1.  Setthe marker and/or camera coordinates to be used for optimization (if not done yet).

2 Click &% Setti ngstoolbar button on the Reference pane and set the coordinate system (if not doneyet).

3. Inthe Reference pane Settings dialog box specify the assumed accuracy of measured values as well
as the assumed accuracy of marker projections on the source photos.

4. Click OK button.

5. Indicate relative GPS device and/or INS to camera coordinates (if info is available) on GPS/INS tab
of Camera Calibration dialog available from Tools menu.

6. Check Fix GPS/INS offset box.
7. Click OK button.

Click # Optimize toolbar button. In Optimize Camera Alignment dialog box check additional
camera parameters to be optimized if needed. Click OK button to start optimization.

9. After the optimization is complete, the georeferencing errors will be updated.

[{ Note

» Step 5 can be safely skipped if you are using standard GPS (not that of extremely high precision).

« Tangentia distortion parameters p3, p4, are available for optimization only if pl, p2 values are
not equal to zero after alignment step.
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« The model data (if any) is cleared by the optimization procedure. You will have to rebuild the
model geometry after optimization.

Image coordinates accuracy for markers indicates how precisely the markers were placed by the user or
adjusted by the user after being automatically placed by the program.

Ground altitude parameter is used to make reference preselection mode of alignment procedure work
effectively for oblique imagery. See Aligning photos for details.

Camera, marker and scale bar accuracy can be set per item (i.d. per camera/marker/scale bar) using
Accuracy column on the Reference pane. Accuracy values can be typed in on the pane per item or for a
group of selected items. Alternatively accuracy values can be uploaded along with camera/marker data
as atext file (see Assigning reference coordinates subsection of Setting coordinate system). Additionally,
different accuraciesper coordinate can beindicated using /" asaseparator between valuesin the Accuracy
column.

GPS/INS offset values input by the user can also be adjusted by PhotoScan with respect to measurement
accuracy that may beindicated on the GPS/INS tab of Camera Calibration dialog. Uncheck Fix GPS/INS
offset box to allow for adjustment procedure.

Generally it isreasonableto run optimization procedure based on markersdataonly. It isdueto thefact that
GCPs coordinates are measured with significantly higher accuracy compared to GPS data that indicates
camera positions. Thus, markers data are sure to give more precise optimization results. Moreover, quite
often GCP and camera coordinates are measured in different coordinate systems, that also prevents from
using both cameras and markers data in optimization simultaneously.

The results of the optimization procedure can be evaluated with the help of error information on the
Reference pane. In addition, distortion plot can be inspected along with mean residuals visualised per
calibration group. Thisdatais available from Camera Calibration dialog (Tools menu), from context menu
of a camera group - Distortion Plot... command. Note that residuals are averaged per cell of an image
and then across all the images in a camera group. Scale reference under the plot indicates the scale of the
distortiong/residuals.

In case optimization results does not seem to be satisfactory, you can try recalculating with lower values
of accuracy parameters, i.e. assuming ground control measurements to be more accurate.

Scale bar based optimization

Scale bar is program representation of any known distance within the scene. It can be a standard ruler or
a specialy prepared bar of a known length. Scale bar is a handy tool to add supportive reference data to
your project. They can prove to be useful when thereis no way to locate ground control pointsall over the
scene. Scale bars allow to save field work time, since it is significantly easier to place several scale bars
with precisely known length, than to measure coordinates of a few markers using special equipment. In
addition, PhotoScan allows to place scale bar instances between cameras, thus making it possible to avoid
not only marker but ruler placement within the scene aswell. Surely, scale bar based information will not
be enough to set a coordinate system, however, the information can be successfully used while optimizing
the results of photo alignment. It will also be enough to perform measurements in PhotoScan software.
See Performing measurements on 3D model.

To add a scale bar between markers

1. Placemarkersat the start and end points of the bar. For information on marker placement please refer
to the Setting coordinate system section of the manual.

2. Select both markers on the Reference pane using Ctrl button.
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Select B Create Scale Bar command form the Model view context menu. The scale bar will be
created and an instant added to the Scale Bar list on the Reference pane.

Switch to the E View Source mode using the Reference pane toolbar button.

Double click on the Distance (m) box next to the newly created scale bar name and enter the known
length of the bar in meters.

To add a scale bar between camer as

1

Select the two cameras on the Workspace or Reference pane using Ctrl button. Alternatively, the
cameras can be selected in the Model view window using selecting tools from the Toolbar.

Select E& Create Scale Bar command form the context menu. The scale bar will be created and an
instant added to the Scale Bar list on the Reference pane.

Switch to the E View Source mode using the Reference pane toolbar button.

Double click on the Distance (m) box next to the newly created scale bar name and enter the known
length of the bar in meters.

Torun scale bar based optimization

1.

2.

On the Reference pane check all scale bars to be used in optimization procedure.

Click &% Setti ngs toolbar button on the Reference pane. In the Reference pane Settings dialog box
specify the assumed accuracy of scale bars measurements.

Click OK button.

Click & Optimize toolbar button. In Optimize Camera Alignment dialog box check additional
camera parameters to be optimized if needed. Click OK button to start optimization.

After the optimization is complete, cameras and markers estimated coordinates will be updated as well as
all the georeferencing errors. To analyze optimization results switch to the View Estimated mode using
the Reference pane toolbar button. In scale bar section of the Reference pane estimated scale bar distance
will be displayed.

To delete a scale bar

1

2.

3.

Select the scale bar to be deleted on the Reference pane.
Right-click on it and chose Remove Scale Bars command from the context menu.

Click OK for the selected scale bar to be deleted.

What do the errors in the Reference pane mean?

Camer as section

1

2.

Error (m) - distance between the input (source) and estimated positions of the camera.

Error (deg) - root mean square error calculated over al three orientation angles.
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3. Error (pix) - root mean square reprojection error calculated over al feature points detected on the
photo.

Reprojection error is the distance between the point on the image where a reconstructed 3D point can be
projected and the origina projection of that 3D point detected on the photo and used as a basis for the
3D point reconstruction procedure.

Markers section
1.  Error (M) - distance between the input (source) and estimated positions of the marker.

2. Error (pix) - root mean sgquare reprojection error for the marker calculated over al photos where
marker isvisible.

Scale Bar s section

e Error (m) - difference between the input (source) scale bar length and the measured distance between
two cameras or markers representing start and end points of the scale bar.

If the total reprojection error for some marker seems to be too large, it is recommended to inspect
reprojection errors for the marker on individual photos. The information is available with Show Info
command from the marker context menu on the Reference pane.

Working with coded and non-coded targets

Overview

Coded and non-coded targets are specially prepared, yet quite ssimple, real world markers that can add up
to successful 3D model reconstruction of a scene. The difference between coded and non-coded targets
is that while a non-coded target |ooks like an ordinary full circle or afigure (circle / rectangular) with 4
segments, the coded target has aring parted in black and white segments around the central full circle.

Coded targets advantages and limitations

Coded targets (CTs) can be used as markersto define local coordinate system and scale of the model or as
true matchesto improve photo alignment procedure. PhotoScan functionality includes automatic detection
and matching of CTson source photos, which allowsto benefit from marker implementation in the project
while saving time on manual marker placement. Moreover, automatic CTsdetection and marker placement
is more precise then manual marker placement.

PhotoScan supports four types of circle CTs: 12 bit, 14 bit, 16 bit and 20 bit. While 12 bit pattern is
considered to be decoded more precisely, whereas 14 bit, 16 bit and 20 bit patterns allow for a greater
number of CTsto be used within the same project.

To be detected successfully CTs must take up a significant number of pixels on the original photos. This
leadsto anatural limitation of CTsimplementation: while they generally proveto be useful in close-range
imagery projects, aerial photography projects will demand too huge CTs to be placed on the ground, for
the CTsto be detected correctly.

Coded targets in workflow

Sets of all patterns of CTs supported by PhotoScan can be generated by the program itself.
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Tocreatea printable PDF with coded tar gets

1. Select Print Markers... command from the Tools menu.

2. Specify the CTstype and desired print parameters in Print Markers dial og.
3. Click OK.

Once generated, the pattern set can be printed and the CT's can be placed over the scene to be shot and
reconstructed.

When the images with CTs seen on them are uploaded to the program, PhotoScan can detect and match
the CTs automatically.

To detect coded targets on sour ce images

1. Select Detect Markers... command from the Tools menu.

2. Specify parameters of detector in Detect Markers dialog according to the CTstype.

3. Click OK.

PhotoScan will detect and match CTs and add corresponding markers to the Reference pane.

CTs generated with PhotoScan software contain even number of sectors. However, previous versions of
PhotoScan software had no restriction of the kind. Thus, if the project to be processed contains CTs from
previousversions of PhotoScan software, it isrequired to disable parity check in order to make the detector
work.

Non-coded targets implementation

Non-coded targets can a so be automatically detected by PhotoScan (see Detect Markersdialog) . However,
for non-coded targets to be matched automatically, it is necessary to run align photos procedure first.

Non-coded targets are more appropriate for aerial surveying projects due to the simplicity of the pattern
to be printed on a large scale. But, looking alike, they does not allow for automatic identification, so
manual assignment of an identifier is required if some referencing coordinates are to be imported from
afile correctly.
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Performing measurements on 3D model

PhotoScan supports measuring of distances on the model, as well as of surface area and volume of the
reconstructed 3D model. All the instructions of this section are applicable for working in the Model view
of the program window, both for analysis of Dense Point Cloud or of Mesh data. When working in the
model view, all measurements are performed in 3D space, unlike measurementsin Ortho view, which are
planar ones.

Distance measurement

PhotoScan enables measurements of distances between the points of the reconstructed 3D scene.
Obviously, model coordinate system must be initialized before the distance measurements can be
performed. Alternatively, the model can be scaled based on known distance (scale bar) information to
become suitable for measurements. For instructions on setting coordinate system pleaserefer to the Setting
coordinate system section of the manual. Scale bar concept is described in the Optimization section.

To measure distance

L Select 4 Ruler instrument from the Toolbar of the Model view.

2. Click on the point of the model where the measurement should be started from.

3. Upon the second click on the model the distance between the indicated points will be shown right
in the Model view.

4. Thedistance can be measured along the polyline drawn with the Ruler.

5.  To complete the measurement and to proceed to a new one, please press Escape button on the
keyboard. The result of the measurement will be shown on the Console pane

Shape drawing is enabled in Model view as well. See Shapes section of the manual for information on
shape drawing. Measure command available from the context menu of a selected shape allowsto learn the
coordinates of the vertices as well as the perimeter of the shape.

To measure several distances between pairs of points and automatically keep the resulting data, markers
can be used.

To measur e distance between two markers

1. Placethe markersin the scene at the targeted locations. For information on marker placement please
refer to the Setting coordinate system section of the manual.

2. Select both markersto be used for distance measurements on the Reference pane using Ctrl button.

Select E& Create Scale Bar command form the 3D view context menu. The scale bar will be created
and an instant added to the Scale Bar list on the Reference pane.

Switch to the estimated values mode using @ View Estimated button from the Reference pane
toolbar.

5. The estimated distance for the newly created scale bar equals to the distance that should have been
measured.
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To measur e distance between camer as

1. Select the two cameras on the Workspace or Reference pane using Ctrl button. Alternatively, the
cameras can be selected in the Model view window using selecting tools from the Toolbar.

Select E& Create Scale Bar command form the context menu. The scale bar will be created and an
instant added to the Scale Bar list on the Reference pane.

Switch to the estimated values mode using @ View Estimated button from the Reference pane
toolbar.

4. The estimated distance for the newly created scale bar equals to the distance that should have been

measured.
"  Note
* Please note that the scale bar used for distance measurements must be unchecked on the
Reference pane.
Note

» The distance values measured by PhotoScan are displayed in meters.

Surface area and volume measurement

Surface area or volume measurements of the reconstructed 3D model can be performed only after the scale
or coordinate system of the scene is defined. For instructions on setting coordinate system please refer to
the Setting coordinate system section of the manual.

To measure surface area and volume
1. Select Measure Areaand Volume... command from the Tools menu.

2. Thewhole model surface areaand volume will be displayed in the Measure Areaand Volume dialog
box. Surface areais measured in square meters, while mesh volume is measured in cubic meters.

V olume measurement can be performed only for the models with closed geometry. If there are any holes
in the model surface PhotoScan will report zero volume. Existing holes in the mesh surface can be filled
in before performing volume measurements using Close Holes... command from the Tools menu.

Performing measurements on DEM

PhotoScan is capable of DEM-based point, distance, area, and volume measurements as well as of
generating cross-sections for a part of the scene selected by the user. Additionally, contour lines can be
calculated for the model and depicted either over DEM or Orthomosaic in Ortho view within PhotoScan
environment. Measurements on the DEM are controlled with shapes: points, polylines and polygons. For
information about how to create and work with shapes please refer to Shapes section of the manual.

Point measurement

Ortho view allows to measure coordinates of any point on the reconstructed model. X and Y coordinates
of the point indicated with the cursor as well as height of the point above the vertical datum selected by
the user are shown in the bottom right corner of the Ortho view.
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Distance measurement

To measuredistance with a Ruler

1.

Select & Ruler instrument from the Toolbar of the Ortho view.
Click on the point of the DEM where the measurement should be started from.

Upon the second click on the DEM the distance between the indicated points will be shown right
in the Ortho view.

The distance can be measured along the polyline drawn with the Ruler.

To complete the measurement and to proceed to a new one, please press Escape button on the
keyboard. The result of the measurement will be shown on the Console pane

To measur e distance with shapes

1

Connect the points of interest with a polyline using A Draw Polyline tool from the Ortho view
toolbar.

Double click on the last point to indicate the end of a polyline.
Right button click on the polyline and select Measure... command from the context menu.

In the Measure Shape dialog inspect the results. Perimeter value egquals to the distance that should
have been measured.

In addition to polyline length value (see perimeter value in the Measure Shape), coordinates of the vertices
of the polyline are shown on the Planar tab of the Measure Shape dialog.

£ Note

< Measure option is available from the context menu of a selected polyline. To select a polyline,
double-click onit. A selected polylineis coloured in red.

Area and volume measurement

To measure area and volume

1.

=

Draw apolygon on the DEM using _/Draw Polygon instrument to indicate the area to be measured.
Right button click on the polygon and select Measure... command from the context menu.

In the Measure Shape dialog inspect the results: see area value on the Planar tab and volume values
on the Volume tab.

PhotoScan allows to measure volume above best fit / mean level / custom level planes. Best fit and mean
level planes are calculated based on the drawn polygon vertices. Volume measured against custom level
plane allows to trace volume changes for the same areain the course of time.

4 Note

» Measure option is available from the context menu of a selected polygon. To select a polygon,
double-click onit. A selected polygon is coloured in red.
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Cross sections and contour lines

PhotoScan enables to calculate cross sections, using shapes to indicate the plane(s) for a cut(s), the cut
being made with aplane parallel to Z axis. For apolyline/polygon the program will calculate profilesalong
all the edges starting from the first drawn side.

To calculate cross section

1. . . AL . il
Indicate aline to make a cut of the model using” * Draw Polyline/'—' Draw Polygon tool from the
Ortho view toolbar.

2. Double click on the last point to indicate the end of a polyline.

3. Right button click on the polyline/polygon and select Measure... command from the context menu.

4. Inthe Measure Shape dialog inspect the results on the Profile tab of the dialog.

Generate Contours...command is available either from DEM label context menu on the Workspace pane
or from the Tools menu.

To gener ate contour s
1. Select Generate Contours...command from Tools menu.
2. Inthe Generate Contours dialog select DEM as the source data for calculation.

3.  Setvauesfor Minimal altitude, Maximal altitude parameters as well as the Interval for the contours.
All the values should be indicated in meters.

4, Click OK button once done.

5. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

6. When the procedure is finished, a shape layer with "contours' label will be added to the project file
structure shown on the Workspace pane.

Contour lines can be exported using Export Contours command from the contour lineslabel context menu
on the Workspace pane. Alternatively the command is available from the File menu. In the Export Contour
Linesdialog it is necessary to select the type of the contour linesto be exported. A .SHP file can store the
lines of the same type only: either polygons or polylines.

Vegetation indices calculation

Multispectral cameras

PhotoScan enables to calculate NDVI and other vegetation indices based on the multispectral imagery
input. Vegetation index formula can be set by the user, thus allowing for great flexibility in dataanalysis.
Calculated data can be exported asagrid of floating point index values calculated per pixel of orthomosaic
or as an orthomosaic in pseudocolours according to a palette set by the user. In case severa indices
are calculated for the same orthomosaic, the results can be exported as a multichannel orthomosaic,
one channel per index. Furthermore, values of 3 different vegetation indices can be mixed to represent
combined results as afalse colour "RGB" image.
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To calculate a vegetation index

1

2.

10.

11.

12.

Open orthomosaic in the Ortho tab double-clicking on the orthomosaic label on the Workspace pane.

Open Raster Calculator tool using % Raster Calculator button from the Ortho view toolbar.

On the left-hand side of the Transform tab of the Raster Calculator dialog all the bands of the input
imagesarelisted. Set avegetation index expression on the Output Bands side of thetab using keyboard
input and operator buttons of the raster calculator if necessary. If the expression isvalid, the line will

be marked with % sign.

Y ou can set several vegetation index expressionsto be calculated. Use '»:' X buttons to add/del ete
linesin thelist of output bands.

Click OK hutton to have the index(ces) calculated. The result - orthomosaic with vegetation
index(ces) information, each index being stored in a separate channel, can be exported with Export
orthomosaic command from the File menu. For guidance on the export procedure, please refer to
NDVI data export section of the manual.

Alternatively to Step 5, if you would like to have the index visualised in Ortho view of PhotoScan
window for inspection, follow Steps 6-12. Check Enable transform box and switch to the Palette tab
of the Raster Calculator dialog.

Select output band in 'Use band' field on the Pal ette tab.

Click 'TIDU pdate button to have the histogram of the index values shown on the left-hand side of the
Palette tab.

Select the range of meaningful index values either manually on the histogram or apply automatically
calculated range with the Auto button at the bottom of the tab.

Select palette preset from the drop-down list on the right-hand side of the Palette tab.

Click Apply button. Once the operation is completed - all the vegetation indeces are calculated, the
index values stored in the selected output band (indices calculated according to the selected output
band expression set on the Transform tab of the Raster Calculator) will be shown in the Ortho view,
index values being visualised with pseudocol ours according to the pal ette set in the Raster Cal cul ator
dialog.

Y ou can either continue your work in Raster Calculator or click OK button to close the dialog.

Pal ette defines the color for each index value to be shown with. PhotoScan offers several standard palette
presets on the Palette tab of the Raster Calculator dialog. A preset (Heat, NDV1, Gray scal€) can be chosen
from the drop-down list on the Palette tab of the Raster Calculator dialog. Alternatively, the user can

upload the palette from a Surfer Color Spectrum (*.clr) file (= 'Import Palette), preliminary prepared in
an external tool.

The palette can al so be edited within PhotoScan environment using l:)Add Color and @ Remove Color
buttons on the Palette tab of the Raster Calculator dialog. For each new line added to the palette a certain
index value should be typed in. Double click on the newly added line to type the value in. A customized

palette can be saved for future projects using mExport Palette button on the Palette tab of the Raster
Calculator dialog.
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The range of meaningful index values can be manually adjusted on the left-hand side of the Palette tab or
set automatically with the Auto button at the bottom of the tab. Interpolate colors option can be checked
to introduce intermediate colors to the output image.

False color value on the drop-down list of the palette presets alows to visualise combined results of
particular 3 vegetation indices tackled as false RGB colors.

4 Note

« If you change the index expression for selected output band on the Transform tab, do not forget
to adjust Palette settings for visualisation purposes. click Update button on the Palette tab to
have the histogram of the index values updated, set the range of the meaningful values, chose
the proper color palette.

« If you would like to inspect values of a different vegetation index, not the one already shown,
you need to set the corresponding formula in the selected band of the Output Band list on the
Transform tab of the Raster Calculator dialog.

* If you would like to see original multispectral orthomosaic, with no index calculation applied,
uncheck Enable transform option on the Transform tab of the Raster Calculator dialog and
click Apply/OK button. If the input images have three channels marked as R, G, B, then the
orthomosaic will be visualised as an RGB image (or false RGB). Otherwise, the spectral data
from the first channel will be visualised in gray scale.

Modified visible range cameras

Modified visible range cameras provide data in the form of three channel imagery, but those channels
do not contain standard R, G, B spectrum range information due to some physical manipulation done on
the sensor. For example, a Colored Infrared (CIR) cameraby MAVinci records Red+NIR datain the first
channel, Green+NIR datain the second channel, and NIR datain the third one.

Modified visible range cameras are used for vegetation monitoring along with multispectral cameras. To
cal culate vegetation indeces with PhotoScan the data captured with amodified camerashould be calibrated
first. This means we need to get pure R, G, NIR values to apply vegetation index formulae. To perform
the calibration, one needs calibration matrix data. In this context, a calibration matrix is amatrix of linear
transformation of source light intensity values in each channel into absolute values of intensity.

In case of CIR cameraby MAVinci, calibration matrix can be calculated based on the histograms for the
following relations. NIR/R, NIR/G. Calibration matrix spectrum values will be equal to the values of the
cut offs (kr, kg) of the corresponding histograms: C = {(kg, 0O, -1), (0, kg, -1), (0, 0, 1)}. Then the vector of
the absolute intensity values for R, G, NIR spectrum bands, scaled according to NIR intensity value, can
be calculated as X1=C* X, where C [3x3]- CIR calibration matrix, Xq [3x1]- vector of the source values
of the intensity for each band.

PhotoScan offers dialog to manually input values of the calibration matrix - see Color Matrix section of
the CIR Calibration tab in the Raster Calculator dialog. (Thetab is available for 3 bands imagery only. If
the project deals with multispectral imagery, thereis no need to calibrate the data.) One can either printin
the values, or select the values with sliders on the histograms. For a CIR cameraby MAVinci, calibration
matrix values can be set automatically with the Auto button.

Once the calibration matrix values are set, click Apply button for PhotoScan to perform the calibration.
After that you can proceed to Transform and Palette tabs of the Raster Calculator to calcul ate vegetation
indices as described in the section above. PhotoScan will use calibrated values as Input Bands on the
Transform tab.
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Index based contour lines

PhotoScan enables to cal culate contour lines based on the calculated index values.

To calculate contour lines based on vegetation index data

1

Select Generate Contours... command from the orthomosaic icon context menu on the Workspace
pane, while index data is shown in the Ortho view.

Select Orthomosaic as the source for the contours calculation.
Adjust the min/max value and the interval parameters for the task.
Press OK button to calculate index values.

The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

When the procedure is finished, a shape layer with "contours" label will be added to the project file
structure shown on the Workspace pane. The contour lines will be shown over the index data on the
Ortho tab.
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Using masks

Overview

5|

Masks are used in PhotoScan to specify the areas on the photos which can otherwise be confusing to
the program or lead to incorrect reconstruction results. Masks can be applied at the following stages of
processing:

Matching of the images
Building depth maps

Building mesh model using visibility consistent mesh generation method with strict volumetric masks
option applied

Building 3D model texture
Building Tiled Model

Building Orthomosaic

Alignment of the photos

Masked areas can be excluded during feature point detection. Thus, the objects on the masked parts
of the photos are not taken into account while estimating camera positions. This is important in the
setups, where the object of interest is not static with respect to the scene, like when using aturn table
to capture the photos.

Masking may be also useful when the object of interest occupies only a small part of the photo. In
this case a small number of useful matches can be filtered out mistakenly as a noise among a much
greater number of matches between background objects.

Building dense point cloud

While building dense point cloud, masked areas are not used in the depth maps computation process.
Masking can be used to reduce the resulting dense cloud complexity, by eliminating the areas on the
photos that are not of interest.

Masked areas are always excluded from processing during dense point cloud and texture generation
stages, including Tiled Model generation process.

Let'stake for instance a set of photos of some object. Along with an object itself on each photo some
background areas are present. These areas may be useful for more precise camera positioning, so it
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is better to use them while aligning the photos. However, impact of these areas at the building dense
point cloud is exactly opposite: the resulting model will contain object of interest and its background.
Background geometry will "consume" some part of mesh polygons that could be otherwise used for
modeling the main object.

Setting the masks for such background areas allows to avoid this problem and increases the precision
and quality of geometry reconstruction.

Building texture atlas
During texture atlas generation (for single mesh model and tiled model), masked areas on the photos
are not used for texturing. Masking areas on the photosthat are occluded by outliers or obstacles helps
to prevent the "ghosting" effect on the resulting texture atlas.

Loading masks

Masks can be loaded from external sources, as well as generated automatically from background images
if such datais available. PhotoScan supports loading masks from the following sources:

» From aphachannel of the source photos.
» From separate images.
» Generated from background photos based on background differencing technique.

» Based on reconstructed 3D model.

Toimport masks
1. Select Import Masks... command from the File menu.
2. Inthe Import Mask dialog select suitable parameters. Click OK button when done.

3. When generating masks from separate or background images, the folder selection dialog will appear.
Browse to the folder containing corresponding images and select it.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

The following parameters can be specified during mask import:

Method
Specifies the source of the mask data.

From Al pha - load masks from alpha channel of the source photos.
From Fi | e - load masks from separate images.

Fr om Backgr ound - generate masks from background photos.
From Model - generate masks based on reconstructed model.

Operation
Specifies the action to be done in case a second mask isimported for the photo.

Repl acenent - new mask will be loaded and stored instead of the original one.

Uni on - two masks will be united and stored.
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I nt er sect i on - theintersection of the two masks will be stored as a new mask for the photo.
Di f f er ence - only the difference between two masks will be stored as a new mask for the photo.

Filename template (not used in Fr om al pha mode)
Specifies the file name template used to generate mask file names. This template can contain special
tokens, that will be substituted by corresponding data for each photo being processed. The following
tokens are supported:

{fil ename} - filename of the source photo without extension.
{fil eext} -extension of the source photo.

{caner a} - cameralabel.

{frame} - frame number.

{filenunt -sequential number of the mask being imported.

For example, {filename} _mask.png template can be used if masks are available in PNG format and
havea_mask suffix.

Tolerance (Fr om Backgr ound method only)
Specifies the tolerance threshold used for background differencing. Tolerance value should be set
according to the color separation between foreground and background pixels. For larger separation
higher tolerance values can be used.

Apply to
Specifies whether masks should be imported for the currently opened photo, active chunk or entire
Workspace.
Al'l canmer as - load masks for active chunk.
Entire wor kspace - load masksfor al chunksin the project.

Sel ect ed camer as - load mask for the currently checked cameras (if any).

Current phot o - load mask for the currently opened photo (if any).

Editing masks

Modification of the current mask is performed by adding or subtracting selections. A selection is created
with one of the supported selection tools and is not incorporated in the current mask until it ismerged with
amask using Add Selection or Subtract Selection operations.

To edit the mask

1. Open the photo to be masked by double clicking on its name on the Workspace / Photo pane. The
photo will be opened in the main window. The existing mask will be displayed as a shaded region
on the photo.

2. Select the desired selection tool and generate a selection.

Selection to subtract the selection from the mask. #* | Invert Selection button allows to invert current
selection prior to adding or subtracting it from the mask.
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The following tools can be used for creating selections:

L—4 Rectangle selection tool
Rectangle selection tool is used to select large areas or to clean up the mask after other selection tools
were applied.

% Intelligent scissors tool
Intelligent scissorsisused to generate a selection by specifying its boundary. The boundary isformed
by selecting a sequence of vertices with a mouse, which are automatically connected with segments.
The segments can be formed either by straight lines, or by curved contours snapped to the object
boundaries. To enable snapping, hold Ctrl key while selecting the next vertex. To complete the
selection, the boundary should be closed by clicking on the first boundary vertex.

AN ntelligent paint tool
Intelligent paint tool is used to "paint" a selection by the mouse, continuously adding small image
regions, bounded by object boundaries.

M agic wand tool
Magic Wand tool is used to select uniform areas of the image. To make a selection with a Magic
Wand tool, click inside the region to be selected.

The range of pixel colors selected by Magic Wand is controlled by the tolerance value. At lower
tolerance values the tool selects fewer colors similar to the pixel you click with the Magic Wand tool.
Higher value broadens the range of colors selected.

4 Note

» To add new areato the current selection hold the Ctrl key during selection of additional area.

» Toreset mask selection on the current photo press Esc key.
A mask can beinverted using Invert Mask command from the Edit menu. The command is active in Photo
View only. Alternatively, you can invert masks either for selected cameras or for al camerasin a chunk

using Invert Masks... command from a photo context menu on the Photos pane.

The masks are generated individually for each image. If some object should be masked out, it should be
masked out on all photos, where that object appears.

Saving masks

Created masks can be also saved for external editing or storage.

To export masks

1. Select Export Masks... command from the File menu.

2. Inthe Export Mask dialog select suitable parameters. Click OK button when done.
3. Browseto the folder where the masks should be saved and select it.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

74



Editing

The following parameters can be specified during mask export:

Export masksfor

Specifies whether masks should be exported for the currently opened photo, active chunk or entire
Workspace.

Current phot o - save mask for the currently opened photo (if any).
Act i ve chunk - save masksfor active chunk.

Entire workspace - save masksfor al chunksin the project.

Filetype

Specifies the type of generated files.
Si ngl e channel mask i mage - generates single channel black and white mask images.

I mage wi th al pha channel - generatescolor imagesfrom source photos combined with mask
datain aphachannel.

Mask file names

Specifies the file name template used to generate mask file names. This template can contain special
tokens, that will be substituted by corresponding data for each photo being processed. The following
tokens are supported:

{fil ename} -filename of the source photo without extension.
{fil eext} -extension of the source photo.

{caner a} - cameralabel.

{frame} - frame number.

{filenun} -sequential number of the mask being exported.

For example, { filename} _mask.png template can be used to export masksin PNG format with _nmask
suffix.

4 Note

< When importing/exporting mask for the current photo only, PhotoScan will prompt for the actual
image instead of image folder. Mask file names parameter will not be used in this case.

Editing point cloud

The following point cloud editing tools are available in PhotoScan:

» Automatic filtering based on specified criterion (sparse cloud only)

Automatic filtering based on applied masks (dense cloud only)
Automatic filtering based on points colours (dense cloud only)
Reducing number of pointsin cloud by setting tie point per photo limit (sparse cloud only)

Manual points removal
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4 Note

 Point cloud editing operation can be undone/redone using Undo/Redo command from the Edit
menu.

Filtering points based on specified criterion

In some cases it may be useful to find out where the points with high reprojection error are located within
the sparse cloud, or remove points representing high amount of noise. Point cloud filtering helps to select
such points, which usually are supposed to be removed.

PhotoScan supports the following criteria for point cloud filtering:

Reprojection error
High reprojection error usually indicates poor localization accuracy of the corresponding point
projections at the point matching step. It is aso typical for false matches. Removing such points can
improve accuracy of the subseguent optimization step.

Reconstruction uncertainty
High reconstruction uncertainty is typical for points, reconstructed from nearby photos with small
baseline. Such points can noticeably deviate from the object surface, introducing noise in the point
cloud. While removal of such points should not affect the accuracy of optimization, it may be useful
to remove them before building geometry in Point Cloud mode or for better visual appearance of the
point cloud.

I mage count
PhotoScan reconstruct all the points that are visible at least on two photos. However, points that are
visible only on two photos are likely to be located with poor accuracy. Image count filtering enables
to remove such unreliable points from the cloud.

Projection Accuracy
Thiscriterion alowsto filter out points which projections were relatively poorer localised dueto their
bigger size.

Toremove points based on specified criterion

1 Switch to Point Cloud view mode using 2& Point Cloud toolbar button.

2. Select Gradua Selection... command from the Model menu.
3. Inthe Gradua Selection dialog box specify the criterion to be used for filtering. Adjust the threshold

level using the slider. Y ou can observe how the selection changes while dragging the slider. Click
OK buitton to finalize the selection.

To remove selected points use Delete Selection command from the Edit menu or click X Delete
Selection toolbar button (or simply press Del button on the keyboard).

Filtering points based on applied masks

Toremove points based on applied masks

1 Switch to Dense Cloud view mode using =5 Dense Cloud toolbar button.
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Choose Select Masked Points... command from the Dense Cloud submenu of the Tools menu.

In the Select Masked Points dialog box indicate the photos whose masks to be taken into account.
Adjust the edge softness level using the dlider. Click OK button to run the selection procedure.

To remove selected points use Delete Selection command from the Edit menu or click Pt Delete
Selection toolbar button (or simply press Del button on the keyboard).

Filtering points based on points colors

Toremove points based on points colors

1

Switch to Dense Cloud view mode using Dense Cloud toolbar button.
Choose Select Points by Color... command from the Dense Cloud submenu of the Tools menu.

In the Select Points by Color dialog box the color to be used as the criterion. Adjust the tolerance
level using the slider. Click OK button to run the selection procedure.

To remove selected points use Delete Selection command from the Edit menu or click X Delete
Selection toolbar button (or simply press Del button on the keyboard).

Tie point per photo limit

Tiepoint limit parameter could be adjusted before Align photos procedure. The number indicates the upper
limit for matching points for every image. Using zero value doesn't apply any tie-point filtering.

The number of tie points can a so be reduced after the alignment processwith Tie Points- Thin Point Cloud
command available from Tools menu. As a results sparse point cloud will be thinned, yet the alignment
will be kept unchanged.

Manual points removal

Incorrect points can be also removed manually.

Toremove pointsfrom a point cloud manually

1

Switch to Sparse Cloud view mode using 88 Point Cloud toolbar button or to Dense Cloud view

mode using Dense Cloud toolbar button.

Select points to be removed using .- Rectangle Selection, .+ Circle Selection or 4 FreeForm
Selection tools. To add new points to the current selection hold the Ctrl key during selection of
additional points. To remove some points from the current selection hold the Shift key during
selection of pointsto be removed.

To delete selected points click the X Delete Selection toolbar button or select Delete Selection

command from the Edit menu. To crop selection to the selected points click the ﬁ Crop Selection
toolbar button or select Crop Selection command from the Edit menu.
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Classifying dense cloud points

PhotoScan allows not only to generate and visualize dense point cloud but also to classify the pointswithin
it. There are two options; automatic division of all the pointsinto two classes - ground points and the rest,
and manual selection of agroup of points to be placed in a certain class from the standard list known for
LIDAR data. Dense cloud points classification opens way to customize Build Mesh step: you can choose
what type of objects within the scene you would like to be reconstructed and indicate the corresponding
point class as a source data for mesh generation. For example, if you build mesh or DEM based on ground
points only, it will be possible to export DTM (as opposed to DSM) at the next step.

Automatic classification of ground points

For the user to avoid extramanual work PhotoScan offersfeature for automatic detection of ground points.

To classify ground points automatically
1. Select Classify Ground Points... command from the Dense Cloud submenu of the Tools menu.

2. IntheClassify Ground Points dialog box select the source point data for the classification procedure.
Click OK button to run the classification procedure.

Automatic classification procedure consists of two steps. At the first step the dense cloud is divided into
cellsof acertain size. In each cell the lowest point is detected. Triangulation of these points givesthe first
approximation of the terrain model.

Additionally, at this step PhotoScan filters out some noise points to be handled as Low Points class.

At the second step new point is added to the ground class, providing that it satisfies two conditions: it lies
within a certain distance from the terrain model and that the angle between terrain model and the line to
connect this new point with a point from a ground class is less than a certain angle. The second step is
repeated while there still are points to be checked.

The following parameters control automatic ground points classification procedure

Max angle (deg)
Determines one of the conditionsto be checked whiletesting apoint asaground one, i.e. setslimitation
for an angle between terrain model and the line to connect the point in question with a point from a
ground class. For nearly flat terrain it isrecommended to use default value of 15 deg for the parameter.
It isreasonable to set a higher value, if the terrain contains steep slopes.

Max distance (m)
Determines one of the conditionsto be checked whiletesting apoint asaground one, i.e. setslimitation
for a distance between the point in question and terrain model. In fact, this parameter determines the
assumption for the maximum variation of the ground elevation at atime.

Céll size (m)
Determines the size of the cells for point cloud to be divided into as a preparatory step in ground
points classification procedure. Cell size should be indicated with respect to the size of the largest
area within the scene that does not contain any ground points, e. g. building or close forest.

Manual classification of dense cloud points

PhotoScan allows to associate all the points within the dense cloud with a certain standard class (see
LIDAR data classification). This provides possihility to diversify export of the processing results with
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respect to different types of objects within the scene, e. g. DTM for ground, mesh for buildings and point
cloud for vegetation.

To assign aclassto a group of points

1 Switch to Dense Cloud view mode using using Dense Cloud toolbar button.

2 Select points to be placed to a certain class using L. Rectangle Selection, {_7 Circle Selection or

-;_ﬂ Free-Form Selection tools. To add new points to the current selection hold the Ctrl key during
selection of additional points. To remove some points from the current selection hold the Shift key
during selection of pointsto be removed.

3. Sdect Assign Class... command from the Dense Cloud submenu of the Tools menu.

4. Inthe Assign Class dialog box select the source point data for the classification procedure and the
targeted class to be assigned to the selected points. Click OK button to run classification procedure.

Dense point cloud classification can be reset with Reset Classification command from Tools - Dense Cloud
menul.

Editing model geometry

The following mesh editing tools are available in PhotoScan:
 Decimation tool

* Close Holestool

* Smooth tool

» Automatic filtering based on specified criterion

e Manual polygon removal

* Fixing mesh topology

* Refinement tool

More complex editing can be done in the external 3D editing tools. PhotoScan allows to export mesh and
then import it back for this purpose.

[ Note

 For polygon removal operations such as manual removal and connected component filtering it
is possible to undo the last mesh editing operation. There are Undo/Redo commands in the Edit
menu.

 Please note that undo/redo commands are not supported for mesh decimation and this operation
cannot be undone.

Decimation tool

Decimation is atool used to decrease the geometric resolution of the model by replacing high resolution
mesh with a lower resolution one, which is still capable of representing the object geometry with high
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accuracy. PhotoScan tends to produce 3D model s with excessive geometry resolution, so mesh decimation
isusually a desirable step after geometry computation.

Highly detailed models may contain hundreds of thousands polygons. Whileiit is acceptable to work with
such acomplex modelsin 3D editor tools, in most conventional tools like Adobe Reader or Google Earth
high complexity of 3D models may noticeably decrease application performance. High complexity also
resultsin longer time required to build texture and to export model in pdf file format.

In some casesit isdesirable to keep as much geometry details as possiblelikeit is needed for scientific and
archive purposes. However, if there are no special requirementsit is recommended to decimate the model

down to 100 000 - 200 000 polygons for exporting in PDF, and to 100 000 or even less for displaying in
Google Earth and alike toals.

To decimate 3D mode
1. Select Decimate Mesh... command from the Tools menu.

2. Inthe Decimate Mesh dialog box specify the target number of polygons, which should remain in the
final model. Click on the OK button to start decimation.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click on the Cancel button.

[ Note

» Textureatlasisdiscarded during decimation process. Y ou will have to rebuild texture atlas after
decimation is complete.

Close Holes tool

Close Holes tool provides possibility to repair your model if the reconstruction procedure resulted in a
mesh with several holes, due to insufficient image overlap for example.

Some tasks require a continuous surface disregarding the fact of information shortage. It is necessary to
generate a close model, for instance, to fulfill volume measurement task with PhotoScan.

Close holes tool enables to close void areas on the model substituting photogrammetric reconstruction

with extrapolation data. It is possible to control an acceptable level of accuracy indicating the maximum
size of aholeto be covered with extrapolated data.

Toclose holesin a 3D model
1. Select Close Holes... command from the Tools menu.

2. Inthe Close Holes dia og box indicate the maximum size of aholeto be covered with the slider. Click
on the OK button to start the procedure.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click on the Cancel button.

[{ Note

* Thedlider alowsto set the size of aholein relation to the size of the whole model surface.
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Polygon filtering on specified criterion

In some cases reconstructed geometry may contain the cloud of small isolated mesh fragments surrounding
the "main" model or big unwanted polygons. Mesh filtering based on different criteria helps to select
polygons, which usually are supposed to be removed.

PhotoScan supports the following criteriafor face filtering:

Connected component size
This filtering criteria alows to select isolated fragments with a certain number of polygons. The
number of polygonsin al isolated components to be selected is set with a dider and is indicated in
relation to the number of polygons in the whole model. The components are ranged in size, so that
the selection proceeds from the smallest component to the largest one.

Polygon size
This filtering criteria allows to select polygons up to a certain size. The size of the polygons to be
selected is set with adider and is indicated in relation to the size of the whole model. This function
can be useful, for example, in case the geometry was reconstructed in Smooth type and thereis aneed

to remove extra polygons automatically added by PhotoScan to fill the gaps; these polygons are often
of alarger size that the rest.

Toremove small isolated mesh fragments

1. Select Gradua Selection... command from the Edit menu.

2. Inthe Gradual Selection dialog box select Connected component size criterion.

3. Select the size of isolated components to be removed using the dlider. Size of the largest component

is taken for 100%. Y ou can observe how the selection changes while dragging the slider. Click OK
button to finalize the selection.

To remove the selected components use Delete Selection command from the Edit menu or click X
Delete Selection toolbar button (or simply press Del button on the keyboard).

Toremovelarge polygons

1. Select Gradua Selection... command from the Edit menu.

2. Inthe Gradual Selection dialog box select Polygon size criterion.

3. Select the size of polygons to be removed using the slider. Size of the largest polygon is taken for

100%. You can observe how the selection changes while dragging the sider. Click OK button to
finalize the selection.

To remove the selected components use Delete Selection command from the Edit menu or click X
Delete Selection toolbar button (or simply press Del button on the keyboard).

Note that PhotoScan always selects the fragments starting from the smallest ones. If the model contains
only one component the selection will be empty.

Manual face removal

Unnecessary and excessive sections of model geometry can be also removed manually.
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Toremove part of the mesh polygons manually

1.

-1

Select rectangle, circle or free-form selection tool using . - . Rectangle Selection, {_? Circle Selection

or 'l_g Free-Form Selection toolbar buttons.

Make the selection using the mouse. To add new polygons to the current selection hold the Ctrl key
during selection of additional polygons. To remove some polygons from the current selection hold
the Shift key during selection of polygons to be excluded.

To delete selected polygons click the X Delete Selection toolbar button or use Delete Selection

command from the Edit menu. To crop sel ection to the selected polygonsclick the tlf- Crop Selection
toolbar button or use Crop Selection command from the Edit menu.

Togrow or shrink current selection

1

To grow current selection press PageUp key in the selection mode. To grow selection by even alarger
amount, press PageUp while holding Shift key pressed.

To shrink current selection press PageDown key in the selection mode. To shrink selection by even
alarger amount, press PageDown while holding Shift key pressed.

Fixing mesh topology

PhotoScan is capable of basic mesh topology fixing.

To fix mesh topology

1. Select View Mesh Statistics... command from the Tools menu.

2. In the Mesh Statistics dialog box you can inspect mesh parameters. If there are any topological
problems, Fix Topology button will be active and can be clicked to solve the problems.

3. The progress dialog box will appear displaying the current processing status. To cancel processing

click on the Cancel button.

Editing mesh in the external program

To export mesh for editing in the external program

1

2.

Select Export Model... command from the File menu.

In the Save As dialog box, specify the desired mesh format in the Save astype combo box. Select the
file name to be used for the model and click Save button.

In the opened dialog box specify additional parameters specific to the selected file format. Click OK
button when done.

Toimport edited mesh

1

2.

Select Import Mesh... command from the File menu.

In the Open dialog box, browse to the file with the edited model and click Open.
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Note

 PhotoScan supports loading models in Wavefront OBJ, 3DS, STL, COLLADA, Stanford PLY,
Autodesk FBX, Autodesk DXF, OpenCTM and U3D fileformatsonly. Please make sureto select
one of these file formats when exporting model from the external 3D editor.

« Please be aware that it isimportant to keep reference information for the model if any.

Shapes

Shapes are used to indicate boundaries either for DEM/Orthomosaic export or for measurement
procedures. Shapes can be drawn over DEM or Orthomosaic aswell as over model using buttons from the
Ortho/Model view toolbar. Alternatively, shapescan beloaded from a.SHP/.DXF/.KML filesusing Import
Shapes... subcommand of Import... command available from the File menu. Shapes created in PhotoScan
can be exported using Export Shapes... subcommand of Export... command available from the File menu.

To draw a shape on DEM/Orthomosaic/M odel

1

6.

Open DEM/orthomosaic in Ortho view double clicking on DEM/orthomosaic label in the Workspace
pane. Alternatively, model in Model view.

Select “*" Draw Point /™ Draw Polyline/ '/ Draw Polygon instrument from the toolbar.
Draw a point/polyline/polygon on the DEM/orthomosaic/model with a cursor.

Double click on the last point to indicate the end of a polyline. To complete a polygon, place the end
point over the starting one.

o

Oncethe shapeisdrawn, ashape |abel '/ will be added to the chunk data structure on the Workspace
pane. All shapes drawn on the same model (and on the corresponding DEM and orthomosaic) will
be shown under the same label on the Workspace pane.

The program will switch to a navigation mode once a shape is compl eted.

Drawing shapesin 3D (on the model) solves issues with building basements and other features which are
not visible on the orthomosaic. However, drawing on amodel might not be accurate enough. For this case
PhotoScan offers possibility to draw a shape on source photos and automatically reconstruct it in 3D.

To automatically reconstruct a shapein 3D

1

Go to Preferences dialog available from Tools menu and enable "Attach markers to vertices on
photos' option on Advanced tab.

Open a photo in Photo view double clicking on the photo thumbnail in the Photo pane.

Select "% Draw Point / A Draw Polyline/ " Draw Polygon instrument from the toolbar.
Draw a point/polyline/polygon on the photo with a cursor.

Double click on the last point to indicate the end of a polyline. To complete a polygon, place the end
point over the starting one. All the vertices will be indicated with markers.

Switch to Model view to see that the shape has been reconstructed in 3D automatically.
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7. Torefinethe position of the shape, filter photos by shape using the corresponding command from the
shape context menu. The shape must be selected - to select a shape double click onit.

8. Inspect al the relevant photos to refine markers-vertices positions where necessary. The position of
the shape in 3D will automatically be refined.

After a shape has been drawn, it can be edited using Insert Vertex / Delete Vertex commands from the
context menu. Delete Vertex command is active only for avertex context menu. To get accessto the vertex
context menu, select the shape with a double click first, and then select the vertex with a double click on
it. To change position of a vertex, drag and drop it to a selected position with the cursor. Positions of the
markers-vertices cannot be changed in the model view.

Shapes alow to measure distances both on DEM and 3D model and to measure coordinates, surface
areas and volumes on 3D model. Please refer to Performing measurements on 3D model, Performing
measurements on DEM sections of the Manual for details.

Shapes added to the particular chunk of the project can be organised into layers. Thefirst layer is generated
automatically on creation of the first shape and is placed into the Shapes folder on the project tree. This
layer is meant to serve as a background thus named No Layer. It is originally set as default one to store
all the shapes.

To create a new layer use Create Shape Layer command from the context menu of the Shape folder on
the Workspace pane. A layer can be set as default one using Set as default command from the context
menu of the layer name on the Workspace pane. A newly created layer can be renamed with a relevant
command from the context menu.

Export Layers... command from the context menu of alayer allows to save shapes from the layer in one
of the supported export formats available: shp, dxf, kml.

A shape can be labeled and saved to a certain layer using Properties... command from the context menu
of the shape in the Model/Ortho view.

Orthomosaic seamlines editing

PhotoScan software offers various blending options at orthomosaic generation step for the user to adjust
processing to their data and task. However, in some projects moving objects can cause artifacts which
interfere with visual quality of the orthomosaic. The same problem may result from oblique aerial imagery
processing if the area of interest contains high buildings or if the user has captured facade from too oblique
positions. To eliminate mentioned artifacts PhotoScan offers seamline editing tool. The functionality
allowsto choose manually the image or imagesto texture the indicated part of the orthomosaic from. Thus,
the final orthomosaic can be improved visually according to the user's expectations.

A
Automatic seamlines can be turned on for inspection in the Ortho view with pressing the & Show
Seamlines button from the Ortho view toolbar.

To edit orthomosaic seamlines

1 Draw a polygon on the orthomosaic using '/ Draw Polygon instrument to indicate the area to be

retextured.
2. Select Assign Images... command from the context menu of the selected polygon.

3. In the Assign Images dialog box select the image to texture the area inside the polygon from.
Orthomosai ¢ preview on the Ortho tab allows to eval uate the results of the selection. Click OK button
to finalise the image selection process.
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4 Click '_“flﬂ Update Orthomosai ¢ button from the Ortho view toolbar to apply the changes.

Assign Images dialog allows to activate multiple selection option. If the Allow multiple selection option
ischecked, it is possible to assign several images to texture the areainside the polygon from. However, in

this case there is no possibility to preview the resulting orthomosaic. It is necessary to Click '_“:Rﬂ Update
Orthomosai ¢ button from the Ortho view toolbar to apply the changes and seethe results. Until the changes
are applied, the area of interest will be marked with a net of blue colour to indicate that some edits are
waiting for enforcement. Blending method selected at build orthomosaic step will be implemented at
orthomosaic editing step.

Assign Images dialog, aternatively, allows to exclude selected images from texturing the area of interest.
Check Exclude selected images option to follow thisway. Please note that in this case preview illustrates
theimageto be excluded, i.d. the results one should expect after applying the changes are not shown. Click

'_"Jnlﬂ Update Orthomosai ¢ button from the Ortho view toolbar to apply the changes
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Using chunks

When working with typical datasets, automation of general processing workflow allowsto perform routine
operations efficiently. PhotoScan allows to assign severa processing steps to be run one by one without
user intervention thanks to Batch Processing feature. Manual user intervention can be minimized even
further dueto 'multiple chunk project' concept, each chunk to include onetypical dataset. For aproject with
several chunks of the same nature, common operations available in Batch Processing dialog are applied to
each selected chunk individualy, thus allowing to set several data setsfor automatic processing following
predefined workflow pattern.

In addition, multiple chunk project could be useful when it turns out to be hard or even impossible to
generate a 3D model of the whole scene in one go. This could happen, for instance, if the total amount
of photographs is too large to be processed at a time. To overcome this difficulty PhotoScan offers a
possibility to split the set of photos into several separate chunks within the same project. Alignment of
photos, building dense point cloud, building mesh, and forming texture atlas operations can be performed
for each chunk separately and then resulting 3D models can be combined together.

Working with chunks is not more difficult than using PhotoScan following the general workflow. In fact,
in PhotoScan always exists at | east one active chunk and all the 3D model processing workflow operations
are applied to this chunk.

To work with several chunks you need to know how to create chunks and how to combine resulting 3D
models from separate chunks into one model.

Creating a chunk

To create new chunk click on the & Add Chunk toolbar button on the Workspace pane or select Add
Chunk command from the Workspace context menu (available by right-clicking on the root element on
the Workspace pane).

After the chunk is created you may load photosinit, align them, generate dense point cloud, generate mesh
surface model, build texture atlas, export the models at any stage and so on. The models in the chunks
are not linked with each other.

The list of all the chunks created in the current project is displayed in the Workspace pane along with
flags reflecting their status.

The following flags can appear next to the chunk name:

R (Referenced)
Indicates that 3D model in the chunk was referenced. Also will appear when two or more chunks are
aligned with each other. See information on how to reference the model in Setting coordinate system.

S (Scaled)
Indicates that 3D model in the chunk was scaled based on scale bars information only, with no
reference coordinates data being present. See information on scale bar placement in Optimization
section.

T (Transformed)
Indicates that 3D model has been modified manually with at least one of the following instruments:

o
“I# Rotate object, "g° Move object or Scale object.
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To move photos from one chunk to another simply select them in thelist of photos on the Workspace pane,
and then drag and drop to the target chunk.

Working with chunks

All operations within the chunk are carried out following the common workflow: loading photographs,
aligning them, generating dense point cloud, building mesh, building texture atlas, exporting 3D model
and so on.

Note that all these operations are applied to the active chunk. When anew chunk is created it is activated

automatically. Save project operation savesthe content of all chunks. To save selected chunks as aseparate
project use Save Chunks command from the chunk context menu.

To set another chunk as active
1. Right-click on the chunk title on the Workspace pane.

2. Select Set Active command from the context menu.

To remove chunk
1. Right-click on the chunk title on the Workspace pane.
2. Select Remove Chunks command from the context menu.

To rearrange the order of chunksin the Workspace pane simply drag and drop the chunksin the pane.

Aligning chunks

After the "partial” 3D models are built in several chunks they can be merged together. Before merging
chunks they need to be aligned.

To align separate chunks
1. Select Align Chunks command from the Workflow menu.

2. Inthe Align Chunks dialog box select chunks to be aligned, indicate reference chunk with a double-
click. Set desired alignment options. Click OK button when done.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click the Cancel button.

Aligning chunks parameters

Thefollowing parameters control the chunksalignment procedure and can be modified inthe Align Chunks
dialog box:

Method
Defines the chunks alignment method. Poi nt  based method aligns chunks by matching photos
across all the chunks. Mar ker based method uses markers as common points for different chunks.
Thedetails on using markers are avail able in the Setting coordinate system section. Caner a based
method is used to align chunks based on estimated camera locations. Corresponding cameras should
have the same label.
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Accuracy (Point based alignment only)
Higher accuracy setting hel psto obtain more accurate chunk alignment results. L ower accuracy setting
can be used to get the rough chunk alignment in the shorter time.

Point limit (Point based alignment only)
The number indicates upper limit of feature points on every image to be taken into account during
Poi nt based chunks alignment.

Fix scale

Option is to be enabled in case the scales of the models in different chunks were set precisely and
should be left unchanged during chunks alignment process.

Preselect image pair s (Point based alignment only)
The alignment process of many chunks may take a long time. A significant portion of thistime is
spent for matching of detected features across the photos. Image pair preselection option can speed
up this process by selection of a subset of image pairs to be matched.

Constrain features by mask (Point based alignment only)
When this option is enabled, features detected in the masked image regions are discarded. For
additional information on the usage of masks refer to the Using masks section.

4 Note

* Chunk alignment can be performed only for chunks containing aligned photos.

e Thereis no need to perform chunk alignment for georeferenced chunks, as they are already in
the same coordinate frame.

Merging chunks
After aignment is complete the separate chunks can be merged into a single chunk.

To merge chunks
1. Select Merge Chunks command from the Workflow menu.

2. Inthe Merge Chunks dialog box select chunks to be merged and the desired merging options. Click
OK button when done.

3. PhotoScan will mergethe separate chunksinto one. The merged chunk will be displayed in the project
content list on Workspace pane.

Thefollowing parameters control the chunks merging procedure and can be modified in the Merge Chunks
dialog box:

Mer ge dense clouds
Defines if dense clouds from the selected chunks are combined.

Merge models
Defines if models from the selected chunks are combined.

Merge markers
Defines if markers from the selected chunks are merged (only markers with the same labels would
be merged).
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Chunks merging result (i.e. photos, point clouds and geometry) will be stored in the new chunk and it may
be treated as an ordinary chunk (e.g. the model can be textured and/or exported).

Batch processing

PhotoScan allows to perform general workflow operations with multiple chunks automatically. It isuseful
when dealing with alarge number of chunks to be processed.

Batch processing can be applied to al chunks in the Workspace, to unprocessed chunks only, or to the
chunks selected by the user. Each operation chosen in the Batch processing dialog will be applied to every
selected chunk before processing will move on to the next step.

Align Photos Align/Merge Chunks Save/L oad Project
Optimize Alignment Decimate Mesh Export/Import Cameras
Build Dense Cloud Smooth model Export Points

Build Mesh Close Holes Export Model

Build Texture Import Masks Export Texture
Refine Mesh Cdlibrate Colors Reset Region

Build Tiled Model Remove Lighting Export Tiled Model
Build DEM Classify Ground Points Export DEM

Build Orthomosaic Import Shapes Export Orthomosaic
Detect Markers Detect Fiducials Run Script
Generate Report Undistort Photos

To start batch processing

1.

2.

Select Batch Process... command from the Workflow menu.
Click Add to add the desired processing stages.

In the Add Job dialog select the kind of operation to be performed, the list of chunks it should be
applied to, and desired processing parameters. Click OK button when done.

Repeat the previous steps to add other processing steps as required.
Arrange jobs by clicking Up and Down arrows at the right of the Batch Process... dialog box.
Click OK button to start processing.

The progress dialog box will appear displaying the list and status of batch jobs and current operation
progress. To cancel processing click the Cancel button.

When the batch processincludesimport/export features that are applied to multiple chunksit is reasonable
to use the following templatesin the Path field of the import/export jobs:

e {fil enane} - filename (without extension),

o {fileext} -fileextension,

e {camer a} - cameralabdl,
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e {frane} -frameindex,

{chunkl abel } - chunk label,

» {i magef ol der} - folder containing images of an active chunk,

{proj ectfol der} - path to thefolder containing current project,
» {proj ect nane} - current project filename,

» {proj ect pat h} - absolute path to the current project.

The list of tasks for batch processing can be exported to XML structured file using Il?ll Save button in the

Batch processing dialog and imported in a different project using Open button.

4D processing

Overview

PhotoScan supports reconstruction of dynamic scenes captured by aset of statically mounted synchronized
cameras. For this purpose multiple image frames captured at different time moments can be loaded for
each camera location, forming a multiframe chunk. In fact norma chunks capturing a static scene are
multiframe chunks with only a single frame |oaded. Navigation through the frame sequenceis performed
using Timeline pane.

Although aseparate static chunk can be used to process photosfor each time moment, aggregate multiframe
chunks implementation has several advantages:

» Coordinate systems for individual frames are guaranteed to match. There is no need to align chunksto
each other after processing.

» Each processing step can be applied to the entire sequence, with a user selectable framerange. Thereis
no need to use batch processing, which simplifies the workflow.

» Accuracy of photo alignment is better due to the joint processing of photos from the entire sequence.
e Markers can be tracked automatically through the sequence.
* Intuitive interface makes navigation through the sequence pretty simple and fast.

Multiframe chunks can be also efficient (with some limitations) for processing of disordered photo sets of
the same object or even different objects, provided that cameras remain static throughout the sequence.

Managing multiframe chunks

Multiframe layout is formed at the moment of adding photos to the chunk. It will reflect the data layout
used to store image files. Therefore it is necessary to organize files on the disk appropriately in advance.
The following data layouts can be used with PhotoScan:

a. All framesfrom corresponding camera are contained in a separate subfolder. The number of subfolders
isegual to the number of cameras.

b. Corresponding framesfrom all cameras are contained in a separate subfolder. The number of subfolders
isequal to the number of frames.

90



Automation

c. All frames from corresponding camera are contained in a separate multilayer image. The number of
multilayer imagesis equal to the number of cameras.

d. Corresponding frames from all cameras are contained in a separate multilayer image. The number of
multilayer imagesis equal to the number of frames.

Once the data is properly organized, it can be loaded into PhotoScan to form a multiframe chunk. The
exact procedure will depend on whether the multifolder layout (variants a and b) or multilayer (variants
¢ and d) layout is used.

To create a chunk from multifolder layout

L Select & Add Folder... command from the Workflow menu.

2. Inthe Add Folder dialog box browse to the parent folder containing subfolders with images. Then
click Select Folder button.

3. Inthe Add Photosdialog select the suitable datalayout. For layout a) above select " Create multiframe
cameras from folders as cameras'. For layout b) select "Create multiframe cameras from folders as
frames".

4. Created multiframe chunk will appear on the Workspace pane.

To create a chunk from multilayer images

L Select Add Photos... command from the Workflow menu or click Add Photos toolbar button.

2. Inthe Add Photos dialog box browse to the folder containing multilayer images and select files to
be processed. Then click Open button.

3. Inthe Add Photosdialog select the suitable datalayout. For layout ¢) above select " Create multiframe
camerasfromfilesascameras'. For layout d) select " Create multiframe camerasfrom filesasframes®.

4. Created multiframe chunk will appear on the Workspace pane.

It isrecommended to inspect the loaded frame sequence for errors. This can be done by scrolling the frame
selector in the Timeline pane and inspecting thumbnails in the Photos pane during scrolling.

After multiframe chunk is created, it can be processed in the same way as normal chunks. For multiframe
chunks additional processing parameters allowing to select the range of frames to be processed will be
provided where appropriate.

Tracking markers

PhotoScan allows to automatically track marker projections through the frames sequence, provided that
object position doesn't change significantly between frames. This greatly simplifies the task of labeling of
amoving point if the number of framesislarge.

Totrack markersthrough the frame sequence

1. Scroll frameselector inthe Timeline paneto the 1st frame. Add markersfor the 1st frame as described
in the Setting coordinate system section.

2.  Sedlect Track Markers... command from the Tools menu.
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Adjust the starting and ending frame indices if necessary. Default values correspond to tracking from
the current frame to the end of sequence. Click OK button to start tracking.

Check tracked marker locations. Automatically tracked markers will be indicated with “Q? icons. In
case of a placement error at some frame, adjust the wrong marker location within the frame where

the failure occurred. Once the marker location is refined by user, the marker icon will change to ":U

Restart tracking from that frame using Track Markers... command again.

Note

« If the ending frame index is smaller than the starting index, tracking will be performed in the
backwards direction.

» Automatic marker tracking is likely to fail in case when structured light is used to add texture
details to the object surface, as the light pattern will not be static with respect to the moving
object surface.

Python scripting

PhotoScan supports Python API, using Python 3.5 as a scripting engine.

Python commands and scripts can be executed in PhotoScan through one of the following options:

PhotoScan Console pane can serve as Python rich console;

Click L4# Run Script button on Console pane toolbar or use ‘¥ Run Script... command from the Tools
menu to run a Python script.

From command-lineusing - r argument.

On Windows:
photoscan.exe -r <scripthname.py>

On Linux:
Jphotoscan.sh -r <scriptname.py>

On Mac OS X:
./PhotoScanPro.app/Contents/M acOS/PhotoScanPro -r <scriptname.py>

From autorun folder.
for Windows: C:/Users/<user>/AppData/L ocal/Agisoft/PhotoScan Pro/scripts/

for Linux: /home/<user>/.local/share/Agisoft/PhotoScan Pro/scripts/
for Mac OS X: /Userg/<user>/Library/Application Support/Agisoft/PhotoScan Pro/scripts/

on any OS (for all users): <installation folder>/scripts/

For details on PhotoScan functionality accessible through Python scripts please refer to Python API
Reference document available on Agisoft official website (http://www.agisoft.com/downloads/user-
manuals/).

The collection of the sample Python scriptsis available on Agisoft GitHub repository: https://github.com/
agisoft-11c/photoscan-scripts.
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Chapter 8. Network processing

Overview

Agisoft PhotoScan can be configured to run on a computer cluster where processing is distributed on
several computer nodes connected to alocal network. In such configuration multiple PhotoScan instances
running on different processing nodes can work on the same task in parallel, effectively reducing the total
processing time needed.

By default processing is divided between the nodes on a chunk by chunk, frame by frame basis (with the
exception of camera alignment and optimization, where each chunk is processed as a whole on asingle
node). In addition a more fine grained distribution can be enabled for image matching and alignment, as
well as generation of dense clouds, tiled models, DEMs and orthomosaics, in which case processing of
individual chunks/framesis further subdivided between several processing nodes.

Communication between processing nodes, server and clients is performed using TCP connections. In
addition, shared network storage accessible for all processing nodes and clients is used for storing the
source data and intermediate processing results.

Cluster components

Client 1 Processing node 1

Server
TCP TCP

Client 2

\ 4
A

Processing node 2

Client n

Processing node n

Network storage

Server

The server node coordinates operation of all processing nodes, maintaining a task queue for all projects
scheduled for processing. A separate interface is provided for clients, which can connect to the server to
start new processing tasks or monitor progress of existing ones.

The server itself doesn't perform any processing and can easily run on slow hardware. The server
component is critical for operation of the cluster, and is not fault tolerant. Measures should be taken to
ensure continuous operation of the server node.

The server node accepts TCP connections from processing nodes and clients on 2 separate interfaces,
which can be attached to different physical network interfacesif necessary. The server node doesn't initiate
any TCP connections itself.
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Processing nodes

Processing nodes perform actual calculations, and thus need to be run on fast hardware. Each processing
node connects to the server on startup and waits for atask to be assigned. Once the task is available, the
node starts processing, informing the server about the progress. When processing is finished, the results
are stored on shared network storage, and the server isinformed about completion. Then a node switches
to the next task when it becomes available.

Processing nodes can be added or removed from the cluster as needed. Abnormal shutdown of processing
node doesn't cause cluster failurein most cases. Nevertheless, it is highly recommended to stop particular
nodes using Agisoft Network Monitor before disconnecting them from the cluster.

Clients

Clients can connect to the server nodeto control cluster operation or to monitor its status. New tasks can be
submitted for processing using Agisoft PhotoScan software configured as a network client, while cluster
monitoring is performed using Agisoft Network Monitor. Multiple clients can be connected to the server
node simultaneously.

Cluster setup

Before proceeding to the following steps please make sure that shared network storage is accessible from
all processing and client nodes using the same absol ute path. It should be either mounted to the same folder
on al nodes (Linux), or should have the same UNC network path (Windows). In case such configuration
isnot possible (for example in mixed Windows/Linux cluster), a path prefix can be specified on each node
to compensate for the differences.

Starting server

It is recommended to configure server with a static IP address, not dynamically assigned one. This IP
address will be needed for each processing node and client.

The server process can be started by executing PhotoScan with the following command line arguments:
photoscan --server --control <ip>[:port] --dispatch <ip>[:port]

--server parameter specifies that PhotoScan should be started in a server mode.

--contr ol parameter specifiesthe network interface to be used for communication with clients. In case port
value is omitted, the default port 5840 is used.

--dispatch parameter specifiesthe network interface to be used for communication with processing nodes.
In case port value is omitted, the default port 5841 is used.

Example:
photoscan --server --control 10.0.1.1 --dispatch 10.0.1.1

In this case PhotoScan will use the same interface for both clients and processing nodes with default port
values.

Starting network nodes

The processing node can be started by executing PhotoScan with the following command line arguments:
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photoscan --node --dispatch <ip>[:port] [--r oot prefix]
--node parameter specifies that PhotoScan should be started as a processing node.

--dispatch parameter specifies | P of the server to connect. In case port value is omitted, the default port
5841 is used.

--root parameter can be used to specify network storage mount point or prefix path in case it is not the
same across network.

--priority <priority> parameter can be used to specify the priority of the node. Higher number means
higher priority.

--capability {cpu, gpu, any} parameter can be used to specify whether the node should work on CPU-
only tasks, GPU-supported tasks only or will receive any tasks.

--gpu_mask <mask> parameter set GPU device mask for GPU-supported tasks.

--cpu_enable {0,1} parameter can be used to enable or disable CPU during the GPU-supported tasks.
--absolute_paths{0,1} parameter can be used to set the absolute paths option.

--auto-submit parameter can be used to enable automatic crash report submission.

--email <address> parameter specifies email address to be included in the crash reports.

Example:
photoscan --node --dispatch 10.0.1.1 --r oot /processing

This command will start processing node using 10.0.1.1 as a server | P with default port 5841.

Checking cluster status

Start Agisoft Network Monitor application. In the host name field enter server IP used for client
connections (10.0.1.1 in our example). Modify port values in case non-default port was specified. Click
Connect button when done.

A list of available network nodes currently connected to the server will be displayed in the bottom part of
the window. Please make sure that all started processing nodes are listed.

Thetop part lists tasks currently being processed (finished tasks are removed from the list as soon as they
are completed). The task list will be empty if no processing was started yet.

Starting network processing

1. Configure Agisoft PhotoScan for network processing.
Start Agisoft PhotoScan on any computer connected to the cluster network.

Open Preferences dialog using Preferences... command from the Tools menu. On the Network tab
make sure Enable network processing option is turned on, and specify the server IP used for client
connection in the Host name field. In case non-default port was configured on a server, modify the
port value accordingly.

In case you are going to process a few single-frame chunks with large number of photos, we
recommend to enable fine-level task distribution for all supported operations (Match Photos, Align
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Cameras, Build Dense Cloud, Build Tiled Model, Build DEM, Build Orthomosaic). In case you are
going to process a large number of small chunks, or chunks with large number of frames, fine-level
task distribution can be left in disabled state.

Press OK button when done.
2. Prepare project for network processing.

Open the project file to be processed. Make sure that the project is saved in PhotoScan Project (*.psx)
format. Processing of projectsin PhotoScan Archive (*.psz) format isnot supported in network mode..

Important! Please make sure that source images are located on shared network storage and not on a
local hard drive. Otherwise processing nodes will be unable to load them.

3. Start processing.

Start processing using corresponding command from the Workflow menu, or using Batch Process
command to execute a command segquence. A network progress dialog should appear displaying
current progress.

4. Wait for processing to complete.

You can disconnect from the server at any time using Disconnect button in the Network Progress
dialog in case you need to work on other projects. Processing will continue in the background.

To see processing status after you have disconnected from the server simply open corresponding .psx
project on the network storage. Alternatively you can use Agisoft Network Monitor to see processing
status for all projects being processed.

5. Inspect processing resullts.

After processing is finished, click Close button to close Network Progress dialog. The project with
processing results will be displayed in PhotoScan window.

Cluster administration

Adding processing nodes

New processing nodes can be added by starting Agisoft PhotoScan on additional computersin the network
node mode, as outlined in the Starting network nodes section above.

Removing processing nodes

Aborting or disconnecting processing node during cluster operation is not absolutely safe, and can lead to
project corruption if performed during final project update at the end of processing. Although the chances
of this situation are relatively low, we strongly recommend against such approach. To safely disconnect
processing node from the cluster you need to stop processing on this node using Agisoft Network Monitor
first.

1. Start Agisoft Network Monitor. Make sure the server IPis properly configured in the host namefield
and click Connect button.

2. In the bottom list of network nodes identify the node to be removed. From the node menu select
Pause command to stop the node after it finishes current job, or Stop command to abort processing
immediately.
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3. Wait until the Batch # and Progress items for a selected node become empty. This indicates that the
node has finished processing. The status of the node should be Paused.

4.  Now you can safely disconnect the node by aborting PhotoScan process.
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Appendix A. Graphical user interface

Application window
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General view of application window.

Model view

Model view tab is used for displaying 3D data as well as for mesh and point cloud editing. The view of
the model depends on the current processing stage and is also controlled by mode selection buttons on

the PhotoScan toolbar.

Model can be shown as a dense cloud, with class indication or without, or as a mesh in shaded, solid,
wireframe or textured mode. Along with the model the results of photo alignment can be displayed. These
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include sparse point cloud and camera positions visualised data. Additionally tiled textured model can be
displayed and navigated in the model view.

PhotoScan supports the following tools for navigation in the 3D view:

Tool Keyboard modifier
Rotation Tool Default

Pan Tool Ctrl key pressed
Zooming Tool Shift key pressed

All navigation tools are accessible in the navigation mode only. To enter the navigation mode click the
+ Navigation toolbar button.

PhotoScan offers two different navigation modes: Object navigation and Terrain navigation. Switching
between the navigation modes can be performed from the Navigation Mode submenu of the View menu.
Object navigation mode allows for 3-axis rotation control, while Terrain navigation mode restricts control
to 2-axis rotation only, z-axis being kept vertical all the time.

In Object navigation mode the rotation with mouse can be performed while left mouse button is pressed,
whereas holding right mouse button allows for model tilt. In Terrain navigation mode mouse buttons
functionality isinverted and left button is responsible for tilt, whereas right button for rotation.

[{ Note

e Zooming into the model can be aso controlled by the mouse whed!.

Ortho view

Ortho view is used for the display of 2D processing results data: digital elevation model, full resolution
orthomosaic, NDVI colour-coded values, as well as shapes and contour lines data. Switching between
DEM and orthomosaic can be performed using the corresponding button on the toolbar or by double-
clicking on the respectiveicon on the Workspace pane, providing that both products have been generated.

Orthomosaic can be displayed intheoriginal coloursor in coloursaccording to the pal ette set for vegetation
index values visualisation.

Additional instruments allow to draw points, polylines and polygons on the orthomosaic and/or digital
elevation model to perform point, linear, profile and volume measurements. Also polygonal shapes are
allowed to be set up as inner or outer boundaries, that will be used for the definition of the area to be
exported. Using polygonal shapes allows to create custom seamlines on the orthomosaic, which can be
useful for some projects enabling to eliminate blending artefacts.

Switching to Ortho view mode changes the contents of the Toolbar, presenting related instruments and
hiding irrelevant buttons.

Photo view

Photo view tab is used for displaying individual photos aswell as markers, shapes and masks on them.

In the Photo view tab it is allowed to create markers, refine their projections, draw shapes and adjust
positions of shape vertices and to draw masks on the photos.

Photo view is visible only if any photo is opened. To open a photo double-click on its name on the
Workspace, Reference or Photos pane.
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Switching to Photo view mode changes the contents of the Toolbar, presenting related instruments and
hiding irrelevant buttons.

Workspace pane

On the Workspace pane all elements comprising the current project are displayed. These elements can
include:

 List of chunksin the project

* List of cameras and camera groups in each chunk

« List of markers and marker groups in each chunk
 List of scale barsand scale bar groupsin each chunk
 List of shapelayersin each chunk

 Tiepointsin each chunk

* Depth mapsin each chunk

» Dense point clouds in each chunk

* 3D modelsin each chunk

+ Tiled modelsin each chunk

* Digital elevation modelsin each chunk

» Orthomosaicsin each chunk

Buttons located on the Workspace pane toolbar allow to:

e Add chunk

Add photos

Add marker
» Create scale bar

Enable or disable certain cameras or chunks for processing at further stages.
* Removeitems

Each element in the list is linked with the context menu providing quick access to some common
operations.

Photos pane

Photos pane displays the list of photos/ masks/ depth mapsin the active chunk in the form of thumbnails.
Buttons located on the Photos pane toolbar allow to:

+ Enable/ disable certain cameras

» Remove cameras

* Rotate selected photos clockwise / counterclockwise (for display purposes only)

* Reset current photo filtering option
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 Switch between images/ masks/ depth maps thumbnails

Increase/ decrease icons size or display detailed information on photos including EXIF data

Console pane

Console paneis used for:

Displaying auxiliary information

Displaying error messages

Python commands input

Buttons located on the pane toolbar allow:

Savelog (in HTML, XHTML or Plain Text format)
Clear log

Execute Python script

Reference pane

Reference paneis designed for:

Displaying and editing cameraand / or marker coordinates
Displaying and editing scale bars lengths

Displaying and editing camera orientation angles
Displaying estimation errors

Displaying and editing accuracy parameters for camera/marker coordinates, camera angles and scale
bar lengths

Buttons located on the pane toolbar allow:

Import / export reference coordinates

Convert reference coordinates from one system to the other

Optimize camera alignment and update data

Switch between source coordinates, estimated coordinates and errors views

Specify the coordinate system and measurement accuracy to be assumed through Settings dialog

Timeline pane

Timeline paneis designed for:

» Working with multi-frame chunks

Buttons located on the pane toolbar allow:

Add / remove frames from chunk

Play / stop frame sequence

101



Graphical user interface

 Adjust frame rate through Settings dialog

Animation pane

Animation paneis designed for:

* Loading the cameratrack

o Start / stop the camera movement according to the track

» Render the frame sequence to the form of the video file

Buttons located on the pane toolbar allow:

 Start / stop the animation according to the cameratrack

» Render the animation and save to the external video file

» Create track, load track and adjust track properties through Settings dialog

£ Note

« To open any pane select a corresponding command from the View menu.

Menu commands

FileMenu
] New
Open...

Append...
1 Save
Save As...

Export Points...

Export Model...

Export Tiled Modd...

Export Orthomosaic...

Export DEM...

Generate Report...
Export Cameras...
Export Markers...

Export Masks...

Creates an empty PhotoScan project.
Opens PhotoScan project file.

Appends existing PhotoScan project file to the
current one.

Saves PhotoScan project file.

Saves PhotoScan project file with a new name.
Saves sparse / dense point cloud.

Saves 3D model.

Saves atiled model as hierarchical tiles.
Exports generated orthomosaic.

Exports generated digital elevation model.

Generates Agisoft PhotoScan processing report in
PDF format.

Exports camera positions, orientation data and tie
points measurements.

Exports marker projections/ estimated marker
locations.

Exports masks.
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FileMenu

Export Shapes...
Export Texture...

Export Panorama...

Export Orthophotos...

Undistort Photos...

Render Photos...
Import Cameras...
Import Markers...

Import Masks...
Import Shapes...

Import Points...
Import Moddl...

Import Texture...

Exports shapes from the selected layers.
Exports model texture.

Exports spherical panoramafor camera stations.
Exports separate orthorectified images.

Removes nonlinear distortions by warping source
photos and saving the result asfiles.

Lenticular images generation
Imports camera positions and orientation data.
Imports marker projections.

Imports masks or creates mask from model or
background.

Imports shapes to be used for editing or
measurements.

Imports pointsin aform of the dense point cloud.
Imports polygonal mesh model.
Imports texture and appliesit to the current model.

Imports digital elevation model.

Import DEM...
Import Video... Imports video in aform of fra_me sequence and
saves the extracted frames as images.
Uploads generated products (points, textured mesh
Upload Data... models, tiled models, orthomosaics or digital
elevation models) to one of the supported web-
sites.
Exit Closes the application window.
Edit Menu
“) Undo Undo the last editing operation.
™ Redo Redo the previously undone editing operation.
Add selection Adds current selection to the mask.
Subtract sslection Subtracts current selection from the mask.

Inverts current selection for the photo.

Invert Selection

. Inverts current selection of faces/ points/ cameras.
Invert Selection

Grow Sdlection Grows current selection of mesh faces.

Shrink Selection Shrinks current selection of mesh faces.
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Edit Menu

:K Delete Selection

ﬁ Crop Selection
Invert Mask

X Reset mask

ﬁL Rotate right

s Rotate left

View Menu

#, Zoom In

=, Zoom Out

"3 Reset View
Capture view

= Workspace
@ Timeline
@ Animation
"37 Reference
Photos
@ Console
i Jobs

Toolbar

Full Screen
Workflow Menu

Add Photos..
& Add Folder...

Align Photos...
Build Dense Cloud...
Build Mesh...

Build Texture...

Removes selected faces from the mesh or selected
points from the point cloud.

Crops selected faces/ points.
Inverts mask for the current photo.
Resets mask for the current photo.
Rotates the photo clockwise.

Rotates the photo counterclockwise.

Increases magnification in the active view mode.
Decreases magnification in the active view mode.

Resets the viewport to display the complete model
or photo.

Saves screenshot of current view of the project
(Model/Ortho/Photo)

Shows or hides Workspace pane.
Shows or hides Timeline pane.
Shows or hides Animation pane.
Shows or hides Reference pane.
Shows or hides Photos pane.
Shows or hides Console pane.
Shows or hides Jobs pane.
Shows or hides Toolbar.

Switchesto / from Full Screen mode.

L oads additional photos to be processed by
PhotoScan.

L oads additional photos from folders to be
processed by PhotoScan.

Estimates camera positions and sparse point cloud.
Generates dense point cloud.
Generates polygonal mesh model.

Generates texture for the mesh model.
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Workflow Menu

Build Tiled Moddl .. Generates tiled textured model.

BLild DEM... Generates digital elevation model.

Build Orthomosaic... Generates orthomosaic,

Aligns multiple chunks.

Align Chunks...
Merge Churks... Merges multiple chunks into the single chunk.
Batch Process... Opens Batch Process dialog box.
Model Menu
I¥ Navigation Switches to navigation mode.
Fa Rectangle Selection Rectangl_e selection tool for the elements of the
Model view.
7Y A , Circle selection tool for the elements of the Model
~.+ Circle Selection .
view.
.*"l: Free-form Selection Free-form selection tool for the elements of the
- Model view.
Gradual selection... Se_lecjtsfaca/pomtsbased on the specified
criterion.
% Draw Point Switches to the 3D point drawing toal.

AL Draw Polyline Switches to the 3D polyline drawing tool.

" Draw Pol ygon Switches to the 3D polygon drawing tool.

i Ruler Switches to 3D coordinate and linear distance
measurement tool.

e Move Object Switches to object movement tool.

& . i - i .
% Rotate Object Switches to object rotation tool

Scale Object Switches to object scaling tool.

Reset Transform Resets the transformations applied to the object.
ogo . Switches to volume movement tool.

Move region

@2 Rotate Region Switches to volume rotation tool.

Resize region Switches to volume resize tool.

Resets the transformations applied to the volume to
default.

Shows or hides camera positions estimated during
image alignment.

Reset Region

82 show Cameras

Shows or hides image thumbnails in the camera

Show Thumbnails placehol ders.
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Graphical user interface

Model Menu

2 Show Shapes

% show Markers

Show Images
Show Region
Show Trackball

'@' Show Info

D Show Grid
Show All
Hide All

28 Point Cloud

Dense Cloud

#1 Dense Cloud Classes

4> shaded
4> solid
<> Wireframe

< Textured

¥ Tiled Model

Perspective/Orthographic
Stereo Mode

Predefined views

Navigation Mode

Photo Menu
¥¥' Navigation

L Rectangle Selection

Shows or hides shapes.

Shows or hides marker positions.

Shows or hides stereographic image overlay.
Shows or hides region selector.

Shows or hides the trackball.

Shows or hides the auxiliary on-screen
information.

Shows or hides the grid.
Shows all elements at the same time.
Hides all elements.

Displays sparse point cloud reconstructed during
photo alignment.

Displays dense point cloud.

Displays dense point cloud colored by point
classes.

Displays 3D model in the shaded mode.

Displays 3D model in the solid mode.
Displays 3D model in the wireframe mode.
Displays 3D model in the textured mode.
Displaystiled model.

Switches visualisation view between Perspective
and Orthographic.

Enable/disable stereo view mode according to the
parameters specified in Preferences dial og.

Switches viewport to one of the predefined views.

Switches between Object / Terrain navigation
modes for the Model view window. Object
navigation mode allows for 3-axis rotation control,
while Terrain navigation mode restricts control to
2-axisrotation only, z-axis being kept vertical all
thetime.

Switches to navigation mode.

Rectangle selection tool.
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Graphical user interface

Photo Menu

& Intelligent Scissors
% Intelligent Paint
S Magic Wand
" Draw Point

A Draw Polyline

@ Draw Polygon

& Ruler

Open Next Photo

Open Previous Photo
Go To Next Marker
Go To Previous Marker

Turn Shading On/Off
= Show Shapes
% show Markers
oo . .

oo View Points

Show All

Hide All

Ortho Menu

¥% Navigation

r=-

i -1 Rectangle Selection
{_? Circle Selection

';_i Free-form Selection

*" Draw Point

A Draw Polyline
'/ Draw Pol ygon

7 Draw Patch

Intelligent Scissors selection tool.
Intelligent Paint selection tool.

Magic Wand selection tool.

Switches to the 3D point drawing tool.
Switches to the 3D polyline drawing tool.
Switches to the 3D polygon drawing tool.

Switches to 3D coordinate and linear distance
measurement tool.

Opens next photo from the list in the Photos pane.

Opens previous photo from the list in the Photos
pane.

Zooms to the next marker projection on the opened
photo.

Zooms to the previous marker projection on the
opened photo.

Turns mask shading on or off.
Displays or hides shapes.
Displays or hides markers.

Shows tie point projections used for the camera
alignment.

Shows al elements at the same time.

Hides all elements.

Switches to navigation mode.
Rectangle selection tool for the elements of the
Ortho view.

Circle selection tool for the elements of the Ortho
view.

Free-form selection tool for the elements of the
Ortho view.

Switches to the 2D point drawing tool.
Switches to the 2D polyline drawing tool.
Switches to the 2D polygon drawing tool.

Switches to the patch drawing tool.
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Graphical user interface

Ortho Menu

P
£ Ruler

@ Show Seamlines
23] Show Shapes
% show Markers
Show All
Hide All
% DEM
Orthomosaic
[#] Hillshading

ToolsMenu
Detect Markers...

Track Markers...

Print Markers...

Build Point Cloud...

Thin Point Cloud...

View Matches...

Colorize Dense Cloud...

Invert Point Normals...

Classify Ground Points...

Assign Class...

Reset Classification...

Select Points by Masks...

Select Points by Color...

Switches to coordinate and linear distance
measurement tool.

Displays or hides orthomosaic seamlines.
Displays or hides shapes.

Displays or hides markers.

Shows al elements at the same time.
Hides all elements.

Switches to the digital elevation model display
mode.

Switches to the orthomosaic display mode.

Enables or disables hillshading mode of digital
elevation mode visualisation.

Creates markers from coded targets on photos.

Tracks marker locations across the frame
sequence.

Generates printable PDF file with coded targets.

Builds sparse point cloud based on the estimated
camera parameters available.

Thins sparse point cloud by reducing the number
of projections on the individual photos to the given
limit.

Show View Matches dialog for visual
representation of the common tie points between
the image pairs.

Applies colors to the dense cloud points basing on
source images or orthomosaic.

Inverts normals for the selected points of the dense
cloud.

Classifies dense point cloud based on the user
defined settings.

Assigns classto the selected points.

Resets assigned classes for the selected point
classes.

Selects dense cloud points according to the masked
images.

Selects dense cloud points according to the color
and tolerance.
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Graphical user interface

ToolsMenu

Filter By Class
Filter By Selection

Reset Filter

Compact Dense Cloud...

Update Dense Cloud...

Restore Dense Cloud...

Refine Mesh...
Decimate Mesh...
Smooth Mesh...
Close Holes...

Remove Lighting...

View Mesh Statistics...

View Mesh UVs...

Measure Areaand Volume...

Filter By Selection

Reset Filter
Update Orthomosaic

Reset Orthomosaic
Remove Orthophotos
Generate Seamlines

Calibrate Lens...

Show Chesshoard...

42 Camera Calibration...

& Optimize Cameras...

Filters the points in the dense cloud according to
the selected classes.

Filters the points in the dense cloud according to
the selected points.

Resets all applied dense cloud filters.

Permanently removes all deleted points from the
dense cloud.

Updates statistics of the dense cloud, including
point numbers and assigned classes.

Restores all deleted points of the dense cloud that
were once marked as removed.

Starts photoconsistent mesh refinement operation.
Decimates mesh to the target face count.
Smoothes mesh.

Closes holes on the model surface.

Starts the delighting operation for mesh texture.
Collects and displays mesh statistics.

Displays mesh UV mapping.

Displays surface area and volume of the polygonal
model.

Filters the faces of the polygona model according
to the selected points.

Resets al applied mesh filters.
Applies all the manual edits to the orthomosaic.

Resets all applied edits to default orthomosaic
stitching.

Removes individually orthorectified images from
the project contents.

Creates the shape layer with the polygonal shapes
as copies of the automatic orthmosaic patches.

Shows lens calibration dialog.
Displays the calibration board on screen.
Shows camera calibration dialog box.

Starts the optimization of exterior and interior
parameters of the aligned cameras.
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Graphical user interface

ToolsMenu

Calibrate Reflectance...

Calibrate Colors...

Set Primary Channdl...

Set Brightness...

Set Raster Transform...

Generate Contours...

Survey Statigtics...

4¥ Run Script...
% Preferences...
Help Menu
“¥ Contents

Check for Updates...
Activate Product...

@ About PhotoScan...

Toolbar buttons

General commands
) New
Open
Il?ll Save
3D view commands
“} Undo
™ Redo
. Navigation

L Rectangle Selection

Shows reflectance calibration dialog for precise
radiometric calibration of multispectral data based
on reflectance pandl data.

Shows the color correction dialog for the
brightness and white balance compensation of the
images.

Shows the primary channel selection dialog.

Adjusts image brightness for more convenient
display.

Shows Raster Calculator dialog for NDVI and
other vegetation indices calculation.

Generates contours based on DEM according
to the elevation levels or based on Orthomosaic
according to the vegetation index values.

Shows the survey statistics dialog in aform of
interactive report.

Shows Python Run Script dialog box.

Shows preferences dialog box.

Displays help contents.

Checks if PhotoScan update is available for
download.

Activates / deactivates the product using the
activation key.

Displays program information, version number and
copyright.

Creates a new PhotoScan project file.
Opens a PhotoScan project file.

Saves a PhotoScan project file.

Undo the last editing operation.
Redo the previously undone editing operation.
Navigation tool.

Rectangle selection tool.
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Graphical user interface

3D view commands
{22 Circle Selection
2 Free-Form Sdlection
C 3y overegion

% Resize region
@2* Rotate Region
o Move Object

'ﬂ’ Rotate Object
Scale Object

"% Draw Point

A Draw Polyline

'_ Draw Polygon

5‘6} Ruler

:’( Delete Selection

tf- Crop Selection

3D view settings
#, Zoom In

=, Zoom Out
"3 Reset View
8@ Point Cloud

.

oon Dense Cloud

#1 Dense Cloud Classes
Filter By Class
Filter By Selection

Reset Filter
4 shaded
& saiid

<L> Wireframe

Circle selection tool.

Free-form selection tool.

Volume translation tool.

Volumeresize tool.

Volume rotation tool.

Model translation tool.

Model rotation tool.

Model resize tool.

Switches to the 3D point drawing tool.
Switches to the 3D polyline drawing tool.
Switches to the 3D polygon drawing tool.

3D coordinate and linear distance measurement
tool.

Removes selected faces/ points.

Crops selected faces/ points.

Increases magnification.
Decreases magnification.
Resets model view.

Displays sparse point cloud reconstructed during
image alignment.

Displays dense point cloud model.
Displays dense point cloud colored by point
classes.

Filters the points in the dense cloud according to
the selected classes.

Filters the points in the dense cloud according to
the selected points.

Resets all applied dense cloud filters.
Displays 3D model in the shaded mode.
Displays 3D model in the solid mode.

Displays 3D mode in the wireframe mode.
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Graphical user interface

3D view settings

< Textured

FI# Tiled model

82 show Cameras
Show Thumbnails

% show Shapes

|]QP Show Markers

Show Images

#= Show Aligned Chunks

Photo view commands
“} Undo

™ Redo

“I' Navigation

P Rectangle Selection

¢ Intelligent Scissors
% Intelligent Paint

N Magic Wand

4 Draw Point

A Draw Polyline

o

'_/ Draw Polygon

59 Ruler

L | Add Selection

..... Subtract Selection

Invert Selection
& s Brightness
L .

“l Rotate Right

FE
JL- Rotate L eft

Displays 3D modé in the textured mode.
Displaystiled model.

Shows / hides camera positions, reconstructed
during image alignment.

Shows or hides image thumbnails in the camera
placeholders.

Shows/ hides 3D shapes.

Shows / hides positions of markers placed on the
model.

Shows or hides stereographic image overlay.

Shows / hides aligned chunks.

Undo the last mask editing operation.

Redo the previously undone mask editing
operation.

Switches to the navigation mode.
Rectangle selection tool.

Intelligent scissors tool.

Intelligent paint tool.

Magic wand tool.

Switches to the 3D point drawing tool.
Switches to the 3D polyline drawing tool.
Switches to the 3D polygon drawing tool.

3D coordinate and linear distance measurement
tool.

Adds current selection to the mask.
Subtracts current selection from the mask.
Inverts current selection.

Adjusts image brightness for more convenient
display.
Rotates the photo clockwise.

Rotates the photo counterclockwise.
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Graphical user interface

Photo view commands
#, Zoom In
=L Zoom Out
"2 Reset View
Show Masks
”ﬂ7 Show Shapes
"37 Show Markers

oo . .
oo View Points

Ortho view commands
¥¥' Navigation

Ll Rectangle Selection
(_J Circle Selection

'\3 Free-Form Selection
s Draw Point

A Draw Polyline

@ Draw Polygon

=

= Draw Patch

6& Ruler

% DEM

Orthomosaic

¥ et Raster Transform

& s Brightness

EE Update Orthomosaic

£, Zoom In

‘=L Zoom Out
+

*I* Resat View

# Hillshading mode

Increases magnification.

Decreases magnification.

Resets the viewport to display the whole photo.
Enables or disables the mask shading overlay.
Displays or hides shapes on the current photo.
Switches to marker editing mode.

Shows / hides feature points used for alignment of
the photo.

Switches to the navigation mode.
Rectangle selection toal.

Circle selection tool.

Free-form selection tool.

Switches to the point drawing tool.
Switches to the polyline drawing tool.
Switches to the polygon drawing tool.
Switches to the patch drawing tool.
2D linear distance measurement tool.

Switches to the digital elevation model display
mode.

Switches to the orthomosaic display mode.

Opens Raster Calculator dialog for NDVI and
other vegetation indices calculation.

Adjusts image brightness for more convenient
display.

Applies all the manual edits to the orthomosaic.

Increases the magnification of theimagein the
Ortho view.

Decreases the magnification of theimage in the
Ortho view.

Resets the viewport to display the complete
orthomosaic or DEM.

Enables or disables hillshading mode of digital
elevation mode visualization.
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Graphical user interface

Ortho view commands

% show Seamlines Displays or hides orthomosaic seamlines.

& Displays or hides shapes.

7 Show Shapes

|]5£? Show Markers Displays or hides marker positions.

Hot keys

Below isalist of default hot keys that can be customized in the Preferences dialog.

General
Create new project Ctrl +N
Save project Ctrl +S
Load project Ctrl +O
Run Script Ctrl +R
Full Screen F11
Model View

Undo (only for Delete, Assign Class/ Classify Ctrl +Z
Ground Points,Masking and Close Holes

operations)

Redo (only for Delete, Assign Class/ Classify Ctrl+Y
Ground Points,Masking and Close Holes

operations)

Switch between navigation and any other Space
previously selected mode

Reset view 0

Switch to stereoview mode 9

Switch between orthographic and perspective view 5

modes

Change the angle for perspective view Ctrl + mouse wheel
Assign dense cloud class (only if some pointsare  Ctrl + Shift + C
selected)

Predefined Views

Top 7

Bottom Ctrl +7

Right 3

Left Ctrl +3

Front 1

Back Ctrl +1
Rotate View

Rotate Up 8

114



Graphical user interface

Rotate View
Rotate Down 2
Rotate L eft
Rotate Right 6
Photo View
Next photo (according to Photos pane order) Page Up
Previous photo (according to Photos pane order)  Page Down
Go to the next marker on the same photo Tab
Go to the previous marker on the same photo Shift + Tab
Navigation mode Y
Selection Tools
Rectangle selection M
Intelligent scissors L
Intelligent paint P
Magic wand w
Add selection Ctrl + Shift + A
Subtract selection Ctrl + Shift + S
Invert selection Ctrl + Shift + 1
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Input formats

JPG

TIFF

PNG

BMP

OpenEXR

JPEG 2000

TARGA

Digital Negative (DNG)
Portable Bit Map (PGM, PPM)
Multi-Picture Object (MPO)
Norpix Sequence (SEQ)
AscTec Thermal Images (ARA)

Camera calibration

Import formats

Aqgisoft Camera Calibration (*.xml)
Australis Camera Parameters (*.txt)
Australisv.7 Camera Parameters (*.txt)
PhotoModeler Camera Calibration (*.ini)
3DM CaibCam Camera Parameters (* .txt)
Ca Cam Camera Calibration (*.cal)

Inpho Camera Calibration (*.txt)

USGS Camera Calibration (*.txt)

Z/| Distortion Grid (*.dat)

Camera flight log

Input for mat

Agisoft XML (*xml)
Character-separated values (* .txt, *.csv)
JPG EXIF metadata

MAVinci CSV (*.csv)

APM/PixHawk Log (*.log)

C-Astral Bramor log (*.log)
TopoAxistelemetry (*.tel)

Appendix B. Supported formats

Images

Undistort formats
JPG

TIFF

PNG

BMP

OpenEXR

JPEG 2000

Export formats

Aqgisoft Camera Calibration (*.xml)
Australis Camera Parameters (*.txt)
Australisv.7 Camera Parameters (*.txt)
PhotoModeler Camera Calibration (*.ini)
3DM CaibCam Camera Parameters (* .txt)
Ca Cam Camera Calibration (*.cal)

Inpho Camera Calibration (*.txt)

USGS Camera Calibration (*.txt)

Z/| Distortion Grid (*.dat)

Estimated positions
Agisoft XML (*xml)
Character-separated values (*.txt)
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Supported formats

GCP locations

Input for mat
Character-separated values (*.txt, *.csv)
Agisoft XML (*.xml)

Estimated positions
Character-separated values (* .txt)
Agisoft XML (*.xml)

Interior and exterior camera orientation

parameters

Import camera positions
Agisoft XML (*.xml)

Autodesk FBX (*.fbx)

Alembic (*.abc)

Realviz RZML (*.rzml)

BINGO (*.dat)

Bundler (*.out)

VisionMap Detailed Report (*.txt)

Tie points

Import not available

Sparse/dense point cloud

Import formats
Wavefront OBJ (*.obj)
Stanford PLY (*.ply)

Export camera positions

Agisoft XML (*.xml)

Autodesk FBX (*.fbx)

Alembic (*.abc)

Realviz RZML (*.rzml)

Bundler (*.out)

CHAN files (*.chan)

Boujou (*.txt)

Omega Phi Kappa (* .txt)

PATB Exterior Orientation (*.ptb)
BINGO Exterior Orientation (*.dat)
ORIMA (*.txt)

AeroSys Exterior Orientation (*.orn)
INPHO Project File (*.prj)

Summit Evolution Project (*.smtxml)
Blocks Exchange (* .xml)

Export matches

BINGO (*.dat)

ORIMA (*.txt)

PATB (*.ptb)

Summit Evolution Project (*.smtxml)
Blocks Exchange (*.xml)

Export formats
Wavefront OBJ (*.obj)
Stanford PLY (*.ply)
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Supported formats

Import formats
ASCII PTS (*.pts)
ASPRSLAS (*.las)
LAZ (*.laz)

ASTM E57 (*.€57)

Mesh model

Import mesh

Wavefront OBJ (*.obj)
3DS models (*.3ds)
COLLADA (*.dae)
Stanford PLY (*.ply)
Alembic (*.abc)

STL models (*.stl)
Autodesk DXF (*.dxf)
Autodesk FBX (*.fbx)
Universal 3D models (*.u3d)
OpenCTM models (*.ctm)

Texture

Import texture
JPG

TIFF

PNG

BMP

TARGA

JPEG 2000
OpenEXR

Export formats

ASCII PTS (*.pts)
ASPRSLAS (*.las)
LAZ (*.laz)

ASTM E57 (*.e57)
XYZ Point Cloud (*.txt)
Cesium 3D Tiles (*.zip)
Universal 3D (*.u3d)
Autodesk DXF (*.dxf)
potree (*.zip)

Agisoft OC3 (*.oc3)
Topcon CL3 (*.cl3)
Adobe 3D PDF (*.pdf)

Export mesh

Wavefront OBJ (*.obj)
3DS models (*.3ds)
COLLADA (*.dae)
Stanford PLY (*.ply)
Alembic (*.abc)

STL models (*.stl)
Autodesk DXF (*.dxf)
Autodesk FBX (*.fbx)
Universal 3D models (*.u3d)
VRML models (*.wrl)
Google Earth KMZ (* .kmz)
OpenSceneGraph (*.osgb)
Adobe 3D PDF (*.pdf)

Export texture
JPG

TIFF

PNG

BMP

TARGA

JPEG 2000
OpenEXR
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Supported formats

Orthomosaic

Import not available

Export orthomosaic
GeoTIFF

JPG

JPEG 2000

PNG

BMP

Google Earth KML/KMZ
Google Map Tiles
MBTiles

World Wind Tiles
Tiled Map Service Tiles

Digital elevation model (DSM/DTM)

Import DEM
GeoTIFF elevation (*.tif)

Tiled models

Import not available

Shapes and contours

Import shapes
Shape Files (*.shp)
DXF Files (*.dxf)
KML files (*.kml)
KMZ files (* .kmz)

Export DEM

GeoTIFF elevation (*.tif)

Arc/Info ASCII Grid (*.asc)

Band interleaved file format (*.hil)
XYZ (*.xyz)

Sputnik KMZ (*.kmz)

Export tiles

Cesium 3D Tiles (*.zip)
Scene Layer Package (*.9lpk)
PhotoMesh Layer (*.zip)
OpenSceneGraph (*.osgb)
Agisoft Tiled Model (*.tls)
Agisoft Tile Archive (*.zip)

Export shapes/contours
Shape Files (*.shp)

DXF Files (*.dxf)

KML Files (*.kml)
KMZ Files (*.kmz)
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Appendix C. Camera models

Agisoft PhotoScan supports several parametric lens distortion models. Specific model which approximates
best a real distortion field must be selected before processing. All models assume a centra projection
camera. Non-linear distortions are modeled using Brown's distortion model.

A cameramodel specifiesthe transformation from point coordinatesin thelocal camera coordinate system
to the pixel coordinatesin the image frame.

Thelocal camera coordinate system has origin at the camera projection center. The Z axis points towards
the viewing direction, X axis pointsto theright, Y axis points down.

The image coordinate system has origin at the top left image pixel, with the center of the top left pixel
having coordinates (0.5, 0.5). The X axis in the image coordinate system points to theright, Y axis points
down. Image coordinates are measured in pixels.

Equations used to project a pointsin the local camera coordinate system to the image plane are provided
below for each supported camera model.

The following definitions are used in the equations:

(X,Y, Z) - point coordinatesin the local camera coordinate system,

(u, v) - projected point coordinates in the image coordinate system (in pixels),
f - focal length,

Cx, Gy - principal point offset,

K1, Ko, K3, K4 - radial distortion coefficients,

Py, Py, P3, P4 - tangential distortion coefficients,

B, B> - affinity and non-orthogonality (skew) coefficients,

w, h - image width and height in pixels.

Frame cameras

x=X/Z

y=Y/Z

r=sor(x* +y?)

X' = X(L+ Kqr? + Kor* + Kar® + Kar®) + (PL(r?+2x2) + 2Poxy)(1 + Par? + Par?)
y' = Y(L+ Kar? + Kor* + Kar® + Kgr®) + (Po(r*+2y?) + 2Pixy) (1 + Par® + Par?)
u=w*05+¢c+xf+xB1+yB>

v=h*05+c, +yf

Fisheye cameras

XOZX/Z
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Cameramodels

y0:Y/Z

ro = Srt(Xo” + Yo?)

X=Xg* tan'lrol o

y=yo* tan'rg/ 1o

r = sgrt(x? + y?)

X' =x(1+K 1r2 + Kort + K3I’6 + K4r8) + (Pl(r2+2x2) + 2Pyxy)(1 + P;.;r2 + P4r4)

Y = Y(L+ Kar? + Kor* + Kar® + Kgr®) + (Py(r?+2y%) + 2Pixy) (1 + Par® + Par?)

u=w*05+¢c+xT+xB1+yB>

v=h*05+c, +yf

Spherical cameras (equirectangular projection)

u=w* 05+f* tan(X / Z)

v=h*05+f* tan (Y / sgrt(X? + Z2)

where:

f=w/(2* pi)

£

Note

» Spherica (equirectangular) camera model doesn't support distortions. All distortions should be
corrected before loading images in PhotoScan.

* In case you are capturing panoramas with a rotated frame/fisheye camera, we recommend to
process original images in PhotoScan using camera station function instead of stitching them in
external software.

Spherical cameras (cylindrical projection)

u=w* 05+f* tan(X / Z)

v=h*05+f*Y/syt(X?+ Z?

where:

f=w/(2* pi)

£

Note

» Spherica (cylindrical) camera model doesn't support distortions. All distortions should be
corrected before loading images in PhotoScan.

* In case you are capturing panoramas with a rotated frame/fisheye camera, we recommend to
process original images in PhotoScan using camera station function instead of stitching them in
external software.

121



	c15b98b0214a25495ad953675ebb703f76cc4ffc8a84bde618f1d60394942d59.pdf
	Microsoft Word - 2019_TFM_LUBONG_AXEL
	TF-RE-IN-EXT0-ZC-032.pdf
	Microsoft Word - 2019_TFM_LUBONG_AXEL
	REF-UBICACION.psd
	REF-UBICACION.psd

	274b394dc677755046eed6dad32e124b8faa354ea3a78d53b37a763d60641689.pdf
	c15b98b0214a25495ad953675ebb703f76cc4ffc8a84bde618f1d60394942d59.pdf
	Microsoft Word - 2019_TFM_LUBONG_AXEL

	Agisoft PhotoScan User Manual - Professional Edition, Version 1.4
	Agisoft PhotoScan User Manual
	Table of Contents
	Overview
	How it works
	About the manual

	Chapter 1. Installation and Activation
	System requirements
	GPU acceleration
	Installation procedure
	Installing PhotoScan on Microsoft Windows
	Installing PhotoScan on Mac OS X
	Installing PhotoScan on Debian/Ubuntu

	Restrictions of the Demo mode
	Activation procedure
	PhotoScan node-locked license activation

	Floating licenses

	Chapter 2. Capturing scenarios
	Equipment
	Camera settings
	Object/scene requirements
	Image preprocessing
	Capturing scenarios
	Restrictions
	Modifications of photographs
	Lack of EXIF data
	Lens distortion

	Lens calibration

	Chapter 3. General workflow
	Preferences settings
	Loading photos
	Camera groups
	Inspecting loaded photos
	Multispectral imagery
	Rigid camera rigs
	Video Data


	Aligning photos
	Image quality
	Alignment parameters
	Incremental image alignment
	Point cloud generation based on imported camera data

	Building dense point cloud
	Reconstruction parameters
	Point cloud import


	Building mesh
	Mesh based on point cloud data
	Reconstruction parameters

	Visibility consistent mesh
	Reconstruction parameters


	Building model texture
	Color calibration
	Color calibration parameters

	Texture mapping modes
	Texture generation parameters
	Improving texture quality

	Building tiled model
	Reconstruction parameters

	Building digital elevation model
	Parameters

	Building orthomosaic
	Color calibration
	Color calibration parameters

	Build orthomosaic parameters

	Saving intermediate results
	PhotoScan project archive (.PSZ)
	PhotoScan project file (.PSX)

	Exporting results
	Point cloud export
	Tie points and camera calibration, orientation data export
	Panorama export
	3D model export
	Tiled model export
	Orthomosaic export
	NDVI data export

	Digital Elevation Model (DSM/DTM) export
	Extra products to export
	Processing report generation
	Survey Data
	Camera Calibration
	Camera Locations
	Ground Control and Check Points
	Scale Bars
	Digital Elevation Model
	Processing Parameters



	Chapter 4. Referencing
	Camera calibration
	Calibration groups
	Camera types
	Scanned Photos
	Camera calibration parameters
	Calibration parameters list

	Setting coordinate system
	Placing markers
	Assigning reference coordinates
	Setting georeferenced coordinate system
	Using different vertical datums
	Reference pane: some features more

	Example of a reference coordinates file in CSV format (*.txt)

	Optimization
	Optimization of camera alignment
	Scale bar based optimization
	What do the errors in the Reference pane mean?


	Working with coded and non-coded targets
	Overview
	Coded targets advantages and limitations
	Coded targets in workflow
	Non-coded targets implementation


	Chapter 5. Measurements
	Performing measurements on 3D model
	Distance measurement
	Surface area and volume measurement

	Performing measurements on DEM
	Point measurement
	Distance measurement
	Area and volume measurement
	Cross sections and contour lines

	Vegetation indices calculation
	Multispectral cameras
	Modified visible range cameras
	Index based contour lines


	Chapter 6. Editing
	Using masks
	Overview
	Loading masks
	Editing masks
	Saving masks

	Editing point cloud
	Filtering points based on specified criterion
	Filtering points based on applied masks
	Filtering points based on points colors
	Tie point per photo limit
	Manual points removal

	Classifying dense cloud points
	Automatic classification of ground points
	Manual classification of dense cloud points

	Editing model geometry
	Decimation tool
	Close Holes tool
	Polygon filtering on specified criterion
	Manual face removal
	Fixing mesh topology
	Editing mesh in the external program

	Shapes
	Orthomosaic seamlines editing

	Chapter 7. Automation
	Using chunks
	Creating a chunk
	Working with chunks
	Aligning chunks
	Aligning chunks parameters

	Merging chunks
	Batch processing

	4D processing
	Overview
	Managing multiframe chunks
	Tracking markers

	Python scripting

	Chapter 8. Network processing
	Overview
	Cluster components
	Server
	Processing nodes
	Clients

	Cluster setup
	Starting server
	Starting network nodes
	Checking cluster status
	Starting network processing

	Cluster administration
	Adding processing nodes
	Removing processing nodes


	Appendix A. Graphical user interface
	Application window
	General view
	Model view
	Ortho view
	Photo view
	Workspace pane
	Photos pane
	Console pane
	Reference pane
	Timeline pane
	Animation pane

	Menu commands
	Toolbar buttons
	Hot keys
	General
	Model View
	Photo View


	Appendix B. Supported formats
	Images
	Camera calibration
	Camera flight log
	GCP locations
	Interior and exterior camera orientation parameters
	Tie points
	Sparse/dense point cloud
	Mesh model
	Texture
	Orthomosaic
	Digital elevation model (DSM/DTM)
	Tiled models
	Shapes and contours

	Appendix C. Camera models
	Frame cameras
	Fisheye cameras
	Spherical cameras (equirectangular projection)
	Spherical cameras (cylindrical projection)



